# Table of Contents

## Chapter 1: Let’s Get Started
- Launching Compass for Simple Western ........................................ 1
- Compass for Simple Western Overview ........................................... 2
  - Changing the Screen View ....................................................... 2
  - Assay Screen ................................................................. 2
  - Run Summary Screen ................................................................ 4
- Analysis Screen ............................................................................ 5
- Screen Panes ................................................................................ 5
- Title Bar ....................................................................................... 6
- Main Menu .................................................................................... 6
- Instrument Status Bar ................................................................. 6
- Screen Tab .................................................................................... 6
- View Bar ....................................................................................... 7
- Compass Status Bar ................................................................. 7
- Software Menus ........................................................................... 7
  - File Menu ................................................................................ 8
  - Edit Menu ................................................................................. 8
  - View Menu ................................................................................ 8
  - Instrument Menu ................................................................. 8
  - Window Menu .......................................................................... 9
  - Help Menu .............................................................................. 10
- Changing the Compass for Simple Western Main Window Layout ........................................................................ 10
- Resizing the Main Compass for Simple Western Window ........................................................................ 10
- Resizing the Screen Tab ............................................................. 11
- Resizing Screen Panes ............................................................... 11
- Changing the Location of Screen Panes ...................................... 13
- Restoring the Main Window to the Default Layout ..................... 14
- Software Help ............................................................................. 15
  - Viewing Instrument User Guides ............................................. 15
  - Checking for and Installing New Versions of Compass for Simple Western ........................................... 15
- Instrument Software (Embedded) Updates .................................. 16
- Keeping Multiple Versions of the Software ............................... 17
  - Viewing Release Notes ............................................................ 19
  - Exporting the Software Log ...................................................... 19
  - Sending Run Files to Technical Support .................................... 19
- Basic Troubleshooting ................................................................. 21
  - Compass for Simple Western Version Information .................. 21
  - Directory and File Information ................................................. 22
  - File Types ............................................................................... 24

## Chapter 2: Size Assays
- Assay Screen Overview ............................................................... 26
  - Assay Screen Panes ................................................................. 26
  - Software Menus Active in the Assay Screen ............................ 27
Reagent Color Coding ........................................... 30
Standard Immunoassays .................................. 30
Stellar Assays on Jess ................................. 31
Protein Normalization on Jess ....................... 32
Total Protein Assays ....................................... 33
RePlex Assays on Jess and Abby ..................... 34
Opening an Assay ............................................. 36
Standard Immunoassays: Creating a New Assay ... 37
Step 1 - Open a Template Assay ................. 37
Step 2 - Assign Assay Plate Reagents (Optional). 38
Step 3 - Modifying the Assay Protocol (Optional for All Instruments) .............. 42
Step 4 - Add Assay Notes (Optional) .......... 47
Step 5 - Add Assay Plate Annotations (Optional) 47
Step 7 - Save the Assay ............................. 50
Step 8 - Modify Default Analysis Parameters (Optional) ...................... 51
Step 9 - Modify Default Analysis View (Optional) 52
Stellar Assays on Jess: Creating a New Assay ........ 54
Step 1 - Open a Template Assay ................. 54
Step 2 - Review Assay Plate Reagents (Optional) 55
Step 3 - Modifying the Assay Protocol (Optional for All Instruments) .............. 56
Step 4 - Add Assay Notes (Optional) .......... 61
Step 5 - Add Assay Plate Annotations (Optional) 62
Step 7 - Save the Assay ............................. 65
Step 8 - Modify Default Analysis Parameters (Optional) ...................... 66
Step 9 - Modify Default Analysis View (Optional) 67
Total Protein Assays: Creating a New Assay on Wes ... 69
Step 1 - Open a Template Assay ................. 69
Step 2 - Assign Assay Plate Reagents (Optional) 70
Step 3 - Modifying the Assay Protocol (Optional for All Instruments) .............. 74
Steps 4 - 9 ................................................. 78
Protein Normalization on Jess: Creating a New Assay ............................. 78
Step 1 - Open a Template Assay ................. 78
Step 2 - Assign Assay Plate Reagents .......... 79
Step 3 - Modifying the Assay Protocol (Optional for All Instruments) .............. 80
Steps 4 - 9 ................................................. 80
RePlex Assays on Jess and Abby: Creating a New Assay ..................... 80
Step 1 - Open a Template Assay ................. 80
Step 2 - Assign Assay Plate Reagents .......... 83
Step 3 - Modifying the Assay Protocol (Optional) 84
Steps 4 - 9 ................................................. 89
Making Changes to an Existing Assay .............. 90
Switching Between Open Assays ...................... 90
Creating a Template Assay ......................... 91
Viewing and Changing the Detection Exposures ...... 92
High Dynamic Range Detection Profile ............ 92
RePlex Dynamic Range Detection Profile ......... 95
Changing the Detection Profile .................. 96
Copying Protocols and Templates ................. 98
Copying an Assay Protocol ......................... 98
Copying an Assay Template ....................... 99
Printing Protocols and Templates .................. 99
Printing an Assay Protocol ......................... 99
Printing an Assay Template ....................... 99
Importing and Exporting Protocols and Templates 100
Importing an Assay Protocol ....................... 100
Exporting an Assay Protocol ....................... 101
Viewing Run Data ........................................ 168
Switching Between Sample and Standards Data Views ........................................ 168
Selecting and Displaying Capillary Data ........................................ 171
Switching Between Fluorescence Channel Views (Jess Only) ........................................ 175
Switching Between Single and Multiple Views of the Capillaries ........................................ 175
Viewing RePlex Channel Views (Jess/Abby Only) ........................................ 180
Hiding Capillary Data ........................................ 190
Setting Run Data Display Filters ........................................ 190
Run Data Notifications and Warnings ........................................ 191
Checking Your Results ........................................ 194
Step 1 – Review the Fluorescent Sizing Standards Movie ........................................ 194
Step 2 – Checking Fluorescent Sizing Standards ........................................ 195
Step 3 – Checking the Ladder ........................................ 197
Step 4 – Checking Samples ........................................ 199
Step 5 – Assigning Peak Names (Optional) ........................................ 201
Group Statistics ........................................ 202
Using Groups ........................................ 202
Viewing Statistics ........................................ 203
Hiding or Removing Capillaries in Group Analysis ........................................ 205
Copying Data Views and Results Tables ........................................ 206
Copying Data Views ........................................ 206
Copying Results Tables ........................................ 206
Saving the Graph or Lane View as an Image File ........................................ 206
Exporting Run Files ........................................ 207
Exporting Results Tables ........................................ 207
Exporting Raw Sample Electropherogram Data ........................................ 207
Running Reports ........................................ 209
Changing Sample Protein Identification ........................................ 215
Adding or Removing Sample Data ........................................ 215
Hiding Sample Data ........................................ 216
Changing Peak Names for Sample Data ........................................ 218
Displaying Sample Data for Named Peaks Only ........................................ 222
Changing the Virtual Blot View ........................................ 224
Overlaying Protein Normalization or Total Protein Data ........................................ 224
Adjusting the Contrast ........................................ 226
Inverting the Virtual Blot ........................................ 227
Lane Options ........................................ 228
Overlaying Standards Data on Sample Lanes ........................................ 231
Moving Lanes in the Virtual Blot View ........................................ 232
Creating Annotated Lane View Figures ........................................ 233
Annotations Pane Toolbar ........................................ 240
Adjusting Lane Contrast ........................................ 242
Adding Lane Labels ........................................ 245
Adding Band Labels ........................................ 251
Adding a Title and Notes ........................................ 256
Changing the Font ........................................ 257
Changing the Electropherogram View ........................................ 260
Autoscaling the Electropherogram ........................................ 260
Stacking Multiple Electropherograms ........................................ 262
Overlaying Multiple Electropherograms ........................................ 263
Zooming ........................................ 264
Graph Options: Customizing the Data Display ........................................ 265
Selecting Data Viewing Options ........................................ 277
Adding and Removing Baseline Points ...............283
Selecting the X-Axis Molecular Weight Range ........284
Closing Run Files ........................................286
Analysis Settings Overview .............................287
Advanced Analysis Settings .............................289
Standards Settings ......................................290
Sample Settings ........................................290
Image Settings ..........................................290
Advanced Analysis Settings Groups ..........291
Creating a New Analysis Group ..................291
Changing the Default Analysis Group ..........292
Modifying an Analysis Group ....................292
Deleting an Analysis Group .....................293
Applying Analysis Groups to Specific Run Data 293
Images Analysis Settings ...............................296
Exposure Settings .......................................297
Changing the Sample Data Exposure Displayed 299
Normalization (Jess/Abby only) ..................300
Signal to Noise Settings ..............................303
S/N Compass v5.0 ......................................304
Signal-to-Noise Ratio ................................304
Peak Fit Analysis Settings .........................308
Range Settings .........................................309
Baseline Settings .....................................310
Peak Find Settings ..................................310
Peak Fit Analysis Settings Groups ..........311
Creating a New Peak Fit Group ..............312
Changing the Default Peak Fit Group ....313
Modifying a Peak Fit Group ..................314
Deleting a Peak Fit Group ....................314
Applying Peak Fit Groups to Specific Run Data 315
Peak Names Settings ..................................317
Peak Names Analysis Groups ..................318
Creating a Peak Names Group ..................319
Adding Peak Names Groups ....................322
Modifying a Peak Names Group ..............322
Deleting a Peak Names Group .................323
Applying Peak Names Groups to Run Data ....323
Standard Curve Settings ..............................326
Applying Peak Names Groups to Run Standard Curve ...........328
System or Loading Control Settings ..........331
Standards Settings ....................................333
Standards Analysis Settings Groups ..........334
Changing the Capillary Used for the Ladder ....336
Creating a New Standard .........................337
Creating a New Ladder .........................338
Importing and Exporting Analysis Settings ......340
Importing Analysis Settings ....................340
Exporting Analysis Settings ...................340

Chapter 8: Setting Your Preferences ..................343
Custom Preference Options .....................344
Setting Data Export Options ...................345
Selecting Custom Plot Colors for Graph Overlay ....346
Setting Up Jess, Wes, and Abby to Send Tweets ....348
Chapter 1:
Let’s Get Started

Chapter Overview
• Launching Compass for Simple Western
• Compass for Simple Western Overview
• Software Menus
• Changing the Compass for Simple Western Main Window Layout
• Software Help
• Checking for and Installing New Versions of Compass for Simple Western
• Instrument Software (Embedded) Updates
• Keeping Multiple Versions of the Software
• Exporting the Software Log
• Sending Run Files to Technical Support
• Basic Troubleshooting
• Compass for Simple Western Version Information
• Directory and File Information
Launching Compass for Simple Western

To open Compass for Simple Western, double-click the icon on the computer desktop.

NOTES:
Compass for Simple Western 6.1 and higher is compatible with macOS 10.14 - Mojave, 10.15 - Catalina and 11.00 - Big Sur.

If you are using Peggy Sue, Sally Sue or NanoPro 1000, Compass for Simple Western version 6.0 and higher does not support these instruments. You can still use software versions 5.x and lower to create, load and run assays on these instruments, and to analyze your data.

Compass for Simple Western Overview

Compass for Simple Western has three main screens:

- **Assay** - You’ll create and review your assay.
- **Run Summary** - Check out the status of your run.
- **Analysis** - Take a look at the data from your experiment.

Changing the Screen View

To move between the Assay, Run Summary and Analysis screens, just click the button in the screen tab located in the upper right corner of the main window.

Assay Screen

The Assay screen is used to create, view, and edit assays. You can assign well locations for assay plate reagents, modify assay protocol steps, enter assay notes and add annotations for individual wells on the assay plate.
### Layout

<table>
<thead>
<tr>
<th>Component</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Separation Matrix</td>
<td></td>
</tr>
<tr>
<td>Stacking Matrix</td>
<td></td>
</tr>
<tr>
<td>Sample</td>
<td></td>
</tr>
<tr>
<td>Separation Time (min)</td>
<td>15.0</td>
</tr>
<tr>
<td>Separation Voltage (vols)</td>
<td>575</td>
</tr>
<tr>
<td>Matrix Removal</td>
<td></td>
</tr>
<tr>
<td>Protein Normalization Time (min)</td>
<td>40.0</td>
</tr>
<tr>
<td>Antibody Loading Time (min)</td>
<td>2.0</td>
</tr>
<tr>
<td>Primary Antibody Time (min)</td>
<td>30.0</td>
</tr>
<tr>
<td>Secondary Antibody Time (min)</td>
<td>30.0</td>
</tr>
<tr>
<td>Destain</td>
<td></td>
</tr>
</tbody>
</table>

### Template

- **Columns:**
  - Column 1: Sample
Run Summary Screen

The Run Summary screen is used to monitor status of a run in progress, watch movies of the separation in the capillaries, and view current and voltage plots for each run.
Analysis Screen

The Analysis screen is used to view data from your assay, including the graph view (electropherograms), lane view (shown below), capillary images, and a table with your results. You can also analyze your data here after the run is finished.

Screen Panes

Assay, Run Summary and Analysis screens all have multiple screen panes that let you view the individual components of a run, assay or data file. Each pane has a labeled tab and a unique icon. We'll describe panes specific to each screen later in the individual screen sections.

The active pane in a screen is blue. To view a pane, click in the pane or on its tab. The example below shows panes in the Analysis screen, and the Lane pane is active:
Title Bar
In the title bar you will see the run file name and the icons that allow the main Compass for Simple Western window to be minimized, maximized or closed.

Main Menu
Access to various software, instrument and screen operations is available through the main menu. More details on menu commands can be found in “Software Menus” on page 7.

Instrument Status Bar
The instrument status bar is used to start runs and cleaning protocols, relay system status and show run progress. More details on instrument control and status can be found in Chapter 6, “Controlling Jess, Wes, and Abby”.

NOTE: You will only see the instrument status bar when Compass for Simple Western is connected to an instrument. There is no status bar on computer workstations that you’re only using for data analysis.

Screen Tab
The screen tab lets you move between Assay, Run Summary or Analysis screens and is located in the upper right corner of the main window. Just click a button to view a screen. The tab for the screen currently displayed is highlighted in blue.
View Bar
The view bar is only displayed in the Analysis screen as part of the main menu bar and allows you to switch between displaying sample chemiluminescent, fluorescent or protein normalization data, fluorescent standards or capillary registration information, data for a single capillary or all capillaries in the run, or grouped capillary data. View bar options are detailed in “Switching Between Sample and Standards Data Views” on page 168, and “Using Groups” on page 202.

Compass Status Bar
The status bar is located in the lower right corner of the main window. It displays active software processes and their progress.

Software Menus
A brief description of the software menus in the main menu are described in this section. Not all menus are available in every screen, and menu commands change depending on what screen is active. The menus and commands available for each screen will be detailed in the individual screen sections.
File Menu

The File menu contains basic file commands.

Edit Menu

The Edit menu contains basic editing commands, analysis and preferences options. Specific details on preferences are described in Chapter 8, “Setting Your Preferences”.

View Menu

The View menu can only be seen in the Analysis screen, and allows you to change how your data is displayed.
Instrument Menu

The Instrument menu is only available when Compass for Simple Western is connected to directly to your instrument. Instrument control options are explained in Chapter 6, “Controlling Jess, Wes, and Abby”.

Window Menu

The Window menu allows you to switch between Blot, Assay, Run Summary or Analysis screens, and restore screens to the Compass for Simple Western default layout.

- **Blot** - Displays the Blot screen where you can view and enhance acquired blotting membrane images.
- **Assay** - Displays the Assay screen where you can create, view, and edit assays.
- **Run Summary** - Displays the Run Summary screen which tells you the status of a run in progress.
- **Analysis** - Displays the Analysis screen which is used to view sample electropherograms, lane data and results.
- **Default Layout** - Restores the individual panes in the current screen back to their default size and location.
Help Menu

The Help menu provides access to Help, software updates, release notes and other software information.

- **Compass for SW Help** - Displays the Compass for Simple Western User Guide.
- **User Guide** - Displays a menu of Simple Western instrument User Guides.
- **Check for Updates** - Automatically checks to see if a new version of Compass for Simple Western is available.
- **Release Notes** - Displays Compass for Simple Western release notes for the current and prior versions.
- **Export Logs** - In the event a technical support issue arises, the Export Logs option lets you gather instrument-specific logs into a .zip file and send it directly to ProteinSimple Technical Support. If you don’t have an internet connection, you can also save the .zip file to the desktop and send to Technical Support at a later time.
- **Send Run File** - Lets you send a run file to ProteinSimple Technical Support directly from Compass for Simple Western.
- **About Compass for SW** - Displays the Compass for Simple Western software version and build information.

**Changing the Compass for Simple Western Main Window Layout**

You can easily resize the Compass for Simple Western main window and the individual panes in each screen. Screen panes can also be moved outside of the main window.

**Resizing the Main Compass for Simple Western Window**

To resize the main window, roll the mouse over a corner or border until the sizing arrow appears. Then just click and drag to resize.
Resizing the Screen Tab

The screen tab can be sized to show all or just some of the screen buttons. To resize, roll the mouse over the left edge of the tab until the sizing arrow appears, then click and drag to resize. If a screen button is hidden, a double arrow will display in the tab. Click to display and select the hidden screen.

Resizing Screen Panes

- **To resize a pane** - Roll the mouse over the pane border until the sizing arrow appears. Then just click and drag to resize.
- **To maximize a pane** - Click the maximize button in the upper right corner or double-click the tab.

The other panes in the screen will automatically minimize to pane bars in the task area along the window border.
• **To minimize a pane** - Click the minimize button in the upper right corner of the tab. The other panes in the screen will automatically resize and the minimized pane will display as a pane bar in the task area.

![Minimize and Maximize Buttons](image)

• **To restore all minimized panes** - Click **Restore** on the minimized pane bar.

• **To restore only one minimized pane** - Click the pane icon on the minimized pane bar.
• **To restore a maximized pane to its original size** - Double-click the tab or click **Restore** in the tab menu bar.

• **To restore all panes to their original sizes** - Select **Window** in the main menu and click **Default Layout**.

**Changing the Location of Screen Panes**

Panes can be moved to different locations within a screen.

• **To move a pane** - Click on its tab and drag it to the new location. As the pane is moved, area guides will display to assist you in choosing a drop location.

The following figure shows the Analysis screen after moving the Peaks pane.
• To detach a pane from the main window - Click on its tab and drag it outside the main Compass for Simple Western window or right click the tab and click Detached.

• To move a detached pane back inside the main window - Select Window in the main menu and click Default Layout.

• To restore all panes to their original locations - Select Window in the main menu and click Default Layout.

Restoring the Main Window to the Default Layout

To restore screen pane sizes and locations to the original Compass for Simple Western layout, select Window from the main menu and click Default Layout.
Software Help
Select Help and click Compass for SW Help to view the Compass for Simple Western User Guide. If the computer you’re using has an internet connection, the latest online version of the User Guide PDF will display. When an internet connection isn’t available, the User Guide PDF shipped with the original installer for the software will open instead.

Viewing Instrument User Guides
Select Help and click User Guide to display a menu of Simple Western instrument User Guides. If the computer you’re using has an internet connection, the latest online version of the User Guide PDF will display. When an internet connection isn’t available, the User Guides PDF shipped with the original installer for the software will open instead. The latest versions of all User Guides are also available online at https://www.proteinsimple.com/technical_library.html.

Checking for and Installing New Versions of Compass for Simple Western
Compass for Simple Western can automatically check to see if a newer version of software is available. To do this:
1. Make sure the computer being used has an active internet connection.
2. Select Help and click Check for Updates. If an update is found, the following screen will display:

![Update Screen](image)

3. Click Finish to start the download and install the update.
4. Follow the on-screen instructions to complete the software installation.
5. Reboot the computer before using the new version of Compass for Simple Western.

**Instrument Software (Embedded) Updates**

To view the version installed, select Instrument in the main menu, then click Properties. The current version of system software will display:

![Properties Screen](image)
To check for embedded updates, select **Instrument** in the main menu, then **Update** and select **Network**. If you are not on the network, contact ProteinSimple Technical Support for assistance on how to obtain the latest update.

**Keeping Multiple Versions of the Software**

1. Rename the currently installed Compass for SW folder. For example, rename C:\Program Files\Compass for SW to C:\Program Files\Compass for SW_5.0.1.
2. Open the renamed folder, right click on **Compass for SW.exe**, select **Sent To** and then **Desktop (create shortcut)**.
3. Rename the shortcut per the version number, for example: Compass 5.0.1. for SW.

4. **Important:** uninstall Compass for SW through the Control Panel.

5. Install the latest (or other) version of Compass for Simple Western.

6. The new desktop shortcut will point to the last version of Compass for Simple Western that was installed. Rename it to the version that was just installed, for example **Compass 6.0.0. for SW.**
Viewing Release Notes

Select Help and click Release Notes to view feature updates and bug fixes for new and past versions of Compass for Simple Western. If the computer you’re using has an internet connection, the latest online version of the release notes PDF will display. When an internet connection isn’t available, the release notes PDF shipped with the original installer for the software will open instead. We recommend you review these notes whenever a software update is installed. The latest release notes are also available online at https://www.proteinsimple.com/technical_library.html

Exporting the Software Log

Select Help and click Export Logs to view the software log file. This will export a zip file containing both the Compass and embedded logs (self test, error, temperature, command logs, etc.). This information is used for troubleshooting purposes.

Sending Run Files to Technical Support

If the computer you’re using has an internet connection, Compass for Simple Western can zip and send a run file directly to ProteinSimple Technical Support.

1. Open the run file you’d like to send in the Analysis screen.
2. Select Help and click Send Run File:
3. Enter your Name, Company and E-mail address, and any details in the Comments section:
4. Click **Send**. The progress window displays:

5. When the file upload is complete, the following message displays. Click **OK**.
Basic Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The instrument won't connect to the computer</td>
<td>• Confirm the static IP address for the ethernet port is set to 172.30.1.2.</td>
</tr>
<tr>
<td></td>
<td>• Use a direct ethernet to ethernet connection. USB to ethernet adapters can be unreliable.</td>
</tr>
<tr>
<td></td>
<td>• Refer to the installation guide for more detailed instructions or contact Technical Support at <a href="mailto:support@proteinsimple.com">support@proteinsimple.com</a></td>
</tr>
<tr>
<td>I can’t access my data</td>
<td>• By default, run files save to C:\Users\Documents\Compass for Simple Western\Runs.</td>
</tr>
<tr>
<td></td>
<td>• If you don’t see your file in the default folder, connect to the instrument’s embedded drive. From the Compass for Simple Western main menu, select Instrument &gt; Runs...</td>
</tr>
</tbody>
</table>

NOTE: Run files are organized chronologically.

For additional instrument, software and Simple Western assay troubleshooting support, please contact ProteinSimple Technical Support toll-free in the US and Canada at (888) 607-9692 (option 3), support@proteinsimple.com or visit http://www.proteinsimple.com/resources.html?product=simple-western. You can also contact your local Field Application Scientist for help.

Compass for Simple Western Version Information

Select Help and click About Compass for SW to view the software version and build number information.
Directory and File Information

The main Compass for Simple Western directory is located in the Program Files folder, and also contains PDF files of the Jess, Wes and Abby User Guides.
Compass for Simple Western assay and run files are located in the Documents folder in the User directory on your computer:

- **Assays Folder** - Contains all assay files that you’ve saved.
- **New Assays Folder** - Contains Simple Western default assay template files.
- **Runs Folder** - Contains all run files. Run data is automatically written to this folder.
- **Blots Folder** - Contains all Western blot image files that you’ve saved.

NOTE: When a Compass for Simple Western software update is performed, the template assays in the New Assays folder are overwritten.
File Types

The following file types are used by Compass for Simple Western:

- **Assay Files** - Use an *.assay file extension.
- **Run Files** - Use a *.cbz file extension. The default file format for run files is Date_Time_AssayName. An example run file name would be 2012-09-28_18-50-53_Simple Western.cbz.
- **Blot Files** - Use a *.btz file extension.
- **Protocol Files** - Exported protocol files use a *.protocol file extension.
- **Template Files** - Exported template files use a *.template file extension.
- **Analysis Settings Files** - Exported analysis settings files use a *.settings file extension.
Chapter 2:
Size Assays

Chapter Overview

• Assay Screen Overview
• Reagent Color Coding
• Opening an Assay
• Standard Immunoassays: Creating a New Assay
• Stellar Assays on Jess: Creating a New Assay
• Total Protein Assays: Creating a New Assay on Wes
• Protein Normalization on Jess: Creating a New Assay
• RePlex Assays on Jess and Abby: Creating a New Assay
• Making Changes to an Existing Assay
• Switching Between Open Assays
• Creating a Template Assay
• Viewing and Changing the Detection Exposures
• Copying Protocols and Templates
• Printing Protocols and Templates
• Importing and Exporting Protocols and Templates
Assay Screen Overview

NOTE: If you are using Peggy Sue, Sally Sue or NanoPro 1000, Compass for Simple Western version 6.0 and higher does not support these instruments. You can still use software versions 5.x and lower to create, load, and run assays on these systems, and to analyze your data.

The Assay screen is used to create, view, and edit assays. To access this screen, click Assay in the screen tab:

Assay Screen Panes

The Assay screen has four panes:

- **Layout** - Displays a map of the assay plate and shows where assay reagents will be located.
- **Protocol** - Lists individual assay protocol steps and parameters that Jess, Wes, or Abby will execute for each of the capillaries.
- **Notes** - Lets you enter specific assay information that is saved with the assay and can be used for future reference.
• **Template** – Enter annotations for the individual well and row reagents in the assay plate.

Software Menus Active in the Assay Screen

You can use the following software menus:

• File
• Edit
• Instrument (when Compass for Simple Western is connected to Jess, Wes, or Abby)
• Window
• Help

The File and Edit menu options specific to the Assay screen are described next.
File Menu

The following File menu options are active:

- **New Assay** - Creates a new assay from a starter template.
- **Open Assay** - Opens an existing assay.
- **Save** - Saves the open assay.
- **Save As** - Saves the open assay under a different file name.
- **Import Protocol** - Imports a saved protocol file into an assay.
- **Import Template** - Imports a saved template file into an assay.
- **Export Protocol** - Exports the current protocol file for future use.
- **Export Template** - Exports the current template file for future use.
- **Print** - Prints the information in the Protocol or Template panes.
- **Exit** - Closes Compass for Simple Western.
**Edit Menu**

The following Edit menu options are active:

- **Copy** - Copies the information in the Protocol or Template panes into other documents.
- **Default Analysis** - Displays the default settings that will be used to analyze the run data generated with an assay.
- **Default Analysis View** - Displays the default Graph and Lane view options that will be used to display run data generated with an assay.
- **Preferences** - Set and save your preferences for data export, plot colors in the graph and Twitter settings. See Chapter 8, "Setting Your Preferences" for more information.
Reagent Color Coding

Standard Immunoassays

The Assay screen uses color coding to identify various assay reagents in all panes. The following example shows the Layout pane for chemiluminescence assays on the left and fluorescence assays (Jess only) on the right:

- **Orange** - Samples and ladder
- **Magenta** - Antibody Diluent (2 or Milk-Free)
- **Light Teal** - Primary antibody
- **Teal** - Secondary HRP conjugate
- **Gold** - Luminol/Peroxide mix

- **Orange** - Samples and ladder
- **Magenta** - Antibody Diluent (2 or Milk-Free)
- **Light Teal** - Primary antibody
- **Teal** - Secondary fluorescent conjugate
Stellar Assays on Jess

The Assay screen uses color coding to identify various assay reagents in all panes. The following example shows the Layout pane for a Stellar Assay on the left, and a Stellar Assay with Total Protein on the right:

- **Orange** - Samples and ladder
- **Magenta** - Antibody Diluent (2 or Milk-Free)
- **Light Teal** - Primary antibody
- **Teal** - Stellar secondary antibody
- **Red** - Stellar IR or NIR Anneal
- **Dark Blue** - Stellar IR or NIR Label
- **Orange** - Samples and ladder
- **Peach** - Total Protein labeling reagent
- **Light Teal** - Primary antibody
- **Teal** - Stellar secondary antibody + Stellar Total Protein Streptavidin-HRP
- **Red** - Stellar IR or NIR Anneal
- **Dark Blue** - Stellar IR or NIR Label
- **Gold** - Luminol/ Peroxide mix
- **Magenta** - Antibody Diluent (2 or Milk-Free)
Protein Normalization on Jess

The Assay screen uses color coding to identify protein normalization reagent (green), which can be included with every size assay plate setup. There's no need to run protein normalization as a separate assay.

- **Orange** - Samples and ladder
- **Green** - Protein Normalization reagent
- **Magenta** - Antibody Diluent (2 or Milk-Free)
- **Light Teal** - Primary antibody
- **Teal** - Secondary antibody
- **Gold** - Luminol/Peroxide mix (chemiluminescence only)
Total Protein Assays

The Assay screen uses color coding to identify various assay reagents in all panes. The Layout pane is shown in the following example:

- **Orange** - Samples and ladder
- **Magenta** - Total Protein labeling reagent
- **Light Teal** - Antibody Diluent 2
- **Teal** - Total Protein Streptavidin-HRP
- **Gold** - Luminol/Peroxide mix
RePlex Assays on Jess and Abby

Jess and Abby let you run two immunoassays or an immunoassay with Total Protein in a single run. This is done in two different probing cycles. These assay combinations are currently validated on Jess and Abby:

- Chemiluminescence + chemiluminescence
- Chemiluminescence + Total Protein
- Chemiluminescence/NIR fluorescence + Total Protein (Jess only)
- NIR fluorescence + NIR fluorescence (Jess only)
- NIR fluorescence + chemiluminescence (Jess only)

The Assay screen uses color coding to identify various assay reagents in all panes. The following examples show the Layout pane for a few of the RePlex Assay combinations listed above:

**Chemiluminescence + Chemiluminescence**

(Jess and Abby)

- **Orange** - Samples and ladder
- **Magenta** - Antibody Diluent (2 or Milk-Free)
- **Light Teal** - Primary antibody for Probe 1
- **Teal** - Secondary HRP conjugate for Probe 1
- **Light Teal** - Primary antibody for Probe 2
- **Teal** - Secondary HRP conjugate for Probe 2
- **Gold** - Luminol/Peroxide mix
- **Purple** - RePlex reagent mix
Chemiluminescence/NIR fluorescence + Total Protein (Jess only)

- **Orange** - Samples and ladder
- **Peach** - Total Protein labeling reagent
- **Magenta** - Antibody Diluent (2 or Milk-Free)
- **Light Teal** - Primary antibody for Probe 1
- **Teal** - Secondary antibody for Probe 1
- **Green** - Total Protein Streptavidin-HRP for Probe 2
- **Gold** - Luminol/Peroxide mix
- **Purple** - RePlex reagent mix

NIR fluorescence + NIR fluorescence (Jess only)

- **Orange** - Samples and ladder
- **Magenta** - Antibody Diluent (2 or Milk-Free)
- **Light Teal** - Primary antibody for Probe 1
- **Teal** - Secondary antibody for Probe 1
- **Light Teal** - Primary antibody for Probe 2
- **Teal** - Secondary antibody for Probe 2
- **Purple** - RePlex reagent mix
Opening an Assay

NOTE: If you are using Peggy Sue, Sally Sue or NanoPro 1000, Compass for Simple Western version 6.0 and higher does not support these instruments. You can still use software versions 5.x and lower to create, load, and run assays on these systems, and to analyze your data.

To open an existing assay:

1. Select the Assay screen.
2. Select File in the main menu and click Open Assay.
3. A list of the last five assays opened will display. Select one of these assays or click Browse to open the Assay folder and select a different assay.
4. To make changes to the assay, follow the instructions under “Standard Immunoassays: Creating a New Assay” on page 37 for changing the assay parameters. Select File from the main menu and click Save.
Standard Immunoassays: Creating a New Assay

To create a new assay, we recommend using one of the template assays and making any necessary modifications from there.

NOTES:
If you are using Peggy Sue, Sally Sue or NanoPro 1000, Compass for Simple Western version 6.0 and higher does not support these instruments. You can still use software versions 5.x and lower to create, load, and run assays on these instruments, and to analyze your data.

This section provides details on how to create a standard immunoassay. To create a RePlex Assay on Jess or Abby that includes an immunoassay, see “RePlex Assays on Jess and Abby: Creating a New Assay” on page 80. To create a Stellar Assay on Jess see “Stellar Assays on Jess: Creating a New Assay” on page 54.

Step 1 - Open a Template Assay

1. Select the Assay screen.
2. Select File in the main menu and click New Assay:

![New Assay menu](image)

3. Select the template assay for your instrument by selecting the instrument-appropriate Assay Type or Immunoassay, Size Range and Cartridge Type, or choose Open Assay to select from the menu of saved assays.
NOTE: If you make changes to the assay, such as defining the wells in the plate, be sure to select File and Save before proceeding.

Step 2 - Assign Assay Plate Reagents (Optional)

1. Click on the Layout tab. Displayed are the default row locations where each reagent should be placed on the assay plate.

   Plate layout:
• **Row A** - Biotinylated Ladder (A1) and Sample (A2-25)
• **Row B** - Antibody Diluent
• **Row C** - Antibody Diluent (C1) and Primary antibody (C2-C25)
• **Row D** - Streptavidin-HRP or NIR (D1) and Secondary conjugate (D2-D25)
• **Row E** - Luminol-S/Peroxide mix (chemiluminescence only)
• **Row F** - Empty

**NOTE:** For details on sample, reagent and assay plate preparation, please refer to the product insert provided with the Simple Western kits.

2. If needed, well assignments can be modified as described below. Any row assignments changed in the **Layout** pane are updated in the Protocol pane automatically.

  - **To move a reagent row to another location** - Click the row in the **Layout** pane, then drag and drop it on the new location. The row from which it was moved will be reassigned as empty.

  ![Layout](image.png)

  - **To insert a sample row** - Click an empty row where the new sample row should be inserted, then click the S icon (Insert a sample row) in the **Layout** pane toolbar. A new sample row will be added in the empty row.
To insert a detection row - Click an empty row where the new detection row should be inserted, then click the D icon (Insert a detection row) in the Layout pane toolbar. A new detection row will be added in the empty row.

To insert a tertiary incubation reagent - Click an empty row where the new incubation reagent should be inserted, then click the 3 icon (Insert a tertiary row) in the Layout pane toolbar. A new incubation reagent row will be added in the empty row.
NOTE: Row F is the last row assignment that can be used on the assay plate. New, sample, incubation or luminol rows cannot be inserted if all rows have an assigned reagent. To insert a row in this case, you must first delete the contents of a row.

- **To delete a row** - Click the row to be deleted, then click the red X icon (Delete a row) in the toolbar. Rows for required assay reagents cannot be deleted.
NOTE: Rows J and K are purposely left empty, don’t put anything into these wells.

Step 3 - Modifying the Assay Protocol (Optional for All Instruments)

1. Click on the Protocol tab. This pane shows the individual steps of the assay protocol and allows you to change parameters. When creating a new assay, the default protocol automatically assigns all reagent locations for the assay. The Abby assay is shown as an example:

Each row contains an assay protocol step. Each step can contain a reagent assay plate row assignment and one or more parameter settings. To view the details for a step, click on the white arrow next to the step name. We recommend using the default protocol settings for the assays. An expanded list of the default protocol step parameters is shown below:
2. You can change the primary or secondary antibody incubation time. Click the cell in the value column next to Primary Antibody Time (min) or Secondary Antibody Time (min) and enter a new value in minutes:
3. You can change the primary and secondary antibody incubation reagent row location if there is more than one row for each reagent type. Click the cell in the value column next to Well Row and select a different row on the assay plate:

![Protocol table]

**NOTE:** Only rows you’ve designated as primary antibody in the Layout tab can be selected in the Well Row drop-down menu for Primary Antibody.

4. The default detection mode is High Dynamic Range (HDR) for chemiluminescence assays and Stellar assays on Jess (Compass for Simple Western 6.1 and higher). See “High Dynamic Range Detection Profile” on page 92 for more information.
Additional exposures can be collected in the assay if desired. To do this, click the white arrow next to Detection to expand the row. Click the HDR cell in the column next to Detection Profile to open the Detection Profile window.

Deselect the High Dynamic Range checkbox. Additional times can be added to the protocol by clicking the Add button, entering the values and selecting OK.
For non-RePlex chemiluminescent assays on Jess and Abby, when the High Dynamic Range box is unchecked, you also have the option of selecting the RePlex Dynamic Range:

5. You can modify any other protocol parameters as needed.
NOTE: For more information on changing protocol step parameters other than incubation times, contact ProteinSimple Technical Support toll-free in the US and Canada at 1-888-607-9692 (option 3) or your local Field Application Specialist.

Step 4 - Add Assay Notes (Optional)

1. Click on the Notes tab.
2. Click in the pane and type any assay or protocol notes. This information will be stored with the assay and run data.

NOTE: When notes are being edited, an asterisk will appear in the Notes tab to indicate changes have been made and should be saved.

Step 5 - Add Assay Plate Annotations (Optional)

Custom reagent names, notes and annotations can be entered for individual rows and wells on the assay plate. This information will be stored with assay and run data. During post-run analysis, this information will be used to apply custom analysis settings to specific sample names, blocking reagent names, primary antibody names or sample and primary antibody attributes. This will be explained in more detail in "Analysis Settings Overview" on page 287.

NOTE: Template pane information can also be added or updated after a run is complete.
To enter annotations:

1. Click on the Template tab. The default annotations for reagent rows and individual wells on the assay plate will display:

![Template image]

2. Change or add row and well annotations as needed. To do this:
   a. To enter annotations for a specific well - Right click the well and select **Edit** or click **Edit** in the upper right corner of the pane or double click the selected well. The following box will display:

![Well Content dialog box]

Enter the reagent name, notes or specific attributes (for example, sample concentration or dilution ratio):
Click **OK**. The new information will display in the selected well:

![Diagram of well contents]

b. **To enter annotations for multiple wells or a row** - To select individual wells, press and hold the Control key and then select individual wells. To select a sequential set of wells or a full row, press and hold the Shift key, then select the first well and last well. Next, right click and select **Edit** or click **Edit** in the upper right corner of the pane. The following box will display:

![Annotation dialog box]

Enter the reagent name, notes and specific attributes (for example, sample concentration or dilution ratio):

![Example annotation]

Click **OK**. The new information will display in the selected wells:
Step 7 - Save the Assay

1. Select **File** from the main menu and click **Save As**. Enter the assay name and click **Save**.

**NOTE:** New assays are saved in the Compass Assays directory.
Step 8 - Modify Default Analysis Parameters (Optional)

You can preset the parameters used to analyze run data generated with the assay.

1. Select the **Assay** screen.
2. Select **Edit** from the main menu and click **Default Analysis**. The following screen will display:

   ![Default Analysis Screen](image)

   - **Standards**
   - Ladders
   - Images
   - Peak Names
     - Standard Curves
     - Loading Controls
     - Peak Fit
     - Lane Contrast
     - Signal to Noise
     - Advanced

3. We recommend using the default parameters for Simple Western assays. However, you can modify any you want, then click **OK**. For detailed information on analysis parameters, please refer to "Analysis Settings Overview" on page 287.
Step 9 - Modify Default Analysis View (Optional)

You can preset the Graph and Lane view options used to display run data generated with the assay.

1. Select the Assay screen.
2. Select Edit from the main menu and click Default Analysis View. The following screen will display:

3. Select the items you want to use as default Graph display options for your run data, then click OK. For detailed information on these options, please refer to “Graph Options: Customizing the Data Display” on page 265.

4. Click Lane View Options. Select the items you want to use as default Lane display options for your run data, then click OK. For detailed information on these options, please refer to “Lane Options” on page 228.
NOTE: If you save the run file after updating Graph and Lane options in the Analysis window, those selections will be saved in the Default Analysis View and will automatically display the next time you open the run file.
Stellar Assays on Jess: Creating a New Assay

To create a new assay, we recommend using one of the template assays and making any necessary modifications from there.

Step 1 - Open a Template Assay

1. Select the Assay screen.
2. Select File in the main menu, click New Assay and choose Jess:

   Alternatively you can choose Open Assay from the File menu to select from the menu of saved assays.

   **NOTE:** If you make changes to the assay, such as defining the wells in the plate, be sure to select File and Save before proceeding.


4. Select Chemiluminescence or Total Protein if desired.
5. Select Size Range and Cartridge Type.
Step 2 - Review Assay Plate Reagents (Optional)

1. Click on the Layout tab. Displayed are the default row locations where each reagent should be placed on the assay plate.

Plate layout:

Stellar Assay

- **Row A** - Biotinylated ladder (A1) and sample (A2-25)
- **Row B** - Antibody Diluent
- **Row C** - Antibody Diluent (C1) and Primary antibody (C2-C25)
- **Row D** - Streptavidin-NIR (D1) and Stellar secondary antibody (D2-D25)
- **Row E** - Stellar IR or NIR Anneal
- **Row F** - Stellar IR or NIR Label

Stellar Assay with Chemiluminescence

- **Row A** - Biotinylated ladder (A1) and sample (A2-25)
- **Row B** - Antibody Diluent
- **Row C** - Antibody Diluent (C1) and primary antibody (C2-C25)
- **Row D** - Streptavidin-NIR (D1) and Stellar secondary antibody + Secondary HRP conjugate (D2-D25)
- **Row E** - Stellar IR or NIR Anneal
- **Row F** - Stellar IR or NIR Label
- **Row J** - Luminol-S/Peroxide mix
NOTE: For details on sample, reagent and assay plate preparation, please refer to the product insert provided with the Simple Western kits.

Step 3 - Modifying the Assay Protocol (Optional for All Instruments)

1. Click on the Protocol tab. This pane shows the individual steps of the assay protocol and allows you to change parameters. When creating a new assay, the default protocol automatically assigns all reagent locations for the assay. Examples of the standard Stellar Assay (top), Stellar Assay with chemiluminescence (middle) and Stellar Total Protein Assay (bottom) are shown:
### Protocol

<table>
<thead>
<tr>
<th>Step</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Separation Matrix</td>
<td></td>
</tr>
<tr>
<td>Stacking Matrix</td>
<td></td>
</tr>
<tr>
<td>Sample</td>
<td></td>
</tr>
<tr>
<td>Separation Time (min)</td>
<td>35.0</td>
</tr>
<tr>
<td>Separation Voltage (volts)</td>
<td>375</td>
</tr>
<tr>
<td>Antibody Diluent Time (min)</td>
<td>5.0</td>
</tr>
<tr>
<td>Primary Antibody Time (min)</td>
<td>30.0</td>
</tr>
<tr>
<td>Secondary Antibody Time (min)</td>
<td>30.0</td>
</tr>
<tr>
<td>Amplification</td>
<td>10</td>
</tr>
<tr>
<td>Detection</td>
<td></td>
</tr>
<tr>
<td>Detection Profile (NR)</td>
<td>HDR</td>
</tr>
<tr>
<td>Detection Profile (IR)</td>
<td>HDR</td>
</tr>
<tr>
<td>Ladder Channel</td>
<td>HDR</td>
</tr>
</tbody>
</table>

### Protocol

<table>
<thead>
<tr>
<th>Step</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Separation Matrix</td>
<td></td>
</tr>
<tr>
<td>Stacking Matrix</td>
<td></td>
</tr>
<tr>
<td>Sample</td>
<td></td>
</tr>
<tr>
<td>Separation Time (min)</td>
<td>25.0</td>
</tr>
<tr>
<td>Separation Voltage (volts)</td>
<td>375</td>
</tr>
<tr>
<td>Antibody Diluent Time (min)</td>
<td>5.0</td>
</tr>
<tr>
<td>Primary Antibody Time (min)</td>
<td>30.0</td>
</tr>
<tr>
<td>Secondary Antibody Time (min)</td>
<td>30.0</td>
</tr>
<tr>
<td>Amplification</td>
<td>10</td>
</tr>
<tr>
<td>Detection</td>
<td></td>
</tr>
<tr>
<td>Detection Profile (Chemiluminescence)</td>
<td>HDR</td>
</tr>
<tr>
<td>Detection Profile (NR)</td>
<td>HDR</td>
</tr>
<tr>
<td>Detection Profile (IR)</td>
<td>HDR</td>
</tr>
<tr>
<td>Ladder Channel</td>
<td>HDR</td>
</tr>
</tbody>
</table>

### Protocol

<table>
<thead>
<tr>
<th>Step</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Separation Matrix</td>
<td></td>
</tr>
<tr>
<td>Stacking Matrix</td>
<td></td>
</tr>
<tr>
<td>Sample</td>
<td></td>
</tr>
<tr>
<td>Separation Time (min)</td>
<td>25.0</td>
</tr>
<tr>
<td>Separation Voltage (volts)</td>
<td>375</td>
</tr>
<tr>
<td>Antibody Diluent Time (min)</td>
<td>5.0</td>
</tr>
<tr>
<td>Primary Antibody Time (min)</td>
<td>30.0</td>
</tr>
<tr>
<td>Secondary Antibody Time (min)</td>
<td>30.0</td>
</tr>
<tr>
<td>Amplification</td>
<td>10</td>
</tr>
<tr>
<td>Detection</td>
<td></td>
</tr>
<tr>
<td>Detection Profile (Chemiluminescence)</td>
<td>HDR</td>
</tr>
<tr>
<td>Detection Profile (NR)</td>
<td>HDR</td>
</tr>
<tr>
<td>Detection Profile (IR)</td>
<td>HDR</td>
</tr>
<tr>
<td>Ladder Channel</td>
<td>HDR</td>
</tr>
</tbody>
</table>
Each row contains an assay protocol step. Each step can contain a reagent assay plate row assignment and one or more parameter settings. To view the details for a step, click on the white arrow next to the step name. We recommend using the default protocol settings for the assays. An expanded list of the default protocol step parameters for a standard Stellar Assay is shown:

2. You can change the primary or secondary antibody incubation time. Click the cell in the value column next to Primary Antibody Time (min) or Secondary Antibody Time (min) and enter a new value in minutes:
3. The default detection mode is High Dynamic Range (HDR). See "High Dynamic Range Detection Profile" on page 92 for more information.

Additional exposures can be collected in the assay if desired. To do this, click the white arrow next to Detection to expand the row. Click the HDR cell in the column next to Detection Profile (NIR) or (IR) to open the Detection Profile window.
Deselect the High Dynamic Range checkbox. Additional times can be added to the protocol by clicking the **Add** button, entering the values and selecting **OK**.

For Stellar Assays with chemiluminescence or Total Protein, when the High Dynamic Range box is unchecked in Detection Profile (Chemi), you also have the option of selecting the RePlex Dynamic Range:
4. You can modify any other protocol parameters as needed.

NOTE: For more information on changing protocol step parameters other than incubation times, contact ProteinSimple Technical Support toll-free in the US and Canada at 1-888-607-9692 (option 3) or your local Field Application Specialist.

---

**Step 4 - Add Assay Notes (Optional)**

1. Click on the Notes tab.
2. Click in the pane and type any assay or protocol notes. This information will be stored with the assay and run data.
**Step 5 - Add Assay Plate Annotations (Optional)**

Custom reagent names, notes and annotations can be entered for individual rows and wells on the assay plate. This information will be stored with assay and run data. During post-run analysis, this information will be used to apply custom analysis settings to specific sample names, blocking reagent names, primary antibody names or sample and primary antibody attributes. This will be explained in more detail in “Analysis Settings Overview” on page 287.

**NOTE:** Template pane information can also be added or updated after a run is complete.

To enter annotations:

1. Click on the Template tab. The default annotations for reagent rows and individual wells on the assay plate will display:

   ![Template](image)

2. Change or add row and well annotations as needed. To do this:
   
   a. **To enter annotations for a specific well** - Right click the well and select Edit or click Edit in the
upper right corner of the pane or double click the selected well. The following box will display:

Enter the reagent name, notes or specific attributes (for example, sample concentration or dilution ratio):

Click OK. The new information will display in the selected well:

<p>| | | | | | | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
<td>F</td>
<td>G</td>
<td>H</td>
<td>I</td>
<td>J</td>
<td>K</td>
<td>L</td>
<td>M</td>
<td>N</td>
<td>O</td>
</tr>
<tr>
<td>Blot.</td>
<td>L...</td>
<td>0.1 mg/ml</td>
<td>HeLa #1216</td>
<td>Sample</td>
<td>Antibody Diluent</td>
<td>Primary</td>
<td>Secondary</td>
<td>Annul</td>
<td>Label</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

b. **To enter annotations for multiple wells or a row** - To select individual wells, press and hold the Control key and then select individual wells. To select a sequential set of wells or a full row, press and
hold the Shift key, then select the first well and last well. Next, right click and select Edit or click Edit in the upper right corner of the pane. The following box will display:

Enter the reagent name, notes and specific attributes (for example, sample concentration or dilution ratio):

Click OK. The new information will display in the selected wells:
Step 7 - Save the Assay

1. Select File from the main menu and click Save As. Enter the assay name and click Save.

**NOTE:** New assays are saved in the Compass Assays directory.
Step 8 - Modify Default Analysis Parameters (Optional)

You can preset the parameters used to analyze run data generated with the assay.

1. Select the Assay screen.

2. Select Edit from the main menu and click Default Analysis. The following screen will display:

3. We recommend using the default parameters for Simple Western assays. However, you can modify any you want, then click OK. For detailed information on analysis parameters, please refer to “Analysis Settings Overview” on page 287.
Step 9 - Modify Default Analysis View (Optional)

You can preset the Graph and Lane view options used to display run data generated with the assay.

1. Select the Assay screen.
2. Select Edit from the main menu and click Default Analysis View. The following screen will display:

   ![Default Analysis View](image)

3. Select the items you want to use as default Graph display options for your run data, then click OK. For detailed information on these options, please refer to “Graph Options: Customizing the Data Display” on page 265.

4. Click Lane View Options. Select the items you want to use as default Lane display options for your run data, then click OK. For detailed information on these options, please refer to “Lane Options” on page 228.
NOTE: If you save the run file after updating Graph and Lane options in the Analysis window, those selections will be saved in the Default Analysis View and will automatically display the next time you open the run file.
Total Protein Assays: Creating a New Assay on Wes

To create a new assay, we recommend using one of the template assays and making any necessary modifications from there.

NOTES:
If you are using Peggy Sue, Sally Sue or NanoPro 1000, Compass for Simple Western version 6.0 and higher does not support these instruments. You can still use software versions 5.x and lower to create, load, and run assays on these systems, and to analyze your data.

This section provides details on how to create a standard Total Protein assay on Wes. To create a RePlex Assay on Jess or Abby that includes a Total Protein assay, see “RePlex Assays on Jess and Abby: Creating a New Assay” on page 80.

Step 1 - Open a Template Assay
1. Select the Assay screen.
2. Select File in the main menu and click New Assay:

3. Select the template assay for your instrument by selecting Total Protein Size as your assay type, Size Range and Cartridge Type, or choose Open Assay to select from the menu of saved assays.
NOTE: If you make changes to the assay, such as defining the wells in the plate, be sure to select File and Save before proceeding.

Step 2 - Assign Assay Plate Reagents (Optional)

1. Click on the Layout tab. Displayed are the default row locations where each reagent should be placed on the assay plate.

   Wes plate layout:

   - Row A - Biotinylated Ladder (A1) and Sample (A2-A25)
   - Row B - Antibody Diluent (B1) and Labeling Reagent (B2-25)
   - Row C - Antibody Diluent
   - Row D - Total Protein Streptavidin-HRP
   - Row E - Luminol-S/Peroxide mix
   - Row G - Wash buffer
   - Row H - Wash buffer
   - Row I - Wash buffer
• **Row L-P** - Pre-filled Separation Reagents

**NOTE:** For details on sample, reagent and assay plate preparation, please refer to the product insert provided with the Simple Western kits.

2. If needed, well assignments can be modified. Any row assignments changed in the **Layout** pane are updated in the Protocol pane automatically.

• **To move a reagent row to another location** - Click the row in the **Layout** pane, then drag and drop it on the new location. The row from which it was moved will be reassigned as empty.

![Layout Pane Example](image)

• **To insert a sample row** - Click an empty row where the new sample row should be inserted, then click the $S$ icon (Insert a sample row) in the **Layout** pane toolbar. A new sample row will be added in the empty row.
- **To insert a detection row** - Click an empty row where the new detection row should be inserted, then click the D icon (Insert a detection row) in the **Layout** pane toolbar. A new detection row will be added in the empty row.

- **To insert a tertiary incubation reagent** - Click an empty row where the new incubation reagent should be inserted, then click the 3 icon (Insert a tertiary row) in the **Layout** pane toolbar. A new incubation reagent row will be added in the empty row.
NOTE: Row F is the last row assignment that can be used on the assay plate. New, sample, incubation or luminol rows cannot be inserted if all rows have an assigned reagent. To insert a row in this case, you must first delete the contents of a row.

- **To delete a row** - Click the row to be deleted, then click the red X icon (Delete a row) in the toolbar. Rows for required assay reagents cannot be deleted.

NOTE: Rows J and K are purposely left empty, don’t put anything into these wells.
Step 3 - Modifying the Assay Protocol (Optional for All Instruments)

1. Click on the Protocol tab. This pane shows the individual steps of the assay protocol and allows you to change parameters. When creating a new assay, the default protocol automatically assigns all reagent locations for the assay.

Each row contains an assay protocol step. Each step can contain a reagent assay plate row assignment and one or more parameter settings. To view the details for a step, click on the white arrow next to the step name. We recommend using the default protocol settings for the assays. An expanded list of the default protocol step parameters is shown:
2. You can change the biotin labeling and Total Protein streptavidin-HRP incubation time. Click the cell in the value column next to Biotin Labeling Time (min) or Total Protein HRP Time (min) and enter a new value in minutes:

3. You can also change the biotin labeling and Total Protein streptavidin-HRP row location. Click the cell in the value column next to Well Row and select a different row on the assay plate:
4. The default detection mode is High Dynamic Range (HDR). See “High Dynamic Range Detection Profile” on page 92 for more information.

Additional exposures can be collected in the assay if desired. To do this, click the white arrow next to Detection to expand the row. Click the HDR cell in the column next to Detection Profile to open the Detection Profile window.
Deselect the High Dynamic Range checkbox. Additional times can be added to the protocol by clicking the Add button, entering the values and selecting OK.

5. You can modify any other protocol parameters as needed.
NOTES: For more information on changing protocol step parameters other than incubation times, contact ProteinSimple Technical Support toll-free in the US and Canada at 1-888-607-9692 (option 3) or your local Field Application Specialist.

Steps 4 - 9
Steps 4 through 9 for creating a Total Protein Assay are the same as when you're creating an Immunoassay. Please go to “Step 4 - Add Assay Notes (Optional),” starting on page 47 to continue.

Protein Normalization on Jess: Creating a New Assay

Step 1 - Open a Template Assay
1. Select the Assay screen.
2. Select File in the main menu, click New Assay and choose Jess:

3. Select the template assay by selecting Protein Normalization in addition to Fluorescence and/or Chemiluminescence as your assay type, Size Range and Cartridge Type, or choose Open Assay from the File menu to select from the menu of saved assays.

NOTE: Protein Normalization isn’t available with Stellar Assays. A Stellar Total Protein Assay can be used instead when normalization is needed.
NOTE: If you make changes to the assay, such as defining the wells in the plate, be sure to select **File** and **Save** before proceeding.

Step 2 - Assign Assay Plate Reagents

1. Click on the Layout tab. Displayed is the default row location (green) where the protein normalization reagent should be placed on the assay plate.

   **Jess plate layout:**

   - **Row A** - Biotinylated Ladder (A1) and Sample (A2-A25)
   - **Row B** - Protein Normalization Reagent
   - **Row C** - Milk-Free Antibody Diluent
   - **Row D** - Milk-Free Antibody Diluent (D1) and Primary Antibody Multiplex mix (D2-D25)
   - **Row E** - Streptavidin-NIR (E1) and Secondary Antibody Multiplex mix (E2-E25)
   - **Row F** - Empty for fluorescence only, Luminol/Peroxide mix for chemiluminescence
   - **Row G** - Wash buffer
• Row H - Wash buffer  
• Row I - Wash buffer  
• Row L-P - Pre-filled Separation Reagents  

NOTE: For details on sample, reagent and assay plate preparation, please refer to the product insert provided with the Simple Western kits.

Step 3 - Modifying the Assay Protocol (Optional for All Instruments)

Steps 3 for creating a Protein Normalization Assay on Jess are the same as when you’re creating an Immunoassay. Please go to “Step 3 - Modifying the Assay Protocol (Optional for All Instruments),” starting on page 42 to continue.

Steps 4 - 9

Steps 4 through 9 for creating a Protein Normalization Assay are the same as when you’re creating an Immunoassay. Please go to “Step 4 - Add Assay Notes (Optional),” starting on page 47 to continue.

RePlex Assays on Jess and Abby: Creating a New Assay

Step 1 - Open a Template Assay

1. Select the Assay screen.
2. Select File in the main menu, click New Assay and choose Jess:

   ![Screenshot of Assay menu]

   Alternatively you can choose Open Assay from the File menu to select from the menu of saved assays.
NOTE: If you make changes to the assay, such as defining the wells in the plate, be sure to select File and Save before proceeding.

3. Select RePlex.

These RePlex Assay combinations are currently validated on Jess and Abby:

- Chemiluminescence + chemiluminescence
- Chemiluminescence + Total Protein
- Chemiluminescence/NIR fluorescence + Total Protein (Jess only)
- NIR fluorescence + NIR fluorescence (Jess only)
- NIR fluorescence + chemiluminescence (Jess only)

The assay selected for Probe 1 is run first. When Probe 1 is complete, Jess and Abby perform a wash, RePlex purge, and wash step combination prior to beginning the assay selected for Probe 2.

4. Select the type of assays.

**To run two immunoassays:**

**Abby** - When RePlex is selected as the Assay Type for Abby, chemiluminescence will be run for both Probe 1 and 2.

**Jess** - Select any combination of chemiluminescence or fluorescence for Probes 1 and 2. The default selection is chemiluminescence for both. For example:
To run one immunoassay and one Total Protein assay:

**Abby** - Select **Total Protein**. Probe 1 will be used for chemiluminescence. Probe 2 will be used for the Total Protein assay.

**Jess** - Select **Total Protein**, then select any combination of chemiluminescence or fluorescence for Probe 1. Probe 2 will be used for the Total Protein assay. For example:

5. Select **Size Range** and **Cartridge Type**.
Step 2 - Assign Assay Plate Reagents

1. Click on the Layout tab. Default row locations where each reagent should be placed on the assay plate are displayed. Reagents used in Probe 1 are labeled '1' on the plate, those used in Probe 2 are labeled '2'.

2 Immunoassays

- **Row A** - Biotinylated ladder (A1) and Samples (A2-A25)
- **Row B** - Antibody Diluent
- **Row C** - Primary Probe 1: Antibody Diluent (C1) and Primary antibody for Probe 1 (C2-C25)
- **Row D** - Secondary Probe 1: Streptavidin-HRP or NIR (D1) and Secondary antibody for Probe 1 (D2-D25)
- **Row E** - Primary Probe 2: Antibody Diluent (E1) and Primary antibody for Probe 2 (E2-E25)
- **Row F** - Secondary Probe 2: Antibody Diluent (F1) and Secondary antibody for Probe 2 (F2-F25)
- **Row J** - Luminol/Peroxide mix (chemiluminescence only)
- **Row K** - RePlex reagent mix

Immunoassay + Total Protein

- **Row A** - Biotinylated ladder (A1) and Samples (A2-25)
- **Row B** - Total Protein biotin labeling reagent
- **Row C** - Antibody Diluent
- **Row D** - Primary Probe 1: Antibody Diluent (D1) and Primary antibody for Probe 1 (D2-D25)
- **Row E** - Secondary Probe 1: Streptavidin-HRP or NIR (E1) and Secondary antibody for Probe 1 (E2-E25)
- **Row F** - Total Protein Streptavidin-HRP for Probe 2 (F1-F25)
- **Row J** - Luminol/Peroxide mix
- **Row K** - RePlex reagent mix

---

**NOTE**: For details on sample, reagent and assay plate preparation, please refer to the product insert provided with the Simple Western kits.
2. If needed, the Secondary antibody row assignments for either Probe 1 or 2 can be deleted for assays where the Primary antibody contains HRP. Any row assignments changed in the Layout pane are updated in the Protocol pane automatically.

Click the Secondary antibody row you want to delete, then click the red X icon (Delete a row) in the toolbar. Only Secondary antibody rows can be deleted. Rows required for other assay reagents cannot be deleted.

Step 3 - Modifying the Assay Protocol (Optional)

1. Click on the Protocol tab. This pane shows the individual steps of the assay protocol and allows you to change parameters. When creating a new assay, the default protocol automatically assigns all reagent locations for the assay. A Jess chemiluminescence/NIR fluorescence + Total Protein RePlex Assay is shown in this example:
Each row contains an assay protocol step. Each step can contain a reagent assay plate row assignment and one or more parameter settings. To view the details for a step, click on the arrow next to the step name. We recommend using the default protocol settings for the assays. An expanded list of the default protocol step parameters is shown below:

2. You can change the primary or secondary antibody incubation time. Click the cell in the value column next to Primary Antibody Time (min) or Secondary Antibody Time (min) and enter a new value in minutes:

---

NOTE: If you won’t be using a Secondary antibody with Probe 1 or 2, set the Secondary Antibody incubation time to 0.
3. The default detection mode for chemiluminescent RePlex Assays is RePlex Dynamic Range (RDR). See “RePlex Dynamic Range Detection Profile” on page 95 for more information. The default detection mode for fluorescent RePlex Assays (Jess only) is NIR with 6 standard exposures.

Additional exposures can be collected in the assay, and IR exposures can be added if desired. To do this, click the white arrow next to Detection to expand the row. Click the cell in the exposure column next to Detection Profile in either the Probe 1 or Probe 2 column to open the Detection Profile window.
Chemiluminescent detection:

Deselect the RePlex Dynamic Range checkbox. Up to 6 additional times (for a total of 7 exposures) can be added to the protocol by clicking the Add button, entering the values and selecting OK.
NIR Fluorescent detection (Jess only):
Additional times can be added to the protocol by clicking the Add button, entering the values and selecting OK.

IR Fluorescent detection (Jess only):
An IR detection profile can be added to the protocol by clicking the Add button, entering exposure values and selecting OK.
4. You can modify any other protocol parameters as needed.

NOTE: For more information on changing protocol step parameters other than incubation times, contact ProteinSimple Technical Support toll-free in the US and Canada at 1-888-607-9692 (option 3) or your local Field Application Specialist.

Steps 4 - 9

Steps 4 through 9 for creating a RePlex Assay are the same as when you’re creating an Immunoassay. Please go to “Step 4 - Add Assay Notes (Optional),” starting on page 47 to continue.
Making Changes to an Existing Assay

1. Select the Assay screen.
2. Select File in the main menu and click Open Assay.
3. A list of the last assays opened will display. Select one of these assays or click Browse to open the assay folder and select a different assay.
4. Follow the steps in “Standard Immunoassays: Creating a New Assay” on page 37 to make changes and save the assay.

Switching Between Open Assays

If more than one run file is open, you can switch between viewing the assays for each run. To do this:

1. Click the down arrow in the run box.
2. Select the run for the assay you want to view from the drop down list.
Creating a Template Assay

You can create and save template assays that can be used as a starting point for creating new assays. To do this:

1. Select the Assay screen.

2. Select File in the main menu. Click Open Assay to open an existing assay or click New Assay to open an existing template assay.

3. Follow the steps in “Standard Immunoassays: Creating a New Assay” on page 37 to make changes to the assay.

4. When changes are complete, select File in the main menu and click Save As. Select the New Assays folder:

5. Type the name for the new template assay and click Save.

6. Select File in the main menu and click Open Assay. The new template assay will now be available in the drop down list:
Viewing and Changing the Detection Exposures

To view the current detection profile, roll the cursor over the exposures cell in Protocol pane. In this example, a Jess chemiluminescent immunoassay is shown:

![Detection Exposures Example](image)

**High Dynamic Range Detection Profile**

Starting with Compass for Simple Western 4.0 and the Jess instrument, HDR (high dynamic range) is the default detection profile for chemiluminescent detection, and with Compass for Simple Western 6.1 and higher, HDR is the default detection profile for Stellar fluorescence detection (Jess only). Exposure times for HDR have been optimized for best performance and can’t be edited. These exposures were selected for maximum performance for each instrument when HDR mode is selected. Below is an example of different exposure settings:
To achieve a broader detection dynamic range, you need Compass for Simple Western v4.0 or higher. To download the latest version of the software go to Help > Check for Updates.

The higher dynamic range is achieved by using a more effective algorithm to create the High Dynamic Range multi-image analysis, refreshing substrate from the assay plate prior to each exposure and minimizing the time between substrate aspiration and Image.

NOTE: See "Images Analysis Settings" on page 296 to find out more about how data sets are analyzed under HDR and standard detection profiles.

If you need to switch to an older detection profile for data generated on another Simple Western instrument or if you'd rather not use HDR detection profile, uncheck the box next to HDR in the Detection Profile. Doing so reverts all instrument functions to a pre-Compass 4.0 state. Under this detection profile, the exposure times can be edited.
For non-RePlex chemiluminescence assays on Jess and Abby, when the High Dynamic Range box is unchecked, you also have the option of selecting RePlex Dynamic Range:
RePlex Dynamic Range Detection Profile

For RePlex assays that use chemiluminescent detection, RePlex dynamic range (RDR) is the default detection profile. Exposure times for RDR use the short exposure times from HDR, eliminating the 128 and 512 second exposures. Below is an example of different exposure settings:

![RePlex Dynamic Range Detection Profile Example](image)

**NOTE:** See “Images Analysis Settings” on page 296 to find out more about how data sets are analyzed under HDR and standard detection profiles.

If you'd rather not use the RDR detection profile, uncheck the box. For more information on RDR, please refer to Simple Western assay optimization guidelines. The exposure times can then be manually added and edited. For RePlex assays, up to 7 exposures may be added to the Detection Profile.
Changing the Detection Profile

While we recommend using the default detection profile, you can change the profile, exposure times and exposure sequences if needed. To do this:

1. Select the exposures cell in the Protocol pane and click the button, or double-click in the cell. The following screen displays:
NOTE: Assays created and saved with Compass v2.7 or Compass for Simple Western v3.0 will have HDR unchecked by default. If you want HDR to be the default detection profile for that assay, check the box next to HDR in the Detection Profile, then re-save the assay.

a. **To change an existing exposure time** - Uncheck High Dynamic Range or RePlex Dynamic Range if checked. Then click in the exposure cell and enter a new time in seconds:
b. **To delete an existing exposure** - Select a type or exposure cell and click **Remove**.

c. **To add a new exposure** - Select **Add**. A new exposure will be added to the end of the list. Click in the exposure cell and enter an exposure time in seconds.

2. Click **OK** to save and exit.

**Copying Protocols and Templates**

The steps and parameters in the Protocol pane can be copied and pasted into other documents, as can the graphic image of the annotations in the Template pane.

**Copying an Assay Protocol**

1. Click on the Protocol tab.
2. Select **Edit** in the main menu and click **Copy**.
3. Open a document (Microsoft® Word®, Excel®, etc.). Right click in the document and select **Paste**. All assay protocol steps and parameters will be copied into the document as a list in the same format shown in the Protocol pane.
Copying an Assay Template
1. Click on the Template tab.
2. Select Edit in the main menu and click Copy.
3. Open a document (Microsoft® Word®, Excel®, etc.). Right click in the document and select Paste. The assay template will be copied into the document as an image, exactly as it is shown in the Template pane.

Printing Protocols and Templates
The information in the Protocol pane can be printed, as can a graphic image of the information in the Template pane.

Printing an Assay Protocol
1. Click on the Protocol tab.
2. Select File in the main menu, click Print, and then click Print Protocol.

All assay protocol steps and parameters will be printed as a list in the same format shown in the Protocol pane.

Printing an Assay Template
1. Click on the Template tab.
2. Select File in the main menu, click Print, and then click Print Template.
The assay template will print as an image, exactly as it is shown in the Template pane.

Importing and Exporting Protocols and Templates

The assay protocol in an open assay or run file can be exported as a separate file, as can the assay template annotation information. This allows the same assay protocol and template information to be imported into another assay at a later time, rather than having to re-enter assay protocol and template information manually.

Importing an Assay Protocol

**NOTE:** Importing an assay protocol imports information into the Protocol pane only.

1. Open the assay you want to import the assay protocol in to.
2. Select **File** in the main menu and click **Import Protocol**.
3. Select a protocol file (*.protocol) and click **OK**. The imported information will display in the Protocol pane.
Exporting an Assay Protocol

NOTE: Exporting an assay protocol exports information in the Protocol pane only.

1. Open the assay you want to export the assay protocol from.
2. Select **File** in the main menu and click **Export Protocol**. The following window displays:

3. The default directory is Compass/Assays. Change the directory if needed.
4. Enter a protocol name and click **Save**. The protocol will be saved as a *.protocol file.
Template Export and Import

The Template information including the sample and reagent names can be exported to a file.

There are three file format options:

- A comma separated CSV file that is best opened in a spreadsheet.
- An XML template file that has full control over the sample and reagent names and layout.
- A tab delimited TXT file that can be opened in a spreadsheet even when the decimal separator is set to a comma.

Exporting then Importing the Template to a CSV file

Follow the steps below to easily export a template from Compass for Simple Western, populating it with reagent names (sample, antibody, etc.) and their corresponding attributes (concentration, dilution factor, etc.).

1. Select **File** in the main menu and click **Export Template**. The following window displays:
Make sure the Save as type is set to CSV.

2. Enter a protocol name and click **Save**. The protocol will be saved as a *.csv file.
3. Open the CSV file in a spreadsheet program like Microsoft® Excel®.

The names in the spreadsheet are arranged in the same order as the Compass Template, and the rows alternate between names and attributes.
NOTE: The default assay has no attributes so these rows will be empty.

4. Edit the names and add attributes, then save the spreadsheet as a CSV file.

NOTE: Make sure not to edit the first column of the spreadsheet, this corresponds to the ladder wells.

5. To import the edited CSV file into Compass for Simple Western, select File in the main menu, click Import Template and then browse to the .cvs file you just saved. Once imported, the edited CSV file displays the edited Sample names and Primary Antibody with attributes in the Template.

Template Cut and Paste

The names and attributes in the Template can be copied and pasted within Compass for Simple Western, between two copies of Compass, and between Compass and a spreadsheet like Microsoft® Excel®.

All you need to do is enter names in a spreadsheet row, then copy to the clipboard. Next, select a well in the Template and paste from the clipboard. The new names will be pasted into the row at the selected column and columns to the right. Here’s a quick example of how to do it:

1. Copy these three rows from a spreadsheet:

2. Select a well in the Template, A2 is selected for this example:
3. Paste the names from the clipboard.

*Note: Make sure not to select any of the ladder wells (A1, B1, C1, etc.)*

4. To include attributes, add them in the next row:

5. Pasting into the Template will update the names and attributes.
Multiple rows can also be copied and pasted with names and attributes on alternate rows:

Only wells in the same row can be selected, but multiple rows will be pasted into the rows below.

*Note: Make sure not to select any of the ladder wells (A1, B1, C1, etc.)*
Chapter 3:
Running a Size Assay

Chapter Overview
• Starting a Run
• Stopping a Run
Starting a Run

NOTE: If you are using Peggy Sue, Sally Sue or NanoPro 1000, Compass for Simple Western version 6.0 and higher does not support these instruments. You can still use software versions 5.x and lower to create, load and run assays on these instruments, and to analyze your data.

Step 1 - Get Ready

1. Turn your system on and open Compass for Simple Western. Allow the system to remain on for at least 1.5 hours before starting a run to ensure the instrument reaches its temperature setpoint.
2. Create or open an assay file in Compass for Simple Western.
3. Prepare the assay plate using the information provided in the product insert.

   IMPORTANT
   If a row on the assay plate contains reagents in some wells but not in others, pipette DI water or sample diluent into the empty wells of that row. This prevents air aspiration and bubble formation.

   To prevent well evaporation and ensure best results, keep a lid on the assay plate until ready to use.

4. Prepare the instrument following the procedure described in the User Guide.

   IMPORTANT
   Capillaries are light sensitive. Keep them covered until you are ready to transfer the capillary cartridge to the instrument.

5. Place assay plate into the sample tray of the instrument.

Step 2 - Start the Run

You can start a run in one of two ways depending on whether you want to run an assay using existing parameters or set up a new assay.

   NOTE: Start runs from the Assay screen only.
1. New run of an existing assay:
   a. In the Assay screen, select File in the main menu and click Open Assay.

   ![Assay screen with Open Assay option]

   b. A list of the last five assays opened will display. Select one of these assays or click Browse to open the Assay folder and select a different assay.

2. Alternatively, choose New Assay and select one of the size assays to get the default assay conditions for using Jess, Wes, or Abby.
   a. The Start button will display. This indicates that an assay has been loaded.

   ![Start button displayed]

3. Click Start to begin the run.

   The Start Run window for immunoassays displays with the default run file name and location. In the example below, Start Run windows for a standard Immunoassay and a RePlex Assay are shown. You can edit the file name and/or click Browse if you want to save it in a different location.

   ![Start Run window example]

   NOTE: Run file names should not exceed 255 characters.
NOTE: If the cartridge type or plate installed in the instrument doesn't match the assay selected for the run, messages indicating this will display in the Start Run window. If this happens, click **Cancel** and adjust your assay settings before starting the run again.

Click **Start** to begin the run. Instrument status will change to Running, the Start button will change to Stop and the Run Progress bar will display:

![Run Progress Bar](image)

**Step 3 - Post-Run Procedures**

1. Remove the capillary cartridge.
2. Remove the assay plate.
3. Dispose of the assay plate and capillaries. Disposal will depend on the samples that have been assayed. If sample origins are unknown, we recommend that used capillary cartridges and plates be disposed of as biohazard waste.

**!WARNING! SHARPS HAZARD**

The capillaries may present a potential sharps hazard. Dispose of used capillaries in biomedical waste sharps containers.

**!WARNING! BIOHAZARD**

Samples and waste bottle contents should be handled by procedures recommended in the CDC/NIH manual: Biosafety in Microbiological and Biomedical Laboratories (BMBL). The manual is available from the U.S. Government Printing Office or online at [http://www.cdc.gov/biosafety/publications/bmbl5/](http://www.cdc.gov/biosafety/publications/bmbl5/).

Depending on the samples used, waste bottle contents may constitute a biohazard. Use precaution when emptying the waste bottle. Dispose of waste bottle contents in accordance with good laboratory practices and local, state/provincial and national environmental and health regulations. Read and understand the Material Safety Data Sheets (MSDSs) provided by the manufacturers of the chemicals in the waste vial before you store, handle or dispose of chemical waste.
Stopping a Run

To stop a run, click Stop.

When the run stops, the Start button will reappear and the instrument will start a process that plugs the capillaries in the cartridge. Once that’s done, you can then remove the capillary cartridge and plate and discard them. The stopped status, date and time will display in the Run Summary screen.
Chapter 4:
Imaging a Blot on Jess

Chapter Overview
• Starting a Run
Starting a Run

Step 1 - Get Ready

1. Prepare the membrane and assemble the blot cartridge following the product insert.
2. Open Compass for Simple Western software on your desktop.
3. Make sure that the software is connected to the instrument.
4. Insert the blot cartridge into the blot holder. The light in the blot holder will change from orange to blue when correctly seated.
5. Close the instrument door by gently pushing it until you feel Jess pull it closed.

The software will automatically change to the Blot screen:

---

Step 2 - Start the Imaging Run

*NOTE: Jess’s door must be closed before starting the imaging run.*
Once the blot cartridge is installed and Jess’s door is closed, Compass for Simple Western will automatically provide a preview image.

1. Edit the exposure settings in the Exposures table.
   - To add an exposure: Click Add then select the exposure time to change it.
   - To remove an exposure: Select the exposure and click Remove.
   - To edit exposure time: Click on an exposure and enter a new time.
2. Check the **Markers** box if the blot contains a molecular weight ladder.

3. To load the saved settings from an existing blot imaging protocol file (*.blot), click **Open**. Select the protocol file and click **Open**.

4. You can change the Results File name and location if desired. Imaging file names are automatically generated as `date_time_blot.btz` and saved in the Compass for SW\Blots folder of your My Documents folder.

5. Optional: Add any comments you would like saved with your imaging run in the **Comments** box and click **Save**.
6. Optional: To save the settings associated with this blot imaging protocol for future use, click **Save**.

7. Click **Start** to begin imaging.

**Step 3 - Imaging Run Summary and Analysis**

**Reviewing Imaging Data**

When the imaging run starts, thumbnails are shown in the Run Summary screen.
As images are acquired, they populate the predefined thumbnail boxes and also display in the Review pane. Unless you click on a thumbnail, the most recently acquired image displays in the Review pane. Images that haven’t been taken yet will display blank until the image is acquired.

The Run Summary pane will display thumbnail images for each exposure configured in the imaging protocol:

NOTE: The Markers image is taken at the end of the imaging run. If you click Stop before all exposures are taken, the software will prompt you to confirm that you want to stop the run before the Markers image is taken.

Adjusting Blot Images

You can adjust the blot image using the Review pane toolbar.
The toolbar has the following options:

- Contrast Adjustment
- Auto Contrast
- Invert
- Overlay Markers

An unadjusted blot image is shown in the following example:

![Unadjusted blot image example]

**Exporting Image Files**

To export raw images for further analysis, from the main menu, select **File > Export Images**. Then select a folder to export the files to.
Compass for Simple Western will automatically launch a Windows Explorer window for you to access the saved files. Images are saved in .png format, and both raw and adjusted images are saved in the folder.

- **Raw chemiluminescence images are saved as**: `<Results File Name>_Chemi_<Exposure Number>_<Exposure Time>`.
- **Processed images, as shown in the Review pane, are saved as**: `<Results File Name>_view`.
- **Raw and processed marker images are saved as**: `<Results File Name>_Markers and <Results File Name>_Markers_view`, if selected during the blot imaging protocol.

**Step 4 - Post-Imaging Procedures**

When imaging is done, you’ll need to:

1. Remove the blot cartridge.
2. Remove your membrane and clean the blot cartridge by rinsing it with water. Dry with a lint-free wipe.
3. Wipe down the area underneath the blot cartridge in the instrument with a dry lint-free wipe.
4. Keep the blot cartridge in a dry, clean area protected from dust.

**Stopping a Run**

To stop an imaging run, click **Stop** and confirm your choice. When the run stops, the Start button will reappear so you can start another run when you’re ready.
Chapter 5:
Run Status

Chapter Overview
• Run Summary Screen Overview
• Opening Run Files
• Viewing File and Run Status Information
• Watching Standards Separation Movies
• Viewing Current and Voltage Plots
• Switching Between Open Run Files
• Closing Run Files
Run Summary Screen Overview

The Run Summary screen is used to monitor run progress, watch movies of the fluorescent standards separation, and view current and voltage plots for a run. To access this screen, click Run Summary in the screen tab:

Run Summary Screen Panes

The Run Summary screen has three panes:

- **Status** - Displays run file information and current status of a run in progress.

  *NOTE: If status doesn’t update during a run, there may be a disconnect between the instrument and computer. If this happens and the status light on the instrument is still blinking, let the run complete first and then reconnect to the instrument.*

- **Separation** - Lets you view a movie of the fluorescent standards separation for each cycle of the experimental run.

- **IV Plot** - Lets you view plots of the total current and voltage measured during separation for all capillaries for each cycle of the experimental run.
Software Menus Active in the Run Summary Screen

The following software menus are available:

- File
- Edit
- Instrument (when Compass for Simple Western is connected to an instrument)
- Window
- Help

The File and Edit menu options specific to the Run Summary screen are described next.

File Menu

The following File menu options are active:

- **Open Run** - Opens a run file.
- **Add Run** - Open and view other run files in addition to the one that is already open.
- **Close** - Closes the run file currently being viewed.
- **Close All** - Closes all open run files.
- **Save** - Saves the open run file.
- **Save As** - Saves the open run file under a different file name.
- **Exit** - Closes Compass for Simple Western.
**Edit Menu**

The following Edit menu options are active:

- **Preferences** - Set and save custom preferences for data export, plot colors in the graph and Twitter settings. See Chapter 8, “Setting Your Preferences” for more information.

**Opening Run Files**

You can open one run file or multiple run files at a time to compare information between runs.

**Opening One Run File**

1. In the Analysis screen, select **File** in the main menu and click **Open Run**.

2. A list of the last 10 runs opened will display. Select one of these runs or click **Browse** to open the Runs folder and select a different file. When connected to an instrument, you can also select **Instrument** in the main menu and click **Runs** to select a different run file.
Opening Multiple Run Files

1. To open the first run file, select **File** in the main menu and click **Open Run**.

![Screenshot of the Simple Western ERK Demo software interface showing the Open Run and Add Run options.](image)

2. A list of the last 10 runs opened will display. Select one of these runs or click **Browse** to open the Runs folder and select a different file. When connected to an instrument, you can also select **Instrument** in the main menu and click **Runs** to select a different run file.

3. To open another run file, select **File** in the main menu and click **Add Run**.

![Screenshot showing the Add Run option in the Simple Western ERK Demo software interface.](image)

4. A list of the last 10 runs opened will display. Select one of these runs or click **Browse** to open the Runs folder and select a different file.

5. Repeat the last two steps to open additional runs.

**NOTES:**

- When adding multiple data files for analysis, they must contain matching detection channels (for example, chemi, IR/NIR fluorescence, or IR/NIR fluorescence with Protein Normalization).

- When adding multiple RePlex data files (Jess/Abby only), the channels for both probes must contain matching detection files. For example, a chemiluminescence with Total Protein data file can’t be added to a chemiluminescence/chemiluminescence data file.
Viewing File and Run Status Information

Information specific to each run file is shown in the Status pane:

![Status pane screenshot]

The run file name, path (directory location) and assay used is displayed along with instrument serial number and the run start/complete date and time.

- **To go to the run file directory location** - Double click the path hyperlink, or right-click and select Open Directory.
- **To copy the path** - Right-click on the path hyperlink and click Copy. The path can then be copied into documents. The path can also be copied into the Windows Explorer address bar to launch Compass for Simple Western and open the run file automatically.
- **Kit info** - Compass for Simple Western v2.7 and higher displays the type of kit used to run the assay (regular for immunoassays, total protein or charge), the molecular range and whether or not the split Running Buffer was used.
- **Plate S/N** - The plate serial number (S/N) information is captured and displayed for all assays.

---

**NOTE:** If plates with an 11 digit barcode are used with Compass SW 6.0 or older versions of the software, a 'Confirm plate type matches assay' informational message will appear in the Jess Start Run dialog window.
Assay Steps: Size-based Assays

Each assay step that is executed during the run is represented by an icon. The time the individual step is scheduled to start is shown under each icon. Details on what happens during each assay step is as follows:

**Stellar Assays (Jess Only)**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample</td>
<td><strong>Sample Loading Step</strong> - Capillaries are moved to the assay plate in the sample tray where Separation Matrix, Stacking Matrix, biotinylated ladder and samples are aspirated. Capillaries are then transferred to the running buffer trough.</td>
</tr>
<tr>
<td></td>
<td><strong>Separation Step</strong> - Samples and fluorescent standards are separated in the capillaries. Capillaries are then exposed to UV light, which immobilizes the separated proteins to the walls of each capillary. During the separation, voltage and current are monitored and displayed in the IV Plot. Separation of the fluorescent standards is recorded and a movie of the separation is compiled for viewing when separation is complete in the Separation pane. After separation, Matrix Removal Buffer is aspirated.</td>
</tr>
<tr>
<td>Label</td>
<td><strong>Label Step (Total Protein only)</strong> - Capillaries are moved to the assay plate in the sample tray and Biotin labeling reagent is aspirated. When incubation is complete, Wash Buffer is aspirated.</td>
</tr>
<tr>
<td>Block</td>
<td><strong>Blocking Step</strong> - Capillaries are moved to the assay plate in the sample tray and blocking reagent (Antibody Diluent) is aspirated. When incubation is complete, Wash Buffer is aspirated.</td>
</tr>
</tbody>
</table>
When a run is in progress, icons for steps that have not executed will be grey (inactive). In the following example, the Amplify step is executing and the Detect and Results steps have not started:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1°</td>
<td>Primary Antibody (1°) Step - Capillaries are moved to the assay plate in the sample tray and primary antibody is aspirated. When incubation is complete, Wash Buffer is aspirated.</td>
</tr>
<tr>
<td>2°</td>
<td>Secondary Antibody (2°) Step - Capillaries are moved to the assay plate in the sample tray and Stellar secondary antibody is aspirated. When incubation is complete, Wash Buffer is aspirated.</td>
</tr>
<tr>
<td>Amplify</td>
<td><strong>Amplify Step</strong> - Capillaries are moved to the assay plate in the sample tray and Stellar IR or NIR Anneal is aspirated. Capillaries are then moved to the assay plate again to aspirate Stellar IR or NIR Label. These steps are repeated 10 times. When amplification is complete, Wash Buffer is aspirated.</td>
</tr>
<tr>
<td>Detect</td>
<td><strong>Detect Step</strong> - Capillaries are moved to the assay plate in the sample tray and Luminol-Per-oxide solution is aspirated (chemiluminescence only). Emitted chemiluminescent light is detected with the CCD camera. For Stellar fluorescence detection, emitted fluorescent signal is detected.</td>
</tr>
<tr>
<td>Results</td>
<td><strong>Results Step</strong> - Results are available in the Analysis screen.</td>
</tr>
</tbody>
</table>
### RePlex Assays (Jess/Abby Only)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Loading Step</td>
<td>Capillaries are moved to the assay plate in the sample tray where Separation Matrix, Stacking Matrix, biotinylated ladder and samples are aspirated. Capillaries are then transferred to the running buffer trough.</td>
</tr>
<tr>
<td>Separation Step</td>
<td>Samples and fluorescent standards are separated in the capillaries. Capillaries are then exposed to UV light, which immobilizes the separated proteins to the walls of each capillary. During the separation, voltage and current are monitored and displayed in the IV Plot. Separation of the fluorescent standards is recorded and a movie of the separation is compiled for viewing when separation is complete in the Separation pane. After separation, Matrix Removal Buffer is aspirated.</td>
</tr>
<tr>
<td>Label Step (Total Protein only)</td>
<td>Capillaries are moved to the assay plate in the sample tray and Biotin labeling reagent is aspirated. When incubation is complete, Wash Buffer is aspirated.</td>
</tr>
<tr>
<td>Blocking Step</td>
<td>Capillaries are moved to the assay plate in the sample tray and blocking reagent (Antibody Diluent) is aspirated. When incubation is complete, Wash Buffer is aspirated.</td>
</tr>
<tr>
<td>Primary Antibody (1°) Step</td>
<td>Capillaries are moved to the assay plate in the sample tray and primary antibody is aspirated. When incubation is complete, Wash Buffer is aspirated.</td>
</tr>
<tr>
<td>Secondary Antibody (2°) Step</td>
<td>Capillaries are moved to the assay plate in the sample tray and secondary HRP/NIR/IR antibody conjugate and Streptavidin-HRP/NIR is aspirated. When incubation is complete, Wash Buffer is aspirated.</td>
</tr>
<tr>
<td>HRP Step (Total Protein only)</td>
<td>Capillaries are moved to the assay plate in the sample tray and Total Protein Streptavidin-HRP is aspirated. When incubation is complete, Wash Buffer is aspirated.</td>
</tr>
<tr>
<td>Detect Step</td>
<td>Capillaries are moved to the assay plate in the sample tray and Luminol-Peroxide solution is aspirated (chemiluminescence only). Emitted chemiluminescent light is detected with the CCD camera. For fluorescence detection on Jess, emitted fluorescent signal is detected.</td>
</tr>
</tbody>
</table>
When a run is in progress, icons for steps that have not executed will be grey (inactive). In the following example, the Secondary Antibody (2°) step is executing and the Detect and Results steps have not started:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purge</td>
<td><strong>Purge Step</strong> - Capillaries are moved to the assay plate in the sample tray and Wash Buffer is aspirated. RePlex reagent mix is then aspirated to remove the primary and secondary antibodies from the immobilized sample proteins. This is followed by another round of Wash Buffer.</td>
</tr>
<tr>
<td>Results</td>
<td><strong>Results Step</strong> - Results are available in the Analysis screen.</td>
</tr>
</tbody>
</table>
## Standard Size Assays

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sample Loading Step</strong></td>
<td>Capillaries are moved to the assay plate in the sample tray where Separation Matrix, Stacking Matrix, biotinylated ladder and samples are aspirated. Capillaries are then transferred to the running buffer trough.</td>
</tr>
<tr>
<td><strong>Separation Step</strong></td>
<td>Samples and fluorescent standards are separated in the capillaries. Capillaries are then exposed to UV light, which immobilizes the separated proteins to the walls of each capillary. During the separation, voltage and current are monitored and displayed in the IV Plot. Separation of the fluorescent standards is recorded and a movie of the separation is compiled for viewing when separation is complete in the Separation pane. After separation, Matrix Removal Buffer is aspirated.</td>
</tr>
<tr>
<td><strong>Protein Normalization Step (Jess only)</strong></td>
<td>Capillaries are moved to the assay plate in the sample tray and the protein normalization reagent is aspirated. When incubation is complete, Wash Buffer is aspirated.</td>
</tr>
<tr>
<td><strong>Blocking Step</strong></td>
<td>Capillaries are moved to the assay plate in the sample tray and blocking reagent (Antibody Diluent) is aspirated. When incubation is complete, Wash Buffer is aspirated.</td>
</tr>
<tr>
<td><strong>Primary Antibody or Total Protein Labeling Reagent (1°) Step</strong></td>
<td>Capillaries are moved to the assay plate in the sample tray and primary antibody or labeling reagent is aspirated. When incubation is complete, Wash Buffer is aspirated.</td>
</tr>
<tr>
<td><strong>Secondary Antibody or Total Protein Streptavidin-HRP (2°) Step</strong></td>
<td>Capillaries are moved to the assay plate in the sample tray and secondary HRP/NIR/IR antibody conjugate and Streptavidin-HRP/NIR (Immunoassays), or Total Protein Streptavidin-HRP (Total Protein Assays) is aspirated. When incubation is complete, Wash Buffer is aspirated.</td>
</tr>
<tr>
<td><strong>Detect Step</strong></td>
<td>Capillaries are moved to the assay plate in the sample tray and Luminol-Peroxide solution is aspirated. Emitted chemiluminescent light is detected with the CCD camera. For fluorescence detection on Jess, emitted fluorescent signal is detected.</td>
</tr>
<tr>
<td><strong>Results Step</strong></td>
<td>Results are available in the Analysis screen.</td>
</tr>
</tbody>
</table>
When a run is in progress, icons for steps that have not executed will be grey (inactive). In the following example, the Secondary Antibody (2°) step is executing and the Detect and Results steps have not started:

<table>
<thead>
<tr>
<th>Step</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample</td>
<td>12:54 PM</td>
</tr>
<tr>
<td>Sep</td>
<td>12:56 PM</td>
</tr>
<tr>
<td>Block</td>
<td>1:00 PM</td>
</tr>
<tr>
<td>1°</td>
<td>1:16 PM</td>
</tr>
<tr>
<td>2°</td>
<td>4:22 PM</td>
</tr>
<tr>
<td>Detect</td>
<td>5:20 PM</td>
</tr>
<tr>
<td>Results</td>
<td>8:00 PM</td>
</tr>
</tbody>
</table>

Watching Standards Separation Movies

You can view a movie of the fluorescent standards separation in the capillaries. To do this:

1. Click the Separation tab.

2. The player control panel has play/pause, rewind and fast forward buttons, and a slider bar that allows you to scroll through the movie manually:
Click **Play** (button on far left) to view the movie. In the example below, standards for a Jess RePlex size assay is shown:

NOTE: Complete separation movies of the fluorescent standards are not available until the separation step has finished executing. If the movie is played while the separation step is executing, the movie will only show separation progress up to the current point in time.
Viewing Current and Voltage Plots

You can view plots of the total current and voltage measured during separation. To do this, click the IV Plot tab.

The blue Y-axis and plot shows the run voltage in volts (V), and the red Y-axis and plot shows the run current in micro amps (μA). The X-axis displays time in seconds.

- **To zoom in on an area of the plot** - Hold the mouse button down and draw a box around the area with the mouse.
- **To zoom out** - Click Zoom Out in the upper right corner of the pane.

---

*NOTE: The IV plot for a run in progress will not be available until the separation step starts executing. The plot is then displayed in real-time.*
Switching Between Open Run Files

If more than one run file is open, you can switch between viewing the run information in each. To do this:

1. Click the down arrow in the run box.

2. Select the run you want to view from the drop down list.

Closing Run Files

If more than one run file is open, you can close just one file or all the open files at the same time.

- **To close the run file being viewed** - Select **File** from the main menu and click **Close**.
- **To close all open run files** - Select **File** from the main menu and click **Close All**.
Chapter 6:
Controlling Jess, Wes, and Abby

Chapter Overview
• Instrument Control
• Self Test
• Viewing and Changing System Properties
• Viewing Log Files
• Status Modes
Instrument Control

The Instrument menu allows you to control Jess, Wes, and Abby.

NOTE: Instrument menu options are active only when a computer with Compass for Simple Western is connected directly to Jess, Wes, or Abby. Available functions will vary depending on the instrument.

Self Test

Jess, Wes, and Abby can perform a series of self tests to check for proper instrument performance. To start the test, select Instrument and click Self Test. The test takes approximately 15 to 30 minutes depending on the instrument.

NOTE: We recommend performing the self test prior to starting a run.
To view the test log at completion of the test, select Instrument, click Properties and click View Logs. See “Self Test Logs” on page 142 for more information.

Viewing and Changing System Properties
Select Instrument and click Properties to display system properties which include:

- Name
- Location
- Type
- Serial number
- Instrument software version (firmware)
- Network name and address
- Date and time of the instrument clock

- **To change system name or location** - click in the name or location boxes and enter the new information.
- **To sync the instrument clock with the computer** - click Set to PC time.

Viewing Log Files

Error Logs
1. Select Instrument in the main menu and click Properties to display system properties.
2. Click View Error Log. A list of system logs will display:
3. Select a log file and click **View**. The log details will display:
4. Click **Save File As** to save a copy of the log file.
Self Test Logs

1. Select **Instrument** in the main menu and click **Properties** to display system properties.
2. Click **Logs**. A list of self test logs will display:
3. Select a log file and click View. The individual test details will display:

![Log File View](image)

4. Click Save File As to save a copy of the log file.

**Software Updates**

To check for software updates, go to Compass for Simple Western, select Help in the main menu and click Check for Updates.

**Instrument Software (Embedded) Updates**

To view the version installed, open Compass for Simple Western, select Instrument in the main menu, then click Properties. The current version of system software will be displayed.

To check for embedded updates, go to Compass for Simple Western, select Instrument in the main menu, then Update and select Network. If you are not on the network, contact ProteinSimple Technical Support for assistance on how to obtain the latest update.
Status Modes

The instrument status bar displays status, buttons and progress bars depending on what Jess, Wes, or Abby is doing.

- **Ready/Start button** - The instrument is ready and an assay is loaded. The indicator light will be solid blue. Click Start to begin a run.

- **Not Ready/Reset button** - The instrument is not ready and must reinitialize. The indicator light will be red or magenta. Click Reset to start the initialization protocol.

- **Running/Stop button** - The instrument is running an assay. The indicator light will be blinking blue. The run name, time the run started and when it will complete display in the run progress bar. Click Stop to stop the run.

- **Error/Reset button** - An error has occurred. Go to the Status window in the Run Summary screen to view details. The indicator light will be red. When the source of the error is corrected, click Reset.
Chapter 7:
Size Assay Data Analysis

Chapter Overview
• Analysis Screen Overview
• Opening Run Files
• How Run Data is Displayed in the Analysis Screen
• Viewing Run Data
• Run Data Notifications and Warnings
• Checking Your Results
• Group Statistics
• Copying Data Views and Results Tables
• Exporting Run Files
• Running Reports
• Changing Sample Protein Identification
• Changing the Virtual Blot View
• Creating Annotated Lane View Figures
• Closing Run Files
• Analysis Settings Overview
• Advanced Analysis Settings
• Images Analysis Settings
• Normalization (Jess/Abby only)
• Signal to Noise Settings
• Peak Names Settings
• Standard Curve Settings
• System or Loading Control Settings
• Standard Curve Settings
• Importing and Exporting Analysis Settings
Analysis Screen Overview

The Analysis screen is used to view run data including electropherograms, capillary images, lane view data and tabulated results. Any post-run analysis is also done in this screen. To access this screen, click Analysis in the screen tab:

Analysis Screen Panes

The Analysis screen has seven panes, each displays the following data for up to 25 capillaries per experimental run:

• **Experiment** - Lists the assay protocol steps and assay template information.
• **Graph** - Displays electropherogram data for sample proteins, fluorescent standards or capillary registrations.
• **Image** - Displays a 12-capillary image of the separated sample proteins, fluorescent standards or capillary registrations.
• **Lane** - Displays data for sample proteins, fluorescent standards or capillary registrations as bands in individual lanes. This virtual blot-like image is similar to traditional blot results.
• **Peaks** - Lists the tabulated results for sample proteins and information for identified fluorescent standards and capillary registrations.
• **Capillaries** - Displays a list of the sample proteins Compass for Simple Western named automatically using the user-defined peak name analysis parameters.
• **Analysis Options** - Displays options to change various exposure settings and edit/label peak attributes.

**NOTE:** If you don’t see data in the Analysis screen after a run, there may have been a disconnection between the instrument and computer during the run. If this happens, the instrument’s embedded computer will have a copy of the run file. Go to Instrument > Runs... to find and save a copy of the run file.
NOTE: The reported molecular weight for sample proteins in Compass for Simple Western may vary from apparent molecular weights using other techniques and based on sample and assay conditions.
Software Menus Active in the Analysis Screen

The following software menus are available:

- File
- Edit
- View
- Instrument (when Compass for Simple Western is connected to Jess, Wes, or Abby)
- Window
- Help

The File, Edit and View menu options specific to the Analysis screen are described next.

**File Menu**

The following File menu options are active:

- **Open Run** - Opens a run file.
- **Add Run** - Opens and views other run files in addition to those that are already open.
- **Close** - Closes the run file currently being viewed.
- **Close All** - Closes all open run files.
- **Save** - Saves changes to the open run file.
- **Save As** - Saves changes to the open run file under a different file name.
- **Export Tables** - Exports the results for all capillaries in the run in .txt format.
- **Export Spectra** - Exports the raw data traces for each capillary in the run in .txt or .cdf format.
- **Exit** - Closes Compass for Simple Western.
**Edit Menu**

The following Edit menu options are active:

- **Copy** - Lets you copy data shown in the graph, lane, peaks or capillaries panes. See “Copying Data Views and Results Tables” on page 206 for more information.
- **Analysis** - Displays the analysis settings used to analyze the run data and lets you change them as needed. See “Analysis Settings Overview” on page 287 for more information.
- **Preferences** - Lets you set and save custom preferences for data export, plot colors in the graph and Twitter settings. See Chapter 8, “Setting Your Preferences” for more information.

**View Menu**

The following View menu options are active:

- **Selected View** - Displays data in a per capillary (single) view format.
- **All View** - Displays data in a per 12- or 25-capillary (multiple) view format.
- **Standards** - Lets you change the data view to show only the fluorescent standards.
- **Samples** - Lets you change the data view to show sample proteins.
- **Filter** - Lets you display data only for specific capillaries or named proteins.
- **View Region** - Lets you change the molecular weight (x-axis) range of the data displayed.
- **Show Hidden** - Shows capillaries that are hidden from the data view.
Opening Run Files
You can open one or multiple run files at a time to compare data between runs.

Opening One Run File

NOTE: If you need to open a run file when another run is executing, launch another instance of Compass for Simple Western first, then open the file.

1. Select File in the main menu and click Open Run.

2. A list of the last 10 runs opened will display. Select one of these runs or click Browse to open the Runs folder and select a different file.

Opening Multiple Run Files

NOTE: If you need to open a run file when another run is executing, launch another instance of Compass for Simple Western first, then open the file.

1. To open the first run file, select File in the main menu and click Open Run.
2. A list of the last 10 runs opened will display. Select one of these runs or click **Browse** to open the Runs folder and select a different file. When connected to an instrument, you can also select **Instrument** in the main menu and click **Runs** to select a different run file.

3. To open another run file, select **File** in the main menu and click **Add Run**.

4. A list of the last 10 runs opened will display. Select one of these runs or click **Browse** to open the Runs folder and select a different file. When a run is added, its data will append to the open run file, and will display as a second set of up to 25 capillaries (Jess/Wes/Abby) in all screen panes. The second run file name will also appear in the Compass title bar:
5. Repeat the last two steps to add additional runs.

**NOTES:**

When adding multiple data files for analysis, they must contain matching detection channels (for example chemi, IR/NIR fluorescence, or IR/NIR fluorescence with Protein Normalization).

When adding multiple RePlex data files (Jess/Abby only), the channels for both probes must contain matching detection files. For example, a chemiluminescence with Total Protein data file can’t be added to a chemiluminescence/chemiluminescence data file.
How Run Data is Displayed in the Analysis Screen

Data in the run file is compartmentalized for easy review in one of six panes in the Analysis screen.

Experiment Pane: Assay and Capillary Information

The experiment pane displays assay and capillary information for each of the 25 capillaries in the run. A view of the experiment panes for a standard Immunoassay on Abby and a RePlex Assay with two fluorescent NIR Immunoassays on Jess are shown below.

- **To view all columns** - Click the Experiment tab, then use the scroll bar or click Maximize in the upper right corner.
- **To resize columns** - Click the Experiment tab. Roll the mouse over a column border until the sizing arrow appears, then click and drag to resize.

Experiment pane column descriptions for the default assay are as follows:

- **Sample** - Sample name. If sample names were entered in the assay template (Assay screen), those names will display here. Otherwise, Sample (default name) will display.
- **Primary** - Primary antibody name. If primary antibody names were entered in the assay template (Assay screen), those names will display here. Otherwise, Primary (default name) will display.
- **Primary 1 (Jess/Abby RePlex Assays only)** - Primary antibody name for Probe 1. If primary antibody names were entered in the assay template (Assay screen), those names will display here. Otherwise, Primary (default name) will display.

---

**NOTE:** Data notification icons will display in the sample column if Compass for Simple Western detected a potential analysis issue or data was manually modified by the user. For more information see “Run Data Notifications and Warnings” on page 191.
• **Primary 2 (Jess/Abby RePlex Assays only)** - Primary antibody name for Probe 2. If primary antibody names were entered in the assay template (Assay screen), those names will display here. Otherwise, Primary (default name) will display.

• **Secondary** - Secondary antibody name. If secondary antibody names were entered in the assay template (Assay screen), those names will display here. Otherwise, Secondary (default name) will display.

**NOTE:** The Secondary column will not display for RePlex Assays with two immunoassays.

• **Cap** - Capillary number.

**Graph Pane: Electropherogram Data**

Click the **Graph** tab to view data for sample proteins, fluorescent standards or capillary registrations. Data for samples is shown in the following example, and proteins are displayed as peaks:

![Graph view of electropherogram data](image)

More Graph view options will be described in more detail in "Creating Annotated Lane View Figures" on page 233.
Image Pane: Capillary Separation Image Data

Click the Image tab to view final images of sample proteins or fluorescent standards. Image data for samples is shown in the following example:
Select the blue **All Images** icon at the top right of the Image view pane to display sample, raw, and background images. Image data for multiple detection channels (NIR and IR) is shown in the following example:
Lane Pane: Virtual Blot-Like Image Data

Click the Lane tab to view data for sample proteins, fluorescent standards or capillary registrations as bands in individual lanes. This virtual blot-like image is similar to traditional blot results. Data for samples in the lane view for an Immunoassay (immunodetected proteins), Protein Normalization (for Jess only), and from a Total Protein Assay are displayed as bands in the examples below.
To view information for a band, roll the mouse over a band until the info box appears.

**NOTES:** The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay in Compass for Simple Western may vary from apparent molecular weights using other techniques and based on sample and assay conditions.

Lane data displayed in the virtual blot is automatically aligned by Compass for Simple Western. To view raw, unaligned lane data and learn more about virtual blot viewing options, see “Changing the Virtual Blot View” on page 224.

**NOTE:** Lane view is a digitally created image to aid with data visualization and is not quantitative.
**Std Curve Pane: Standard Curve Fit Data**

Click the **Std Curve** tab to view a linear or 4-parameter curve fit of your standard curve proteins. Data for the samples in the std curve view is shown in the following example where proteins are displayed as dots.

Concentration of the sample proteins is automatically determined by Compass based on defined values of the standard curve.

**Peaks Pane: Calculated Results**

Click the **Peaks** tab to view tabulated results for sample proteins, normalized sample proteins shown as Corr. Area (when Normalization is enabled), fluorescent standards or capillary registrations. Each row in the table shows the individual results for each peak detected in each capillary. Data for samples in the peaks table for an Immunoassay, a Total Protein Assay, Protein Normalization (Jess only) and a RePlex Assay (Jess/Abby only) are shown in the following examples:
NOTES:
Peaks that Compass for Simple Western names automatically using the user-defined peak name analysis parameters are color-coded.
The reported molecular weight for sample proteins detected using an Immunoassay or a Total Protein Assay in Compass for Simple Western may vary from apparent molecular weights using other techniques and based on sample and assay conditions.

- **To view all rows** - Click the **Peaks** tab, then use the scroll bar or click **Maximize** in the upper right corner.
- **To resize columns** - Click the **Peaks** tab. Roll the mouse over a column border until the sizing arrow appears, then click and drag to resize.

Peak table column descriptions are as follows:

- **Sample** - Sample name. If sample names were entered in the assay template (Assay screen) or Analysis Options pane, those names will display here. Otherwise, Sample (default name) will display.
- **Primary** - Primary antibody name. For Immunoassays, if primary antibody names were entered in the assay template (Assay screen) or Analysis Options pane, those names will display here. Otherwise, Primary (default name) will display. For Total Protein Assays, Antibody Diluent will display as the default name.
- **Secondary** - Secondary antibody name. If secondary antibody names were entered in the assay template (Assay screen) or Analysis Options pane, those names will display here. Otherwise, Secondary (default name) will display.
- **Cap**
  - Immunoassays (non-RePlex): Capillary number.
  - Jess/Abby RePlex Assays: Probe and capillary number. For example, P1:4 indicates Probe 1, capillary 4.
- **Peak** - Peak number. Peaks are numbered in order of detection.
- **Name** - Peak name. Displays peaks that Compass for Simple Western named automatically using the user-defined peak name analysis parameters. Cells will be blank if Compass was not able to name the peak or if naming parameters were not entered.
- **Position** - Displays the pixel position of a peak in the image.
- **MW (kDa)** - Displays the calculated molecular weight in kDa for the peak (shown for sample data only).
- **Height** - Displays the calculated peak height.
- **Area** - Displays the calculated peak area (shown for sample data only).
- **% Area** - Reported when area is calculated using the Gaussian method (default for Immunoassays, see “Peak Find Settings” on page 310 for more information). Displays the calculated percent area for the named peak compared to all named peaks. This value results from dividing the individual peak area by the sum of all named peak areas for the capillary and multiplying by 100 (shown for named peak sample data only).
• **% Total** - Reported when area is calculated using the Dropped Line method (default for Total Protein Assays, see “Peak Find Settings” on page 310 for more information). Displays the calculated percent area for the peak compared to the total area measured in the capillary. This value results from dividing the individual peak area by the entire area under the curve for the capillary and multiplying by 100.

• **Conc (Concentration)** - Displays the calculated concentration of protein for the named peak. This column will not appear unless a standard curve is defined.

• **Corr. Area** - Displays the corrected area for the peak. This column will not appear unless a Loading Control is defined or Normalization is enabled in Analysis Preferences.
  - **For PN channel** - A linear correction calculation is applied to peak area to represent amount of protein. The linear calculation correction factor is $Corr.\ Area = Area + (1e-5 \times Area^2)$. The normalization factor is not used for this calculation.
  - **For Chemi, NIR, and IR channel peaks** - Corrected area is determined by first calculating the Capillary Normalization factor for each capillary and then correcting the peak area as follows:
    
    \[
    \text{Capillary Normalization Factor} = \frac{\text{Normalization area for chosen capillary}}{\text{Normalization area for reference capillary in Analysis settings}}.
    \]

    Then,

    \[
    Corr.\ Area = \frac{\text{Peak area}}{\text{Capillary Normalization factor}}.
    \]

• **Width** - Displays the calculated peak width (shown for sample data only).

• **S/N** - Displays the calculated signal to noise ratio for the peak (shown for sample data only). Please note this calculation is either based on a peak finding algorithm to provide a relative ratio comparing all peaks within the electropherogram or a signal to noise ratio that follows USP/NF regulations. These settings are selected in Advanced Analysis settings. For more information see “Signal to Noise Settings” on page 303.

• **Baseline** - Displays the raw baseline signal of each peak

• **Channel** - Detection channel (Chemi, NIR, IR, PN)

**Capillaries Pane: User-Specified Peak Names**

Click the **Capillaries** tab to view tabulated results for sample proteins associated with specific primary antibodies, Protein Normalization area, or Total Protein area in the run data. Compass for Simple Western labels these sample peaks automatically using user-defined peak name settings. Each row in the table shows the individual results for the named peaks detected in each capillary. Data for samples in the capillaries table is shown in the following example for an Immunoassay and a RePlex Assay with two immunoassays.
Compass for Simple Western User Guide

For standard Total Protein Assays where area calculation is handled via Dropped Lines by default, the Capillaries tab is shown below. Compass for Simple Western labels the sample peaks automatically using user-defined peak name settings. Each row in the table shows the individual results for the total area and named peaks detected in each capillary.

- **Total Area** - Total area measured in the capillary when using a standard Total Protein Assay.
For RePlex Assays with Total Protein enabled where the TP Area column accounts for this measurement automatically, the capillaries tab is shown below.

• TP Area - Total area measured in the capillary for the Total Protein signal.
• TPN (%) - Total Protein signal for chosen capillary/Total Protein signal for reference capillary in the Analysis settings.

When using the Protein Normalization Module on Jess, where the PN Corr.Area column accounts for this measurement automatically, the capillaries tab is shown below.

PN Corr.Area is determined by first calculating the normalization factor for each capillary and then correcting the peak area for each signal as follows:

**Capillary Normalization Factor** = Protein Normalization signal for chosen capillary/Protein Normalization signal for reference capillary in Analysis settings.

Then,

PN Corr.Area = PN Area + (1e-5 * Area²)
PN (%) = Capillary Normalization Factor x 100, as percentage
NOTES:
Peaks that Compass for Simple Western names automatically with user-defined peak name settings are color-coded.

Information displayed for fluorescent standards data will be for identified standards.

• **To view all rows** - Click the Capillaries tab, then use the scroll bar or click **Maximize** in the upper right corner.

• **To resize columns** - Click the Capillaries tab. Roll the mouse over a column border until the sizing arrow appears, then click and drag to resize.

Capillaries table column descriptions are as follows:

• **Sample** - Sample name. If sample names were entered in the assay template (Assay screen), those names will display here. Otherwise, Sample (default name) will display.

• **Primary** - Primary antibody name. If primary antibody names were entered in the assay template (Assay screen) or Analysis Options pane, those names will display here. Otherwise, Primary (default name) will display.

• **Secondary** - Secondary antibody name. If secondary antibody names were entered in the assay template (Assay screen) or Assay Options pane, those names will display here. Otherwise, Secondary (default name) will display.

• **Capillary**
  - Immunoassays (non- RePlex): Capillary number.
  - Jess/Abby RePlex Assays: Probe and capillary number. For example, P1:4 indicates Probe 1, capillary 4.

• **Peak Name Columns** - An individual column per peak name will display for every peak identified by name in the run data. Cells for capillaries in these columns will be blank if Compass for Simple Western did not find peaks automatically using the user-defined peak name analysis parameters (or none were entered).

• **To view % area in the peak name columns** - the Gaussian Fit area calculation setting must first be selected. To do this, select **Analysis** from the Edit menu, then select **Peak Fit** page. In the Peak Find box, select **Gaussian Fit** for the Area Calculation setting (default for Immunoassays). Next, select **Area %** in the upper right corner of the Capillaries pane. This displays the calculated percent area for the named peak compared to all named peaks. This value results from dividing the individual peak area by the sum of all named peak areas for the capillary and multiplying by 100.
• **To view peak area in the peak name columns (default)** - Select Area in the upper right corner of the pane. This displays calculated peak area for the individual peak only.

• **To view corrected peak area in the peak name columns** - Select Corr. Area in the upper right corner of the pane. This displays the corrected peak area for the named peak compared with the loading control peak or reference capillary when Protein Normalization is enabled in the Analysis settings.

• **To view concentration in the peak name columns** - Select Conc. in the upper right corner of the pane. This displays the calculated concentration for the named peak compared with the standard curve.

• **To view % total in the peak name columns** - The Dropped Lines area calculation setting must first be selected. To do this, select Analysis from the Edit menu, then select Peak Fit page. In the Peak Find box, select Dropped Lines for the Area Calculation setting (default for Total Protein Assays). Next, select % Total in the upper right corner of the Capillaries pane. This displays the calculated percent total for the named peak compared to the total area measured in the capillary. This value results from dividing the individual peak area by the entire area under the curve for the capillary and multiplying by 100.
Viewing Run Data
Each run file contains the following data for up to 25 capillaries:

- **Sample data** - For the proteins in the sample.
- **Standards data** - For the fluorescent standards run with each sample.

Data can be viewed for one, all, or individually selected capillaries.

Switching Between Sample and Standards Data Views
You can switch between viewing sample and standards data in a run file using the View bar or View menu:

Data buttons in the View bar:

- Show Standards
- Show Samples
- **To view sample data** - Click **Show Samples** in the View bar or select **View** in the main menu and click **Samples**.

- Data in this view is for sample proteins only.
- Graph view data displays electropherograms in chemiluminescence, NIR or IR units (y-axis) and molecular weight in kDa (x-axis). If protein normalization was performed in the same immunoassay run, the overlay is also displayed in the Graph view.
- Lane view data displays sample proteins only.
- Image view data displays sample proteins only.
- Results for each protein are shown in the peaks and capillaries tables.

**NOTE:** The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay in Compass for Simple Western may vary from apparent molecular weights using other techniques and based on sample and assay conditions.

For information on checking and identifying sample peaks, see “Step 3 – Checking the Ladder” on page 197 or “Step 4 – Checking Samples” on page 199.

- **To view standards data** - Click **Show Standards** in the View bar or select **View** in the main menu and click **Standards**.
NOTE: For RePlex Assays (Jess/Abby only), standards data will be displayed regardless of what channel (Probe 1 or Probe 2) is selected.

Data in this view is for the fluorescent standards only. These standards are premixed with each sample prior to analysis.

Graph view data displays electropherograms in fluorescence (y-axis) and position (x-axis).

Lane view data displays fluorescent standards only.

Image view data displays fluorescent standards only.

Standards are highlighted in both the peaks and capillaries tables and marked with an S.

For information on checking and identifying standards peaks, see “Step 2 – Checking Fluorescent Sizing Standards” on page 195.
Selecting and Displaying Capillary Data

You can choose to view data from one, multiple, or all capillaries at once.

- **To look at data for one capillary** - Click a row in the experiment pane. Data for just the row selected will display in all data views and tables. The following example shows sample data displayed in the lane and peaks panes when one sample is selected:
To look at data for multiple non-sequential capillaries - Hold the Ctrl key and select the rows you want to view in the experiment pane. Data for only the rows selected will display in all data views and results tables. The following example shows sample data displayed in the graph (in multiple view) and capillaries panes when multiple rows are selected:
• **To look at data for multiple sequential capillaries** - Hold the *Shift* key and select the first and last rows you want to view in the experiment pane. Data for only the selected rows will display in all data views and results tables. The following example shows standards data displayed in the image and peaks panes when multiple sequential rows are selected:
• **To look at data for all capillaries** - Hold the Shift key and select the first and last rows in the experiment pane. Data for all rows will display in all data views and results tables. The following example shows standards data displayed in the lane and peaks panes when all rows are selected.
Switching Between Fluorescence Channel Views (Jess Only)

You can switch between displaying run data in the graph, image and lane panes for samples run using HRP-tagged or fluorophore dye-containing secondaries in the View bar. Protein normalization overlay data can also be selected here. This view is selected in the View bar:

Detection channels in the View bar:

- Overlay chemiluminescent channel
- Overlay near infrared channel
- Overlay infrared channel
- Overlay protein normalization channel

Switching Between Single and Multiple Views of the Capillaries

You can switch between displaying run data in the graph, image and lane panes in a per capillary (single) format or a multiple capillary format. This view is selected in the View bar or the View menu.

Capillary view buttons in the View bar:

- View Selected
- View All
- **To view data in a per capillary format** - Click **View Selected** in the View bar or select **View** in the main menu and click **Selected**:

Data for the row(s) selected in the experiment pane will display as follows:

- Electropherograms in the graph pane display overlaid or stacked (depending on the graph option chosen).
- Results for only the selected row(s) will display in the peaks and capillaries tables.
- The selected row(s) are highlighted in the image pane:
• Lanes for only the selected row(s) are displayed in the lane pane:
To view data in a multiple capillary format - Click View All in the View bar or select View in the main menu and click All:

Data for the row(s) selected in the experiment pane will display as follows:

- Electropherograms corresponding to the selected row(s) are highlighted and displayed in the graph pane.
- Results for selected capillaries display in the peaks and capillaries tables and are highlighted.
- The selected row(s) are highlighted in the image pane:
• All selected lanes display in the lane pane, and lanes corresponding to the selected row(s) are highlighted.
Viewing RePlex Channel Views (Jess/Abby Only)

Probe 1 data displays by default when you open a RePlex run file. To display a second Probe 1 or Probe 2 channel data, click the channel icon in the View bar.

**Channel designations for Jess**

Detection channels in the View bar:

- 💥 Chemiluminescent channel (grey)
- 🍃 Near infrared channel (red)
- 🌿 Infrared channel (green)
- 💧 Protein normalization channel (blue)
- 🚫 Unused channel (no color)
- ⚡ Channel data is displayed
- 🌟 Channel data is available but not displayed

**Channel designations for Abby:**
Detection channels in the View bar:

- Chemiluminescent channel (grey)
- Channel data is displayed
- Channel data is available but not displayed

The initial view displays Probe 1 data only. In this example showing Jess RePlex Assay data, the Probe1 channel is chemiluminescence.
Probe 1 data is labeled in all data views as P1 or Probe 1:

- **Graph view:**

- **Image view:**
• Lane view - sample lanes are labeled probe number: capillary number

![Graph showing lane view and peaks](image)

• Peaks and Capillaries table: rows are labeled probe number: capillary number

<table>
<thead>
<tr>
<th>Sample</th>
<th>Primary</th>
<th>Secondary</th>
<th>Cap</th>
<th>Peak</th>
<th>Name</th>
<th>Position</th>
<th>MW (kDa)</th>
<th>Height</th>
<th>Area</th>
<th>% Area</th>
<th>Width</th>
<th>S/N</th>
<th>Baseline</th>
<th>Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jurkat pos 1:0</td>
<td>phospho</td>
<td>Secondary</td>
<td>P1:4</td>
<td>1</td>
<td>phosp...</td>
<td>417</td>
<td>63</td>
<td>14026.4</td>
<td>212153.0</td>
<td>100.0</td>
<td>14.2</td>
<td>551.7</td>
<td>185.6</td>
<td>CHEMI</td>
</tr>
<tr>
<td>Jurkat reg 1:0</td>
<td>phospho</td>
<td>Secondary</td>
<td>P1:5</td>
<td>1</td>
<td>phospho...</td>
<td>422</td>
<td>64</td>
<td>1364.4</td>
<td>27672.2</td>
<td>100.0</td>
<td>19.9</td>
<td>4.2</td>
<td>244.3</td>
<td>CHEMI</td>
</tr>
<tr>
<td>Jurkat pos 1:0</td>
<td>phospho</td>
<td>Secondary</td>
<td>P1:6</td>
<td>1</td>
<td>phospho...</td>
<td>417</td>
<td>63</td>
<td>13786.5</td>
<td>185654.1</td>
<td>100.0</td>
<td>13.7</td>
<td>502.4</td>
<td>327.4</td>
<td>CHEMI</td>
</tr>
<tr>
<td>Jurkat reg 1:0</td>
<td>phospho</td>
<td>Secondary</td>
<td>P1:7</td>
<td>1</td>
<td>phospho...</td>
<td>413</td>
<td>62</td>
<td>106.8</td>
<td>2060.6</td>
<td>100.0</td>
<td>19.2</td>
<td>0.4</td>
<td>258.5</td>
<td>CHEMI</td>
</tr>
<tr>
<td>Jurkat pos 1:0</td>
<td>phospho</td>
<td>Secondary</td>
<td>P1:8</td>
<td>1</td>
<td>phospho...</td>
<td>419</td>
<td>63</td>
<td>14133.1</td>
<td>280185.9</td>
<td>100.0</td>
<td>13.3</td>
<td>481.9</td>
<td>2912</td>
<td>CHEMI</td>
</tr>
<tr>
<td>Jurkat reg 1:0</td>
<td>phospho</td>
<td>Secondary</td>
<td>P1:9</td>
<td>1</td>
<td>phospho...</td>
<td>416</td>
<td>62</td>
<td>288.2</td>
<td>9157.2</td>
<td>100.0</td>
<td>28.7</td>
<td>11.8</td>
<td>252.6</td>
<td>CHEMI</td>
</tr>
<tr>
<td>Jurkat pos 1:0</td>
<td>phospho</td>
<td>Secondary</td>
<td>P1:10</td>
<td>1</td>
<td>phospho...</td>
<td>419</td>
<td>63</td>
<td>15952.0</td>
<td>212526.5</td>
<td>100.0</td>
<td>13.0</td>
<td>594.2</td>
<td>307.3</td>
<td>CHEMI</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sample</th>
<th>Primary</th>
<th>Secondary</th>
<th>Cap</th>
<th>Peak</th>
<th>Name</th>
<th>Position</th>
<th>MW (kDa)</th>
<th>Height</th>
<th>Area</th>
<th>% Area</th>
<th>Width</th>
<th>S/N</th>
<th>Baseline</th>
<th>Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jurkat pos 1:0</td>
<td>phospho</td>
<td>Secondary</td>
<td>P1:4</td>
<td>1</td>
<td>phospho...</td>
<td>212313.0</td>
<td>212313.0</td>
<td>CHEMI</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jurkat reg 1:0</td>
<td>phospho</td>
<td>Secondary</td>
<td>P1:5</td>
<td>1</td>
<td>phospho...</td>
<td>2767.2</td>
<td>2767.2</td>
<td>CHEMI</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jurkat pos 1:0</td>
<td>phospho</td>
<td>Secondary</td>
<td>P1:6</td>
<td>1</td>
<td>phospho...</td>
<td>18546.1</td>
<td>18546.1</td>
<td>CHEMI</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jurkat reg 1:0</td>
<td>phospho</td>
<td>Secondary</td>
<td>P1:7</td>
<td>1</td>
<td>phospho...</td>
<td>2060.6</td>
<td>2060.6</td>
<td>CHEMI</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jurkat pos 1:0</td>
<td>phospho</td>
<td>Secondary</td>
<td>P1:10</td>
<td>1</td>
<td>phospho...</td>
<td>208185.9</td>
<td>208185.9</td>
<td>CHEMI</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jurkat reg 1:0</td>
<td>phospho</td>
<td>Secondary</td>
<td>P1:11</td>
<td>1</td>
<td>phospho...</td>
<td>9157.2</td>
<td>9157.2</td>
<td>CHEMI</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jurkat pos 1:0</td>
<td>phospho</td>
<td>Secondary</td>
<td>P1:12</td>
<td>1</td>
<td>phospho...</td>
<td>212313.0</td>
<td>212313.0</td>
<td>CHEMI</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Viewing Data for Probe 2**

To view chemiluminescent or NIR data (Jess only) for Probe 2, select its channel in the view bar. Jess’s view bar is on the left, Abby’s is on the right:

In this example showing Jess RePlex Assay data, Probe 2 data is labeled P2 or Probe 2:
• Graph view will display data stacked or overlaid depending on the option chosen:

• Image view will display separate images for each probe:
- Lane view will display P1 and P2 lanes side by side:

- Peaks and Capillaries tables will display all row data for P1 first, then P2:
**Viewing Data for a Second Channel in Probe 1 (Jess only)**

To view the second channel data for Probe 1, for example in a RePlex Chemiluminescence/NIR fluorescence + Total Protein assay, select it’s channel in the view bar:

- Graph view will display data stacked or overlaid channel data depending on the option chosen:
• Image view will display individual images for each channel:
• **Lane view will display lanes for each channel overlaid:**

![Graph Image]

- Peaks and Capillaries tables will list data for both channels:

<table>
<thead>
<tr>
<th>Sample</th>
<th>Primary</th>
<th>Secondary</th>
<th>Cap</th>
<th>Peak</th>
<th>Name</th>
<th>Position</th>
<th>MW (kDa)</th>
<th>Height</th>
<th>Area</th>
<th>% Area</th>
<th>Corr. Area</th>
<th>Width</th>
<th>S/N</th>
<th>Baseline</th>
<th>Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>MCF7 pos T</td>
<td>F AKT2</td>
<td></td>
<td>P11</td>
<td>1</td>
<td>AKT2</td>
<td>397</td>
<td>90</td>
<td>9899.4</td>
<td>95227.0</td>
<td>100</td>
<td>95299.1</td>
<td>8.9</td>
<td>1122.2</td>
<td>2251.8</td>
<td>AKT</td>
</tr>
<tr>
<td>MCF7 pos S</td>
<td>p AKT2</td>
<td></td>
<td>P11</td>
<td>1</td>
<td>pan AKT</td>
<td>464</td>
<td>63</td>
<td>4165.9</td>
<td>32664.4</td>
<td>100</td>
<td>32701.9</td>
<td>8.1</td>
<td>106.9</td>
<td>92.9</td>
<td>AKT</td>
</tr>
</tbody>
</table>

![Peaks Table Image]

<table>
<thead>
<tr>
<th>Sample</th>
<th>Primary</th>
<th>Secondary</th>
<th>Cap</th>
<th>Primary</th>
<th>Secondary</th>
<th>Position</th>
<th>p-Ser AKT1</th>
<th>p-Thr AKT1</th>
<th>p-Ser AKT2</th>
<th>AKT1</th>
<th>AKT2</th>
</tr>
</thead>
<tbody>
<tr>
<td>MCF7 pos T</td>
<td>F AKT2</td>
<td></td>
<td>p Ser AKT1</td>
<td>p Ser AKT2</td>
<td>p Ser AKT2</td>
<td>7099.4</td>
<td>95227.0</td>
<td>95227.0</td>
<td>95227.0</td>
<td>95227.0</td>
<td>95227.0</td>
</tr>
</tbody>
</table>

Compass for Simple Western User Guide
Hiding Capillary Data

Capillary data can be hidden from view if needed. To do this:

1. Click the **Experiment** tab.
2. Select the rows you want to hide, then right click on one of the selected rows and click **Hide**:

Data for selected rows will be hidden in all data views and results tables (except for the image pane).

- **To view hidden rows** - Select **View** in the main menu and click **Show Hidden**. Hidden rows will become visible again in all panes, and hidden rows will be marked with an X in the experiment pane:

- **To unhide rows** - Select the hidden row(s). Right click on one of the selected rows and click **Unhide**.

Setting Run Data Display Filters

The filter lets you auto-hide specific capillaries in the run file data, or only show data for peaks that Compass for Simple Western identified automatically using the user-defined peak name analysis parameters.

---

**NOTE:** When more than one run file is open, filter settings will be applied to all files.

- **To filter data to show specific capillaries only** - Select **View** in the main menu and click **Filter**. Uncheck the boxes for the capillaries you do not want shown, then click **OK**.

Compass for Simple Western User Guide
Only data for the checked capillaries will display in data views and results tables, unchecked capillaries will be hidden.

- **To filter data to show named peaks only** - Select View in the main menu and click Filter. Select Show named peaks only then click OK. Only data for peaks that Compass for Simple Western identified automatically using the user-defined peak name analysis parameters will display in data views and results tables, all other peak data will be hidden.

### Run Data Notifications and Warnings

If Compass for Simple Western detects a potential data issue, a notification or warning will display next to the row in the experiment pane. A list of warnings, notifications and corrective actions are as follows:

- **Manual correction of sample data notification** - Indicates the user modified sample data manually, such as adding or removing a sample peak. Rolling the mouse over the icon displays the type of data modification made.
Standards warning - Indicates that one of the standards may not be identified properly. This can be resolved by manually identifying the standards. Please refer to “Step 2 – Checking Fluorescent Sizing Standards” on page 195 for details. Rolling the mouse over the icon displays warning details.

Manual correction of standards data notification - Indicates the user modified the standards data manually. Rolling the mouse over the icon displays the type of data modification made.

Peak fit warning - Indicates that a peak cannot be fit properly. This is typically caused either by a very small peak in the electropherogram or a peak that is very close to the end of the molecular weight range. This can be resolved by removing the peak. Please refer to “Step 3 – Checking the Ladder” on page 197 or “Step 4 – Checking Samples” on page 199 for details. Rolling the mouse over the icon displays warning details.

Peak warning: saturated signals - Saturation warnings in the experiment table indicate there are one or more saturated peaks in the current capillary at the selected exposure setting. If there is a saturation warning when HDR is the selected exposure, it means that the signal was saturated at the shortest exposure time in the image series. Pixels in a peak are considered saturated when they can no longer quantify the data reliably for analysis (i.e., the pixels have hit the threshold value of the amount of light they can absorb). These warnings are displayed for Chemi, NIR, IR, and PN channels and take precedence over all other warnings that are shown for capillaries in the Experiment pane.

When accurate quantitation is needed for samples displaying this warning, we recommend re-running the samples at a higher dilution factor. Rolling the mouse over the icon displays warning details.
When a saturated signal is detected, the warning icon displays next to the capillary in the Experiment pane. Saturated pixels in capillaries are also colored red in the Images pane when **Show All Images** is selected.
Checking Your Results

Compass for Simple Western detects proteins, fluorescent standards and capillary registrations and reports results automatically with no user-interaction. However, we recommend you review the data as outlined in this section as good general practice to ensure accurate results. If a data warning is presented in the experiment pane, the following steps will also help you identify and correct any issues.

Step 1 – Review the Fluorescent Sizing Standards Movie

All capillaries should have three fluorescent sizing standards. To verify the standards separated in the capillary correctly:
1. When the run has completed, click the Run Summary screen tab.
2. Click the Separation tab and play the movie (this will be the fluorescent standards separation).
3. For each capillary, verify that the standards visibly separated. Each fluorescent point in the capillary represents one of the three sizing standards.
Step 2 – Checking Fluorescent Sizing Standards

To verify the standards are identified correctly:

1. Click the Analysis screen tab.
2. Click Show Standards in the View bar. Verification that the standards have been correctly identified can be done in either the graph or lane panes.

Graph Pane:
   a. Click View Selected in the View bar.
   b. Click on the first row in the experiment pane, then click the Graph tab. Check that the electropherogram has standard peaks labeled Std 1, Std 29 and Std 230 (for 12-230 kDa size assays), Std 57 and Std 280 (for 66-440 kDa size assays) or Std 1 and Std 26 (for 2-40 kDa size assay). They will also be identified with a green S in the peaks table.

If standards are not identified correctly, they can be manually corrected as follows:

   - **If an incorrect peak is identified as a standard** - Right click the peak in the electropherogram or peaks table and select Not a Standard. Compass for Simple Western should correctly reassign the remaining peaks as standards, and update the peaks table.
• **To set an unidentified peak as a standard** - Right click the peak in the electropherogram or peaks table and select **Force Standard**. Compass for Simple Western will assign the peak as a standard, and correctly reassign the remaining standard peaks. A lock icon indicating the standard was set manually will display next to the peak in the peaks table.

**NOTE:** To remove standards peak assignments that were made manually, right click on the peak in the electropherogram or peaks table and click **Clear**.

c. Repeat the previous steps for the remaining rows in the experiment pane to make sure all standards are identified correctly.

**Lane Pane:**

a. Click **View All** in the View bar.

b. Click on the first row in the experiment pane, then click the **Lane** tab. Standards will be bands and identified with a green outline. Check that all standard bands are labeled: Std 1, Std 29 and Std 230 (for 12-230 kDa size assays) or Std 57 and Std 280 (for 66-440 kDa size assays) or Std 1 and Std 26 (for 2-40 kDa size assays). They will also be identified with a green **S** in the peaks table. To view band labels, roll the mouse over the individual bands.
If standards are not identified correctly, they can be manually corrected as follows:

- **If an incorrect band is identified as a standard** - Right click the band in the lane or peaks table and select **Not a Standard**. Compass for Simple Western should correctly reassign the remaining bands as standards.

- **To set an unidentified band as a standard** - Right click the band in the lane or peaks table and select **Force Standard**. Compass for Simple Western will assign the band as a standard, and correctly reassign the remaining standard bands.

c. Repeat the previous steps for the remaining rows in the experiment pane to make sure all standards are identified correctly.

**Step 3 – Checking the Ladder**

Depending on the size assay you are running, the biotinylated ladder should have the following sizing standards: 12, 40, 66, 116, 180 and 230 kDa (for 12-230 kDa size assays), 66, 116, 200, 280 and 440 kDa (for 66-440 kDa assays) or 2, 5, 12, 26, and 40 kDa (for 2-40 kDa assays). To verify the ladder standards are identified correctly:

1. Click the **Analysis** screen tab.

2. Click **Show Samples** in the View bar. Verification that the ladder standards have been correctly identified can be done in either the graph or lane panes, but manual corrections must be done in the graph pane.

**Graph Pane:**

a. Click **View Selected** in the View.

b. Click on the row in the experiment pane that contains the ladder (typically row 1), then click the **Graph** tab. Check that the electropherogram has either six ladder peaks (for 12-230 kDa size assays) or five ladder peaks (for 66-440 and 2-40 kDa size assays). In the example below, the electropherogram has six peaks labeled Ldr 12, Ldr 40, Ldr 66, Ldr 116, Ldr 180 and Ldr 230.
If ladder peaks are not identified correctly, they can be manually corrected as follows:

- **If an incorrect peak is identified as a ladder peak** - Right click the peak in the electropherogram or peaks table and select Remove peak. Compass for Simple Western should correctly reassign the remaining peaks as ladder standards.

- **To set an unidentified peak as a ladder peak** - Right click the peak in the electropherogram or peaks table and select Add Peak. Compass for Simple Western will assign the peak as a ladder standard, and correctly reassign the remaining ladder standards peaks.

**NOTE:** To remove ladder peak assignments that were made manually and go back to the original view of the data, right click in the electropherogram and click Clear All.

**Lane Pane:**

- Click either View Selected or View All in the View bar.

- Click on the row in the experiment pane that contains the ladder (typically row 1), then click the Lane tab. Check that the lane has either six ladder bands (for 12-230 kDa size assays) or five ladder bands (for 66-440 kDa and 2-40 kDa size assays). In the example below, the lane has six peaks labeled Ldr 12, Ldr 40, Ldr 66, Ldr 116, Ldr 180 and Ldr 230. To view band labels, roll the cursor over the individual bands. If ladder bands are not identified correctly, they must be corrected in the graph pane as described in the previous section.
Step 4 – Checking Samples

All sample proteins in the graph and lane panes will be labeled automatically with the calculated protein size.

NOTE: The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay in Compass for Simple Western may vary from apparent molecular weights using other techniques and based on sample and assay conditions.

To verify that sample proteins are identified correctly:

1. Click the Analysis screen tab.
2. Click Show Samples in the View bar. Verification that sample proteins have been correctly identified can be done in either the graph or lane panes, but manual corrections must be done in the graph pane.
Graph Pane:

a. Click **View Selected** in the View bar.

b. Click on the row in the experiment pane that contains the sample you wish to check, then click the **Graph** tab.

If sample peaks are not identified correctly, they can be manually corrected as follows:

- **If an incorrect peak is identified as a sample peak** - Right click the peak in the electropherogram or peaks table and select **Remove peak**. Compass for Simple Western will no longer identify it as a sample peak in the electropherogram and the peak data will be removed in the results tables.

- **To set an unidentified peak as a sample peak** - Right click the peak in the electropherogram or peaks table and select **Add Peak**. Compass for Simple Western will calculate and display the results for the peak in the results tables and identify the peak in the electropherogram.

**NOTE:** To remove sample peak assignments that were made manually and go back to the original view of the data, right click in the electropherogram and click **Clear All**.

c. Repeat the previous steps for the remaining sample rows in the experiment pane to make sure all sample proteins are identified correctly.
Lane Pane:

a. Click either View Selected or View All in the View bar.

b. Click on the row in the experiment pane that contains the sample you wish to check, then click the Lane tab. To view sample protein band labels, roll the cursor over the individual bands. If sample bands are not identified correctly, they must be corrected in the graph pane as described in the previous section.

Step 5 – Assigning Peak Names (Optional)

Compass for Simple Western can identify and automatically name sample proteins associated with specific primary antibodies in the run data using user-specified peak name settings. For more information on how to do this see “Peak Names Settings” on page 317.
Group Statistics

The Grouping View is used to analyze replicates by calculating the mean, standard deviation and CV of named proteins (see “Peak Names Settings” on page 317 for detailed information on entering named proteins). Statistics for each protein are also plotted for easy comparison between samples, antibodies, and proteins.

Using Groups

1. A group is automatically created for capillaries with the same sample and primary antibody name, so to use this feature, this information must first be entered into the Assay template. To do this:
   a. Click the Assay tab and go to the Template pane.
   b. Enter sample names and primary antibody names as described in “Step 5 - Add Assay Plate Annotations (Optional)” on page 47. Be sure to enter the same sample and/or primary antibody names for the groups of samples you want to calculate statistics for.

   In this example there are two sample types, Sample A and Sample B which were run with two different antibodies, Primary 1 and Primary 2.

   Each of the two samples were run with each of the two antibodies twice in every cycle. This creates four groups for the combination of two samples and two antibodies.

2. To set a grouping option, go to Edit > Preferences and select the Grouping page. Then check the option you want to use. These options allow you to group capillaries in multiple ways. Available options are different for standard immunoassays and RePlex assays:
• **Group across runs** - Groups capillaries from multiple runs. This option creates fewer groups and generates statistics across multiple runs.

• **Group across cycles** - Groups capillaries run in different cycles.

• **Group across probes (RePlex assays only)** - Groups capillaries from multiple probes.

• **No option selected** - When only one run is open, groups will only contain capillaries from the same cycle. When more than one run is open, groups are created for each run.

3. Click **Apply** and then select **OK**.

4. Group your results and view the associated statistics by selecting **View** and clicking on **Grouping**.

**Viewing Statistics**

**Peak and Capillary Groups**

The Peak Groups pane reports statistics for each named protein in every group. Each group shows the statistics for named proteins which includes average area, standard deviation and %CV. The number in parenthesis after the sample name indicates the number of capillaries in the group.
Clicking the arrow next to a group lists the individual capillaries in the group and reported data for each capillary:

The Capillary Groups pane pivots the Peak Groups results to show statistics for named protein peaks in individual columns.

Group Plots

The mean values for named peaks in each group are plotted in bar graphs with error bars showing the standard deviation. The plots compare different antibodies for the same sample and different samples for the same antibody to allow a choice of presentation. The y-axis on the plot will be concentration if a standard curve is defined.
Hiding or Removing Capillaries in Group Analysis

Hidden capillaries are not included in groups. However, hiding capillaries provides an easy way to reject individual capillaries from the statistical analysis. See “Hiding Capillary Data” on page 190 for details on how to do this.

Larger groups of capillaries can also be excluded from analysis. To do this, select View and click Filter.

Uncheck the box next to the cycles or capillaries you wish to remove and click OK. This data will now be removed from the grouped view statistics.
Copying Data Views and Results Tables

You can copy and paste data and results tables into other documents, or save a data view as a graphic file.

Copying Data Views

1. Click in the graph or lane pane, or on an image in the image pane. In the image pane, make sure to select the entire image by clicking the top or bottom edge of the image. This adds a yellow border around the image to indicate it’s selected.
2. Select Edit in the main menu and click Copy, or right click and select Copy.
3. If you selected copy from the graph or lane pane, one of the following windows will display, click Copy. If you selected copy from the image pane skip to the next step.

4. Open a document (Microsoft® Word®, Excel®, PowerPoint®, etc.). Right click in the document and select Paste. A graphic of the copied data view will be pasted into the document.

Copying Results Tables

1. Click in the peaks or capillaries pane.
2. Select one or multiple rows.
3. Select Edit in the main menu and click Copy, or right click and select Copy.
4. Open a document (Microsoft® Word®, Excel®, PowerPoint®, etc.). Right click in the document and select Paste. Data for the rows selected will be pasted into the document.

Saving the Graph or Lane View as an Image File

1. Click in the graph or lane pane.
2. Select Edit in the main menu and click Copy, or right click and select Copy.
3. Select an image option (EMF, PNG or PDF for graph, PNG, JPG or BMP for lane) in the pop-up window, then click Save.
4. Select a directory to save the file to and enter a file name, then click **OK**.

**Exporting Run Files**

Results tables and raw plot data can be exported for use in other applications.

**Exporting Results Tables**

To export the information in the peaks and capillaries tables:

1. Click **File** in the main menu and click **Export Tables**.
2. Select a directory to save the files to and click **OK**. Data will be exported in .txt format.

---

**NOTE:** To exclude export of standards data or export results table data in .csv format, see “Setting Data Export Options” on page 345.

---

**Exporting Raw Sample Electropherogram Data**

To export raw sample plot data:

1. Click **File** in the main menu and click **Export Spectra**.
To export data in .txt format - Select **Text Format**. Plots will be exported in one file for all capillaries.

To export data in .cdf format - Select **Andi Format**. Plots will be exported in one file per capillary.

2. Select a directory to save the files to and click **OK**. Data will be exported in the selected format.
Running Reports

Compass for Simple Western v3.0 and higher can create and export run reports in .pdf format.

1. Open your run file, then select **File > Run Report**. The Run Report window displays.

2. Select or deselect the information you want included in your report.

3. Enter a file name for the report. The report file is saved in the same location as the run file is by default.

4. Report PDFs generated by Compass for Simple Western are secured by default, which means they can be viewed and printed but not modified or renamed. Uncheck **Secure PDF** if you don’t want to generate a secure report.

5. Click **OK**. When the report is done, the directory containing the report will display so you can open the report.

A full report includes the following:

- **Run information**
Run

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Path</td>
<td>C:/Users/Desktop</td>
</tr>
<tr>
<td>Assay</td>
<td>Jess</td>
</tr>
<tr>
<td>Kit Info</td>
<td>Regular: 12-230 kDa</td>
</tr>
<tr>
<td>Instrument</td>
<td>Jess, Jess JS3006 - js3006</td>
</tr>
<tr>
<td>Firmware Version</td>
<td>1.1.34338</td>
</tr>
<tr>
<td>Plate S/N</td>
<td>6902O02129</td>
</tr>
<tr>
<td>Cartridge S/N</td>
<td>0193490027</td>
</tr>
<tr>
<td>Cartridge Expires</td>
<td>N/A</td>
</tr>
<tr>
<td>Started</td>
<td>Fri 3:43 PM Apr 27, 2018 EDT</td>
</tr>
<tr>
<td>Completed</td>
<td>Fri 7:32 PM Apr 27, 2018 EDT</td>
</tr>
<tr>
<td>Error</td>
<td>None</td>
</tr>
</tbody>
</table>

- **Protocol details**

**Protocol**

<table>
<thead>
<tr>
<th>Separation Matrix</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Well Row</td>
<td>L1</td>
</tr>
<tr>
<td>Load Time (sec)</td>
<td>200.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Stacking Matrix</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Well Row</td>
<td>M1</td>
</tr>
<tr>
<td>Load Time (sec)</td>
<td>15.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sample</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Well Row</td>
<td>A1</td>
</tr>
<tr>
<td>Load Time (sec)</td>
<td>6.0</td>
</tr>
<tr>
<td>Separation Time (min)</td>
<td>25.0</td>
</tr>
<tr>
<td>Separation Voltage (volts)</td>
<td>375</td>
</tr>
<tr>
<td>Standards Exposure (sec)</td>
<td>4.0</td>
</tr>
<tr>
<td>EE Immobilization Time (sec)</td>
<td>200.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Matrix Removal</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Matrix Removal Time (sec)</td>
<td>230.0</td>
</tr>
<tr>
<td>Matrix Washes</td>
<td>3</td>
</tr>
<tr>
<td>Matrix Wash Soak Time (sec)</td>
<td>150.0</td>
</tr>
<tr>
<td>Wash Soak Time (sec)</td>
<td>150.0</td>
</tr>
<tr>
<td>Protein Normalization Time (min)</td>
<td>40.0</td>
</tr>
</tbody>
</table>

| Well Row | B1        |
| Washes | 2         |
| Wash Soak Time (sec) | 150.0    |
| Antibody Diluent Time (min) | 5.0     |
| Well Row | C1        |
| Washes | 0         |
| Wash Soak Time (sec) | 0.0      |
| Primary Antibody Time (min) | 30.0    |
| Well Row | D1        |
| Washes | 2         |
| Wash Soak Time (sec) | 150.0    |
| Secondary Antibody Time (min) | 30.0   |
| Well Row | E1        |
| Washes | 1         |
| Wash Soak Time (sec) | 150.0    |

**Detection**

<table>
<thead>
<tr>
<th>NIR Detection Profile</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Exposure 1 (sec)</td>
<td>10.0</td>
</tr>
<tr>
<td>Exposure 2 (sec)</td>
<td>30.0</td>
</tr>
<tr>
<td>Exposure 3 (sec)</td>
<td>60.0</td>
</tr>
<tr>
<td>Exposure 4 (sec)</td>
<td>120.0</td>
</tr>
<tr>
<td>Exposure 5 (sec)</td>
<td>300.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NIR Detection Profile</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Exposure 1 (sec)</td>
<td>10.0</td>
</tr>
<tr>
<td>Exposure 2 (sec)</td>
<td>30.0</td>
</tr>
<tr>
<td>Exposure 3 (sec)</td>
<td>60.0</td>
</tr>
<tr>
<td>Exposure 4 (sec)</td>
<td>120.0</td>
</tr>
<tr>
<td>Exposure 5 (sec)</td>
<td>300.0</td>
</tr>
<tr>
<td>Ladder Channel</td>
<td>NIR</td>
</tr>
</tbody>
</table>

- **Plate layout**

Compass for Simple Western User Guide
• **Analysis settings**

![Plate Layout Diagram]

- **Lane views:**
  - Panel A: Lanes 1-26
  - Panel B: Lanes 27-50
  - Panel C: Lanes 51-74
  - Panel D: Lanes 75-98
  - Panel E: Lanes 99-122

Compass for Simple Western User Guide
• Lane views (Channel Lanes Overlay for Jess Only):

NOTE: The channel lanes overlay is also divided in the report as individual NIR, IR and Standard channel lanes.
• **IV plot:**

![IV Plot](image)

• **Sample plots for each capillary:**

![CHEMI Sample Plots](image)

You can also include the fluorescent standards graphs for each capillary and the standard peaks position in pixels in the report.
• **Sample plots for each capillary by channel (Jess only):**

   ![Sample plots image]

   **NOTE:** The example shown is for the NIR channel on Jess only. The report can also include the IR channel, fluorescent standards graphs and protein normalization for each capillary, in addition to sample peak area data and the standard peaks position in pixels.

• **Sample images:**

   ![Sample images]

   **NOTE:** The report can also include images of other channels and standards.
• Analysis log:

### Analysis Log

<table>
<thead>
<tr>
<th>Date</th>
<th>User Name</th>
<th>Message</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>2019-05-05</td>
<td>Jane Smith</td>
<td>Added peak. New setting. Changes from Compass for Simple Western 2.0.4.16</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>'Added Peak Settings' Applied. Group 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>'User name: John Doe. Assay: Alpha 2 St.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Changed peak settings. Range 1: Analysis 1 to 100.</td>
<td></td>
</tr>
</tbody>
</table>

### Changing Sample Protein Identification

Compass for Simple Western allows you to customize what sample proteins are reported in the results tables by making manual adjustments in the electropherogram or peaks table.

### Adding or Removing Sample Data

1. Click **Show Samples** in the View bar.
2. Click **Single View** in the View bar.
3. Click on the row in the experiment pane that contains the sample you wish to correct, then click the **Graph** tab.

   • **To remove a peak from the data** - Right click the peak in the electropherogram or peaks table and select **Remove peak**. Compass for Simple Western will no longer identify it as a sample peak in the electropherogram and the peak data will be removed in the results tables.
To add an unidentified peak to the data - Right click the peak in the electropherogram or peaks table and select Add Peak. Compass for Simple Western will calculate and display the results for the peak in the results tables and identify the peak in the electropherogram.

NOTES:
To remove sample peak assignments that were made manually and go back to the original view of the data, right click in the electropherogram and click Clear All.

Virtual blot data in the lane pane will also update to reflect changes made in the graph pane.

Hiding Sample Data

You can hide the results for a sample protein in the results tables without completely removing it from the reported results. To do this:

1. Click Show Samples in the View bar.
2. Click Single View in the View bar.
3. Click on the row in the experiment pane that contains the sample you wish to correct, then click the **Graph** tab.

4. Right click the peak in the electropherogram or peaks table and select **Hide peak**. Compass for Simple Western will hide the peak data in the results tables.
5. To view hidden peak data, click **View** in the main menu and click **Show Hidden**. Hidden peak data will display in the results table and be marked with an X.

6. To unhide a peak, right click on the peak in the electropherogram or peaks table and select **Unhide Peak**.

**Changing Peak Names for Sample Data**

If Compass for Simple Western did not automatically name a sample protein associated with a specific primary antibody, this can be adjusted manually. You can do this in the Analysis Options pane.
You can change the name or molecular weight of a peak, the channel and its associated color, or designate corresponding capillaries. Click the desired peak in the Graph view, lane in the Lane view or row in the Peaks Table. Then in the Analysis Options pane, Peak Names menu, click **Modify**.

The New option in the Name dropdown box creates a new default Peak Name using the current channel and capillaries that are selected.

Rename the peak and modify the parameters, then click **Create**.
The tooltip next to the Caps field has useful information on acceptable nomenclature when designating capillaries to apply a Peak Name to:
Alternatively, right click the peak in the electropherogram, peaks table or lane view and click **Name**, then click a name in the list. Compass for Simple Western will change the peak name in the electropherogram and results tables, and adjust peak names for other sample proteins accordingly.

Next, enter the appropriate peak name in the Peak Name box:
NOTES:
For details on how to specify peak name settings, see “Peak Names Settings” on page 317.

Virtual blot data in the lane pane will also update to reflect changes made in the graph pane.

Displaying Sample Data for Named Peaks Only
You can adjust the sample data to display results only for user-specified named peaks. To do this:
1. Click Show Samples in the View bar.
2. Click View in the main menu and click Filter.
3. Check the Show Named Peaks only box and click OK.
Compass for Simple Western will hide peak data in the electropherogram and results tables for all unnamed peaks, and instead only display data for named peaks in the electropherogram and results tables.
Changing the Virtual Blot View

Options in the lane pane let you change the contrast or invert the virtual blot, remove baseline noise, change lane labels or overlay standards data on sample lanes.

The Lane pane toolbar has the following options:

- Protein Overlay
- Contrast Adjustment
- Invert
- Lane Options
- Overlay Standards Data

Overlaying Protein Normalization or Total Protein Data

To view Total Protein or Protein Normalization data (Jess/Abby only), make sure the Protein Normalization channel (Jess only) or Total Protein in Probe 2 of RePlex Assays is selected first, then click the Protein Overlay icon. These examples show Protein Normalization data on Jess and Total Protein data on Abby.
Protein Normalization or Total Protein data is shown as peak area counts, or peak area count percentages relative to a selected reference capillary on the secondary y-axis in lane view.

**NOTE:** Normalization must be enabled in the Analysis settings to display peak count percentage values.

For Protein Normalization runs (Jess only), RePlex runs with Total Protein (Jess/Abby), and Stellar runs with Total Protein (Jess only), Compass automatically displays the normalized peak area for detected peaks in Chemiluminescence, NIR, and/or IR channels in the Corr. Area column in the Peaks table. Additionally, if Protein Normalization is on (Jess only), the total peak area used for normalization is listed in the Corr. Area column.
For RePlex runs with Total Protein in Probe 2, total peak area used for normalization is listed in the Area column when the Probe 2 channel is on as shown in the Peaks table below. For Stellar runs with Total Protein, total peak area used for normalization is listed in the Area column.

Normalization is enabled by default. For more details on enabling or disabling Normalization, or to choose a different reference capillary see “Normalization (Jess/Abby only)” on page 300.

Adjusting the Contrast

1. Click the **Contrast Adjustment** button. The contrast tool will display:

2. There are two ways you can use the Contrast Adjustment tool. The slider is unlocked by default, so you can slide it left or right until the desired contrast is reached. You can also lock the slider at a fixed position and save your desired contrast levels. This lets you reproduce the same contrast level across data files.
3. To lock the slider, select **Edit > Analysis**, and click the **Lane Contrast** page. Select **Fixed Levels**. The numbers displayed refer to the current White and Black levels for the chemiluminescence or fluorescence (Jess only) run being analyzed. Change these settings and click **Apply** to see how they impact the contrast on the lane view. Once you're satisfied with the changes, click **OK**.

- When you select Fixed Level, the slider won't be available in the lane view.
- The Lane Contrast setting can be also be determined and saved in the Default Analysis of the Assay. That way, any data obtained by running the assay will all have the same contrast settings.
- Lane Contrast settings from the assay or run analysis windows can be exported to be applied to other assays or runs.

**Inverting the Virtual Blot**

1. Click the **Invert** button. The virtual blot image will invert:
2. Click the **Invert** button again to return to the default view.

**Lane Options**

*NOTE: If you save the run file after updating Graph and Lane options in the Analysis window, those selections will be saved in the Default Analysis View and will automatically display the next time you open the run file. See “Step 9 - Modify Default Analysis View (Optional)” on page 52 for more information.*

**Selecting Lane Labels**

The labels shown above the lanes in the virtual blot can be customized. To do this:

1. Click the **Lane Options** button. The label box will display. Lane labels for a standard Immunoassay and a RePlex Assays are shown:
2. The following lane display options are available:

- **Baseline On** - Checking this box applies the default, baseline correction to the view.
- **Independent Probe Scales (RePlex Assays only)** - Checking this box lets you have independent control of contrast scales for Probe 1 and Probe 2 data for RePlex assays when using the Contrast Adjustment button.
- **Lane order by Probe (RePlex Assays only)** - Checking this box displays lanes based on the probe number. All Probe 1 data will be displayed side by side, followed by Probe 2 data.

The following label options are available for all assays. Check one or multiple label boxes, and uncheck those you don’t want to display. To remove labels completely, uncheck all boxes.

- **Sample** - Sample name. If sample names were entered in the assay template (Assay screen), those names will display here. Otherwise, Sample (default name) will display.
• **Primary** - Primary antibody name. If primary antibody names were entered in the assay template (Assay screen), those names will display here. Otherwise, Primary (default name) will display.

• **Secondary Ab** - Secondary antibody name. If a secondary antibody name was entered in the assay template (Assay screen), those names will display here. Otherwise, Secondary (default name) will display.

• **Capillary**
  - Immunoassays (non-RePlex): Capillary number.
  - Jess/Abby RePlex Assays: Probe and capillary number. For example, 1:4 indicates Probe 1, capillary 4.

• **Attributes** - Attribute text. If attribute information was entered for any of the rows or wells in the assay template (Assay screen), up to four can be selected and displayed as lane labels.

**Viewing the Corrected Sample Baseline**

1. Click the **Lane Options** button and select the **Baseline On** box (active for sample data only). This will apply the automatic baseline correction.

2. Deselect the **Baseline On** box to return to the default, uncorrected baseline view.
Overlaying Standards Data on Sample Lanes

Data for the standards can be overlaid on the sample data in the virtual blot so you can view the raw, unaligned (uncorrected) lane data. To do this:

1. Click the **Overlay Standards Data** button (active for sample data only). An overlay of the raw sample and standards data will display:

2. Click the **Overlay Standards Data** button again to return to the default, auto-aligned view.
Moving Lanes in the Virtual Blot View

Lanes in the virtual blot view can be moved to make it easier to compare specific lanes of data. To do this:

1. Click a lane in the virtual blot. Hold the mouse button down and drag the lane to a new position.

2. Release the mouse button. The lane will now be repositioned in the virtual blot view.
Creating Annotated Lane View Figures

The Annotations pane lets you create annotated figures of the Compass Lane view for use in presentations or publications.

NOTES:
You can only create annotated figures from one run file at a time. The Annotations pane is not active when multiple run files have been opened using File > Add run.

The Annotation pane can’t be used when Access Control is enabled for 21 CFR Part 11 compliance.

To create a figure:
1. Select the lanes you want to create a figure from. For RePlex runs, select the channel(s) to include.
2. Adjust the lane contrast as needed.
3. Click the Create a figure icon in the Annotations pane.
The Lane pane shows a figure preview in a pink bounding box. The Annotations pane displays the crop region information for the bounding box, which includes capillaries for the selected lanes, the MW range of the assay type used for the run file, and contrast settings.

The following examples show the figure previews for a standard immunoassay and a RePlex assay with two channels selected.
In the preview you can:

**Adjust the lane/capillary order** - Click on a lane and drag it to the position you want it to be in, or type the capillary order in the Caps field. Separate each number with a comma.

**Adjust the MW Range** - Drag the pink bounding box until the desired range is displayed in the table, or just click in the table cell and type a range.

**Adjust the contrast** - see “Adjusting Lane Contrast” on page 242.

**Add a another crop region** - Click in the first blank cell in the MW Range column.
A second bounding box will display on the figure preview.

Drag the pink bounding box for the second crop region until the desired range is displayed in the table, or just click in the table cell and type a range.

**Add a channel/probe for RePlex assays** - This lets you create a figure that stacks multiple channel/probe views. Click in the first blank cell in the MW Range column. Select the channel checkbox(es) and click OK.
A second bounding box will display in the figure preview:

Drag the pink bounding box for the second crop region until the desired range is displayed in the table, or just click in the table cell and type a range.

**To delete a row in the table** - click the cell on the left of the MW Range column to highlight the row, then right click the column and select **Delete**.

4. Click **Crop** to create the figure file.
The figure displays in a new tab. The following examples show figures for a standard immunoassay with one crop region and a RePlex Assay with two stacked crop regions for each probe:
After the figure is cropped, the information in Caps and the table can’t be adjusted. If changes are needed, click **Re-crop**. This returns you to the prior view where you can reorder lanes, adjust the MW range, or add a new crop region.

---

**NOTES:**

After you create a figure, saving the run file saves the figure with the run data and the figure will display the next time you open the file.

If you don’t see the data you want to include in the figure preview, you can click on the Lane tab to review all run data and select/deselect channels.

---

5. **Optional:** If you’d like to create a new figure, repeat the prior steps. Each new figure will display in its own tab:
NOTE: If Analysis settings are modified in the run file, for example peak name changes or changes that affect peak area, those changes are automatically applied to figures created from the run file.

Annotations Pane Toolbar

These options are available in the Annotations pane toolbar:

To export a figure:

Click the Export selected figure icon or right click on the figure and select Export. Browse to the directory you want to save the file to and update the file name as needed. File names must use these guidelines:

- Names must be between 1 and 20 characters
- Names must not already be in use in the same run file
- Use Unicode characters only:
• Letters and numbers
• Spaces
• Hyphen, minus or underline
• $

Click the down arrow in **Save as Type** to choose a file format.
• .png and .jpg are best for use in external programs like Microsoft® Word® or PowerPoint®.
• .tiff is exported at 300 dpi and is the recommended format for submitting data to journals for publication.

To duplicate the current figure: Click the **Duplicate selected figure** icon. A duplicate of the figure currently selected will display in a new tab.

To create another figure: Follow the steps outlined earlier in this section. When you click the **Create a figure** icon, the new figure will display in a new tab.

To switch between annotating multiple figures: Click the **Figure selection** dropdown and select the figure you’d like to annotate.
To copy a figure: Right click on the figure and select Copy. Open a document (Microsoft® Word®, Excel®, PowerPoint®, etc.). Right click in the document and select Paste.

To delete a figure: Click the Delete selected figure icon.

To rename a figure: Select the figure in the Figure selection dropdown, then click on the text and type a new name.

Adjusting Lane Contrast

After you create a figure, you can adjust the lane contrast in the figure two ways:

Contrast adjustment in the Lane pane:
This option lets you change the contrast for the Lane View and the figure at the same time. Note that contrast adjustments can be channel-specific and probe-specific depending on which Lane View options are selected.

Click the Contrast Adjustment icon in the Lane pane.

Click the bar and slide it left or right until the desired contrast is reached. The virtual blot lane contrast will change as you do this, but not the figure. The contrast adjustment will be applied to the figure when you release the mouse.
The following examples show Lane View and figure contrast before (left) and after adjusting the contrast using Contrast Adjustment (right) in Lane View:

Custom contrast in the Annotations pane:
This option lets you change the contrast in the figure only.

Notes:
Custom contrast changes made in the Annotations pane are applied to the figure only. They are not applied to the run data or in Lane View.

If Custom Contrast is selected in the Annotations pane, figure contrast can’t be changed using the Contrast Adjustment tool in the Lane View.

1. In the Annotations pane, click the down arrow next to Crop Regions to expand the section. Click the cell in the Contrast column for the crop region you’d like to adjust, then select the ... button:
2. Select the **Custom Contrast** checkbox.

3. Click the bar and slide it left or right until the desired contrast is reached. Only the lane contrast in the figure, not Lane View, will change as you do this.
Adding Lane Labels

This option lets you add lane labels on the figure, and change how they display.

1. Click the down arrow next to Lane Labels to expand the section.

You can create different lane label groups based on assay attributes or create your own custom group.
NOTE: Assay attributes for the run file can be viewed in the Assay screen Template pane.

Compass automatically creates a default SampleGroup which is linked to the Sample name in the assay template. For more information on assay plate annotations, see “Step 5 - Add Assay Plate Annotations (Optional)” on page 47. This information for the run data is displayed in the table and above the lanes in the figure.

2. Edit the default lane label group as needed:
   a. Click in the Group field and enter a new name.
   b. Select an attribute using the Link to drop down menu.

In this example, Capillary was selected as the attribute (for RePlex assays, this attribute is Probe:Capillary). This displays capillary numbers above the lanes in the figure. This information is also displayed in the Lane Table.
You can also create a custom group by selecting None from the Link to drop down menu. Selecting None allows you to create custom names for each Lane Label in the table.

3. Create new groups as needed. Lane labels for all groups will be displayed on the figure.

   a. Click the Create a label group icon.

   b. Click the Group field and enter a name.
c. Select an attribute using the Link to drop down menu. In this example, two lane groups are displayed on the figure, one for capillaries and for samples:

4. Change the lane label styles using the Style icons. Styles are applied per group. If you’re using more than one lane label group, first select the group you want to change in the Group dropdown.

**Merge labels**: Toggling this icon switches between having individual labels on every lane or merging labels across lanes with the same Lane Label name.
Wrap label text: Toggling this icon switches between the label text displaying on one line or wrapping onto the next line.

When this option is active, || displays in the label text in the table to indicate where the text will wrap. If you've created a custom group, you can add additional breaks by typing || next to a word.

Label location: Toggling this icon moves the labels to under the lanes and back to the top. The default position is above the lanes. If more than one set of group labels is displayed, toggling the icon will move the currently selected group's labels under other group labels first before moving it under the lanes.
Group name position: Toggling this icon displays the group name on the left, top and right of the lane labels, or turns the display off. The default is off.

Overline/underline: Toggling this icon switches between displaying a line under the labels, above the labels or off.

Rotate label: This lets you change the font angle of the labels. Click the Rotate label icon and enter a font angle. The default setting is 0 (horizontal). You can enter values from 0 to 90 degrees.

Lane labels will rotate accordingly:
Adding Band Labels

This option lets you add band labels on the figure, and change how they display.

1. Click the down arrow next to **Band Labels**.

You can create different band label groups based on the Peak Names you created in the Analysis Settings for your run or create your own custom groups.

---

**NOTE:** The Peak Name groups associated with the run data can be viewed in the Analysis Screen in the Analysis Options pane.

---

Compass automatically creates default band label groups based on the Ladder and Peak Name groups in the run data, and these labels automatically display on the figure. In this example, the default groups included a Ladder, and a group with ERK1 and System Control.
2. Edit the default groups as needed:
   
a. Click in the **Group** field and select a group.

b. Change the name of the group as needed.

c. Select a Peak Name group using the **Link to** drop down menu.
3. Create new groups as needed. Band labels for all groups will be displayed on the figure.
   a. Click the Create a label group icon.

   b. Click the Group field and enter a name.

   c. Select a Peak Name group using the Link to drop down menu.

   You can also create a custom band label group by selecting None as the Link to option. This lets you add new label names directly into the table. Click in the table cells and enter a name and a MW for each band. In this example, a custom group was added to indicate where a band was expected but not detected in the sample:
4. Change the band label styles using the Style icons. Styles are applied per group. If you’re using more than one group, first select the group you want to change in the Group dropdown.

**Line style:** Toggling this icon changes the line style next to the band label between no line, a short line, a long line and a line with an arrow.
**Wrap label text:** Toggling this icon switches between the label text displaying on one line or it wrapping to the next line.

When this option is active, `||` displays in the label text in the table to indicate where the text will wrap. You can add additional breaks by typing `||` next to a word.

<table>
<thead>
<tr>
<th>Band Label</th>
<th>MW (kDa)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Band of interest</td>
<td>70</td>
</tr>
</tbody>
</table>

**Label location:** Toggling this icon moves the labels back and forth between the left and right side of the lanes. The default setting is on the right.
Adding a Title and Notes

You can add a title, notes and insert the run file name on the figure.

1. Click the down arrow next to **Title & Notes** to expand the section.

2. Enter a title and any notes. Text for both will display on the figure as you type. The title displays at the top of the figure, notes display under the lanes.
3. Clicking `#cbz` will insert the run file name in the Notes text box:

![Image of annotated lane view figures with `#cbz` inserted in Notes text box]

**Changing the Font**

You can change the font, font size and style used for figure annotations.

1. Click the down arrow next to **Settings** to expand the section and click the `...` button.

![Image of settings dropdown with current font `Segoe UI` highlighted]

2. Select the desired font, font style and size and click **OK**. The default font is `Segoe UI`.

![Image of annotated lane view figures with custom font]
Font changes are applied to all text on the figure. The font for labels, titles and notes can’t be changed individually. In this example, the selected font is Palatino bold:
Changing the Electropherogram View

Options in the graph pane let you zoom and scale electropherograms, overlay or stack plots and change the peak and plot information displayed.

The graph pane toolbar has the following options:

- **Auto Scale**
- **Graph Options**
- **Stack the Plots**
- **Overlay the Plots**

**Autoscaling the Electropherogram**

Click the **Autoscale** button to scale the y-axis to the largest peak in the electropherogram.
Click the **Autoscale** button again to return to default scaling.
Stacking Multiple Electropherograms

Electropherogram data for multiple capillaries can be stacked vertically in the graph pane for comparison. To do this:

1. Click **Single View**.
2. Select multiple rows in the experiment pane.
3. Click the **Stack the Plots** button. The individual electropherograms for each row selected will stack in the graph pane.

You can customize the colors used for the stacked plot display. For more information see "Selecting Custom Plot Colors for Graph Overlay" on page 346.
Overlaying Multiple Electropherograms

The electropherogram data for multiple capillaries can also be overlaid on top of each other for comparison in the graph pane. To do this:

1. Click **Single View**.
2. Select multiple rows in the experiment pane.
3. Click the **Overlay the Plots** button. The individual electropherograms for each row selected will overlay in the graph pane.

You can customize the colors used for the overlay plot display. For more information see “Selecting Custom Plot Colors for Graph Overlay” on page 346.
Zooming

To zoom in on a specific area of the electropherogram, hold the mouse button down and draw a box around the area with the mouse:
To return to default scaling, right click in the electropherogram and click **Zoom Out**.

**Graph Options: Customizing the Data Display**

*NOTE:* If you save the run file after updating Graph and Lane options in the Analysis window, those selections will be saved in the Default Analysis View and will automatically display the next time you open the run file. See “Step 9 - Modify Default Analysis View (Optional)” on page 52 for more information.

You can customize electropherogram peak labels, plot labels and display options. To do this, select the **Graph Options** button.
Peak Labels

You can customize the labels used to identify peaks in the electropherogram with these options:

Matching Peak Names - Checking this box will draw vertical lines through each named peak. Using this option with Stack the Plots or Overlay the Plots features is useful for visual comparison of named peaks across multiple capillaries.
• **Peak Names** - Checking this box will display peak name labels on all named peaks in the electropherogram.

---

**NOTE:** If more than one peak label option is selected, peak name labels will always be used for named peaks.
• **Peak Values** - Checking this box will display the molecular weight labels on all peaks in the electropherogram.

---

**NOTES:**

When viewing standards data, this option is called Peak Positions. Labels displayed are peak positions rather than molecular weight.

If more than one peak label option is selected, peak name labels will always be used for named peaks.

The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay in Compass for Simple Western may vary from apparent molecular weights using other techniques and based on sample and assay conditions.
Baseline, All Exposures and Grid Options

You can view the calculated baseline fit, peak integration, view all exposures and show grid lines with these options.

- **Fitted peaks** - Checking this box will display how the peaks were fit by the software.
  - For Immunoassays, the software uses Gaussian fit by default:

  **NOTE:** This option is only available for sample data.
• For Total Protein Assays, the software uses Dropped Lines fit by default:

• **Baseline Fit** - Checking this box will display the calculated baseline for the peaks. Baseline points will also display for regions of the electropherogram considered to be at baseline.
• **Noise Region** - Checking this box will overlay the noise region on the electropherogram. The noise region is indicated by the two red dots. For more information on signal to noise methods and calculations, see “Signal to Noise Settings” on page 303.
NOTE: This option is only available for sample data.

- **All Exposures** - Checking this option will overlay all the chemiluminescence or fluorescence (Jess only) exposure times acquired for a particular run. The peak that corresponds to the exposure time selected in the Analysis window on the Images page will be outlined in blue and the Peaks table below the graph window displays the data corresponding to the selected exposure time.

In the image below, the All Exposures option is displayed and the 30 second exposure selected in the Analysis window is outlined in blue.
Exposure times are sequential, so longer exposures may have less signal. Since the y-axis in the graph view reports signal/time, the peak heights for the different exposures should be fairly similar. The peak heights and areas will decrease over time with normal HRP enzyme or fluorophore decay, which is expected to occur in the late exposures (longer than 120 or 240 seconds).

If on the other hand you observe a quicker signal (peak height) decline over time in the tall peaks vs. smaller peaks for a chemiluminescence run, then this decline is what we refer to as burnout and is a result of local Luminol depletion.

As a rule of thumb, start by looking at the shortest exposure times (typically 5 to 30 seconds). If the peak heights from each exposure have similar values, then there is likely no signal burnout. If the peak height decreases significantly during those early exposure times, this is an indication of potential signal burnout. Another hallmark of signal burnout is peaks developing shoulders and eventually splitting as exposure time increases.

If you experience burnout, the first thing to do is to reduce the signal level by lowering the sample concentration in the assay. We do not recommend lowering the primary or secondary antibody concentration. Keeping the primary antibody concentration at saturation conditions keeps your assay linear and reproducible.

The image below shows a chemiluminescence detection example where the peak height from 5 to 30 seconds declines significantly and it is split in two peaks by 30 seconds. In this case we would recommend that you start by lowering the sample concentration.
• **Grid Lines** - Checking this box will display grid lines in the graph area.
**Independent Probe Scales (RePlex Assays Only)**

Checking this option displays Probe 1 and Probe 2 data using the same detection channel on independent y-axis scales. The Probe 1 y-axis will display on the left and the Probe 2 y-axis will display on the right. Y-axis labels will indicate P1 and/or P2. The following example show the graph display with the Independent Probe Scales off (top) and on (bottom).

---

**NOTE:** When more than one channel is used for Probe 1, all data for a channel is displayed on the same y-axis when viewing three or more channels.
**Plot Labels**

You can customize the plot labels displayed on the electropherogram with these options.

- **Sample** - Checking this box will display the sample name. If sample names were entered in the assay template (Assay screen), those names will display here. Otherwise, Sample (default name) will display.

- **Primary** - Checking this box will display the primary antibody name. If primary antibody names were entered in the assay template (Assay screen), those names will display here. Otherwise, Primary (default name) will display.

- **Secondary** - Checking this box will display the secondary antibody name. If secondary antibody names were entered in the assay template (Assay screen), those names will display here. Otherwise, Secondary (default name) will display.

- **Capillary** - Checking this box will display the cycle and capillary number. For example, C1:3 indicates cycle 1, capillary 3.

- **Attributes** - Checking this box will display attribute text. If attribute information was entered for samples or primary antibodies in the assay template (Assay screen), they can be selected as plot labels.

- **Exposure** - Checking this box will display the exposure time(s) used for the data.

The following example shows an electropherogram with all plot labels selected:
Selecting Data Viewing Options

The graph view menu provides you with multiple options for changing what type of electropherogram data is displayed. To access the view menu, click the stacked dot icon in the graph pane toolbar:
A check mark next to the menu option indicates it is currently selected. Multiple options can be selected at a time.

NOTE: Unless otherwise noted, graph view menu options are available for sample data only.

- **Sample** - Clicking this option will display raw, uncorrected sample data.
• **Sample Baseline Corrected** - Clicking this option will display sample data with the baseline subtracted (zeroed). This is the default view.

• **Baseline Fit** - Clicking this option will display the calculated baseline for the raw sample data. In the example that follows, both Baseline fit and Sample are selected.
NOTE: This option is selected automatically when Baseline Fit is selected in graph options.

- **Baseline Points** - Clicking this option will display regions of the electropherogram considered to be at baseline. In the example that follows, both Baseline Points and Sample are selected.
NOTE: This option is selected automatically when Baseline Fit is selected in graph options.

- **Fit** - Clicking this option will display the bounding envelope of the fitted peaks as calculated by the software for the raw sample data. In the example that follows, both Fit and Sample are selected.
- **Fit Baseline Corrected** - Clicking this option will display the fitted peaks as calculated by the software for the sample baseline corrected data. In the example that follows, both Fit Baseline Corrected and Sample are selected, the fit plot is on the bottom.

**NOTE:** When viewing standards data, this option is called Standards Fluorescence.
• **Standards** - Checking this box aligns the molecular weight of the raw standards data to the sample data and overlays both electropherograms in the graph pane.

Adding and Removing Baseline Points

Points in the baseline can be added or removed as needed. To do this:

1. Click the **Graph Options** button in the graph pane toolbar and check **Baseline Fit**. This will display baseline points for the raw sample data.

2. Use the mouse to draw a box around the area you want to correct. This will zoom in on the area.
3. Right click a baseline point and click **Add Baseline Point** or **Remove Baseline Point**.

![Image showing baseline points addition and removal](image)

**NOTE:** To clear the manual addition or removal of baseline points and go back to the original view of the data, right click in the electropherogram and click **Clear All**.

### Selecting the X-Axis Molecular Weight Range

The molecular weight range used for the x-axis can be changed. To do this, Select **View** in the main menu and click **View Region**. The following pop-up window will display:
• Selecting **Analysis** will match the range of the run data that was selected in the Peak Fit Analysis Settings in both the electropherogram and virtual blot view.

![Electropherogram Example](image1.png)

• Selecting **Full** will display the range of the run data for the entire capillary in both the electropherogram and virtual blot view.

![Electropherogram Example](image2.png)

• Selecting **Custom** allows you to manually enter the Lower and Upper ranges of the run data to be displayed in both the electropherogram and virtual blot view.
NOTE: You can change the default x-axis range that Compass for Simple Western uses. For more information, see "Normalization (Jess/Abby only)" on page 300.

Closing Run Files

If more than one run file is open, you can close just one file or all the open files at the same time.

- To close one of multiple open run files - In the experiment pane, click on one of the sample rows in the file. Next click File from the main menu and click Close.
- To close all open run files - Select File from the main menu and click Close All.
Analysis Settings Overview

Compass for Simple Western has a variety of analysis features and settings that you can modify as needed to enhance run data.

To access the analysis settings, select **Edit** in the main menu and click **Analysis**. If more than one run file is open, select the run file you want to view analysis settings for from the list:

The following screen will display:
To move between analysis pages in this window, click on an option in the list on the left. The following analysis settings can be user-customized in Compass for Simple Western:

- **Standards** - Lets you customize the positions Compass for Simple Western uses to identify fluorescent standards peaks.
- **Ladders** - Lets you customize the molecular weight Compass for Simple Western uses to identify molecular weight ladder(s), as well as change the capillary used.
- **Images** - Lets you view the chemiluminescent exposures taken during the run and view data for different exposures in the Analysis screen.
- **Normalization (Jess/Abby only)** - Lets you change the reference capillary used for normalization calculations and define region for normalization area.
- **Peak Names** - Lets you enter custom naming settings for sample proteins associated with specific blocking reagents, primary antibodies or attributes and have Compass for Simple Western automatically label the peaks in the run data.
- **Peak Fit** - Lets you customize peak fit settings for sample data.
- **Lane Contrast** - Lets you enter custom contrast settings for detection channels in Lane View.
- **Signal to Noise** - Lets you change the method used to calculate signal to noise in sample data.
- **Advanced** - Lets you customize analysis settings for samples, standards and image data.
Advanced Analysis Settings

The advanced analysis settings page lets you view and change analysis settings for samples, standards and image data. To access these settings, select **Edit** in the main menu and click **Analysis**, then click **Advanced** in the options list.

*NOTE: Settings can be modified in an assay prior to starting a run, or in a run file once the run has finished executing. Analysis changes made to an executing run will not be saved to the final run file.*
Click **Import** to import an analysis settings file. This will be explained in more detail in “Importing Analysis Settings” on page 340.

Click **Export** to export the current analysis settings file. This will be explained in more detail in “Exporting Analysis Settings” on page 340.

Click **OK** to save changes and exit.

Click **Cancel** to exit without saving changes.

**Standards Settings**

- **Peak Width** - The approximate width (at full width half max) used to filter out fluorescence artifacts which improves recognition of standards. The default value is 15.
- **Allowable Drift** - The distance in pixels that standards are expected to move compared to their entered positions in the standards analysis page. This setting assists in recognition of standards. The default value is 100.

**Sample Settings**

- **Peak Fit Starting Width Ratio** - Focuses the peak fit towards the peak center and aids the overall peak fitting. The default value is 0.5.

**Image Settings**

- **Median Filter Threshold Ratio** - Pixel ratio used to filter out camera artifacts. The default value is 0.5.
- **Median Filter Threshold Limit** - Pixel threshold value used to filter out camera artifacts. The default value is 1000.
Advanced Analysis Settings Groups

Advanced analysis settings are saved as a group, and multiple settings groups can be created. Specific group settings can then be applied to individual capillaries, sample names or attributes in the run data.

---

NOTES:

We recommend using the Compass for Simple Western default values for advanced analysis settings. These settings are included in the default Advanced group.

Analysis settings are run-file specific. However, settings can be imported or exported for use with other run files. For more information see “Importing and Exporting Analysis Settings” on page 340.

---

Analysis groups are displayed in the analysis settings box:

![Analysis Groups](image)

The Advanced group shown contains the Compass for Simple Western default analysis settings. You can make changes to this group and create new groups.

To view settings for a group, click on the group name in the analysis settings box.

Creating a New Analysis Group

1. Select **Edit** in the main menu and click **Analysis**, then click **Advanced** in the options list.
2. Click **Add** under the analysis settings box. A new group will be created:

![New Analysis Group](image)

3. Click on the new group and enter a new name.
4. Modify standards, sample or image parameters as needed.

5. To use the new group as the default analysis settings for the run file data, click the arrow in the drop down list below Apply Default, then click the new group from the list. Analysis settings in the new group will then be applied to the run data.

6. Click OK to save changes.

Changing the Default Analysis Group

1. Select Edit in the main menu and click Analysis, then click Advanced in the options list.

2. Click the arrow in the drop down list below Apply Default, then click a new default group from the list.

3. Click OK to save changes. Analysis settings in the group selected will be applied to the run data.

Modifying an Analysis Group

1. Select Edit in the main menu and click Analysis, then click Advanced in the options list.

2. Click on the group in the analysis settings box you want to modify.
3. Modify standards, sample or image parameters as needed.
4. Click **OK** to save changes. The new analysis settings will be applied to the run data.

Deleting an Analysis Group

1. Select **Edit** in the main menu and click **Analysis**, then click **Advanced** in the options list.
2. Click on the group in the analysis settings box you want to delete and click **Remove**.

3. Click **OK** to save changes.

Applying Analysis Groups to Specific Run Data

1. Select **Edit** in the main menu and click **Analysis**, then click **Advanced** in the options list.
2. Click on the group in the analysis settings box you want to apply to specific run data.

3. Application of analysis groups to specific run data is done in the override box. Click **Add** under the override box. A default override data set will be created from sample information found in the run file.
4. Click the cell in the **Apply To** column, then click the down arrow.

![Apply Override window](image)

5. Select an option from the drop down list. This will apply the settings group selected to specific run data as follows:

   - **Sample names** - All sample names entered in the assay template (Assay screen) will display in the drop down list, otherwise the default name of Sample will be shown. Select a sample name to apply group settings to all capillaries that use this sample name in the run file.
   - **Attributes** - All sample attributes entered in the assay template (Assay screen) will display in the drop down list. Select an attribute to apply group settings to all capillaries that use this attribute in the run file.
   - **Cycle 1** - When this option is selected, group settings will be applied to all capillaries.
   - **Probe 1 and 2 (RePlex Assays only)** - Applies group settings to all capillaries within that probe.
   - **Custom settings** - Lets you choose specific capillaries to apply the group settings to. When this option is selected, the following pop-up box appears to let you enter a specific capillary number or range of capillaries:
6. If you need to change the analysis group used for a data set, click the cell in the **Settings** column and click the down arrow. Select a group from the drop down list.

7. Repeat the previous steps to apply other groups to specific run data.

8. To remove a data set, click on its cell in the **Apply To** column, then click **Remove**.

9. Click **OK** to save changes.
Images Analysis Settings

The Images settings in the Analysis window lets you see what Detection Profile was selected, what exposures were taken during the run, and view data for different exposures in the Analysis screen. To access these settings, select **Edit** in the main menu and click **Analysis**, then click **Images** in the options list.

**NOTES:**
If you’re using Compass for Simple Western v3.1 or higher, High Dynamic Range is the default setting.

If the run was performed with HDR unchecked, the data can still be analyzed with the improved HDR algorithm by selecting High Dynamic range from the drop down menu. For Jess, Wes and Abby chemiluminescent runs, the increase in dynamic range will not be as noticeable since the substrate refresh was not performed.

**NOTE:** The Images pane will only list the channels of data that are present in the run data file.
• Click **Import** to import an analysis settings file. This will be explained in more detail in “Importing Analysis Settings” on page 340.

• Click **Export** to export the current analysis settings file. This will be explained in more detail in “Exporting Analysis Settings” on page 340.

• Click **Apply** to see effects of changes before saving.

• Click **OK** to save changes and exit.

• Click **Cancel** to exit without saving changes.

**Exposure Settings**

The exposure used for the sample data displayed in the Analysis screen is shown below for a standard chemiluminescent Immunoassay with Protein Normalization (top), a RePlex Assay (Jess/Abby only) with two chemiluminescent immunoassays (middle) and a Stellar Assay on Jess (bottom):
Even when the exposures for HDR are set and can't be edited from the assay protocol, here you can choose to view each one separately including High Dynamic Range (HDR multi-image).

- **Multi-Image Analysis** - Sample data displayed in the Analysis screen is compiled from all exposures taken during the run. The Multi-Image analysis allows you to keep using exactly the same settings as before, which is calculated using the algorithm in versions of Compass for Simple Western v3.0 or Compass v2.7 or earlier. This is provided for backward compatibility and direct comparison to older data sets, but the HDR method is preferred for all new analyses.

- **High Dynamic Range** - The HDR method uses information from multiple exposures to achieve good signal-to-noise for low protein concentration while simultaneously maintaining signal monotonicity at high protein concentration (i.e. avoiding "burnout").
• **High Dynamic Range 4.0** - Algorithm improvements were made to the original High Dynamic Range analysis in HDR 4.0 to handle a wider range of burnout cases. HDR 4.0 is less sensitive to the level at which burnout occurs. When burnout occurred at a low level, the classical HDR method had trouble picking the optimal exposure and interpolating between exposures.

• **Exposure #** - Sample data displayed in the Analysis screen is for this specific exposure only.

To see the number of exposures and exposure times used for the run data, click the arrow in the drop down.

---

*NOTE: The number of exposures taken and exposure times shown were specified in the assay protocol (Assay screen) prior to executing the run and cannot be modified.*

---

**Changing the Sample Data Exposure Displayed**

The exposure used for the sample data displayed in the Analysis screen can be changed. To do this:

1. Select **Edit** in the main menu and click **Analysis**, then click **Images** in the options list.
2. Click the arrow in the drop down list next to **All** and select an exposure setting:

![Images](image_url)

3. Click **Apply** and then click **OK** to save changes and exit. Sample data for the exposure selected will display in the Analysis screen.
Normalization (Jess/Abby only)

The Normalization settings in the Analysis window lets you view and change the reference capillary used for protein normalization calculations, and adjust the control area and size region for determining the normalization area. Normalization settings are applicable when using the Protein Normalization Module or when enabling the Total Protein feature for RePlex and Stellar Assays. To access these settings, select Edit in the main menu and click Analysis, then click Normalization in the options list.

NOTES:

For Jess/Abby runs that include Protein Normalization or RePlex and Stellar Total Protein assays, the default Reference Capillary is set to 2.

The Enable checkbox is selected by default and must stay selected to normalize immunoassay targets.

- Click Import to import an analysis settings file. This will be explained in more detail in “Importing Analysis Settings” on page 340.
• Click **Export** to export the current analysis settings file. This will be explained in more detail in “Exporting Analysis Settings” on page 340.
• Click **Apply** to see effects of changes before saving.
• Click **OK** to save changes and exit.
• Click **Cancel** to exit without saving changes.

---

**NOTE:** If you deselect the Enable checkbox in the Normalization settings, only Protein Normalization total protein values will display, immunoassay target data won’t be normalized.

---

**To use the Protein Normalization fluorescence signal or RePlex/Stellar Total Protein chemiluminescent signal from a reference capillary for protein normalization:** Click the Reference Capillary drop down menu and select the capillary you’d like to use as the normalization control to normalize all other capillaries against. ProteinSimple recommends choosing the capillary that had the highest sample concentration. The default reference capillary is 2.

---

**To manually assign a reference signal for protein normalization:** Select the **Control Area** box and enter a signal value. This setting is helpful when you want to use the average signal from more than one capillary for normalization.
To change the sizing region that the normalization total area is determined: Enter new kDa values in the Area Start and Area End boxes.

Click Apply and then click OK to save changes and exit. Updated sample data using the new normalization settings will display in the Analysis screen.
Signal to Noise Settings

The signal to noise settings page lets you view and change the method used for the signal to noise calculation in the sample data. To access these settings, select Edit in the main menu and click Analysis, then click Signal to Noise in the options list.

NOTE: Settings can be modified in an assay prior to starting a run, or in a run file once the run has finished executing. Analysis changes made to an executing run will not be saved to the final run file.

- Click Import to import an analysis settings file. This will be explained in more detail in “Importing Analysis Settings” on page 340.
- Click Export to export the current analysis settings file. This will be explained in more detail in “Exporting Analysis Settings” on page 340.
- Click Apply and then click OK to save changes and exit.
- Click Cancel to exit without saving changes.
S/N Compass v5.0

S/N Compass v5.0 is a method that calculates peak score based on a peak finding algorithm to provide a relative ratio comparing all peaks within the electropherogram in Compass. S/N Compass v5.0 was referred to as ‘Peak Score (v1-v5)’ in Compass for Simple Western versions 6.0. This is the default selection for run data generated using Wes assays in Compass for Simple Western 6.0 and higher.

With some run data, Peak Score can result in negative signal to noise values. If this happens, using the Signal-to-Noise Ratio instead will correct this.

Signal-to-Noise Ratio

The calculation used for the Signal-to-Noise Ratio follows USP/NF (United States Pharmacopeia/National Formulary) regulations with the difference on how noise is determined. This is the default selection for run data generated using Jess and Abby assays in Compass for Simple Western 6.0 and higher.

When this option is selected, you can set the following parameters to select the region of data used to identify the best noise sampling:

- **Full** - Selects the entire data range of the run data within the capillary along the x axis (in kDa) for the noise region. The default range used will be the size range for the run data: 2-40, 12-230, or 66-440 kDa. This is the default setting for the Noise Region and is recommended for most use cases.

- **Custom** - Lets you set the data range along the x axis (in kDa) to narrow the search region used for the signal to noise calculation. To use this option, enter a **Start** and **End** value in kDa.

**NOTE:** There are no custom range recommendations from ProteinSimple. The start and end value entry depends on the user application and noise variation in the run data.
When Signal-to-Noise Ratio is selected, the software can overlay the noise region on the electropherogram in the Graph pane. To display the overlay, select **Noise Region** from the Graph Options menu:

The noise region is indicated by the two red dots on the electropherogram. To zoom in on the noise region: select that area with your mouse:
Next, select **Auto Scale**. This makes it easier to see the noise fit region, as well as the points used in the overall noise calculations:
The red line represents the quietest noise fit region within the bounded area. The two points are the greatest difference in noise between the real and fit data within the quietest region.

To find the noise fit region, Compass for Simple Western utilizes a rolling window over the bounded area based on the Start and End values. Beginning at the Start value, the software fits a curve using polynomial regression to a window of real data, and calculates the maximum difference between the real data and the fit data above and below the curve. It then searches for the quietest region via multiple searches within the bounded area and chooses the region with the minimum noise.

Noise is found by taking the distance between the actual data points and the fit curve, and adding those values. In the following data, those values have been marked (1, 2), and the distance between the real point and the fit curve is shown as the straight blue line:

\[
\text{h} = \text{Length of Blue line 1} + \text{Length of Blue line 2}
\]

This is the highest noise within the determined region of minimum noise. The signal to noise ratio given the peak height is then calculated using:

\[
2.0 \times \frac{\text{Peak Height}}{\text{h}}
\]

This calculation is done for each peak, and is represented as the S/N value in the Peaks Table:
NOTE: Per USP standards, 'h' is derived from the noise region around the peak of interest and is used in the S/N ratio calculation for that individual peak. Compass for Simple Western calculates 'h' in the quietest noise fit region in the boundary area (not around the individual peak of interest). This value is used to calculate the S/N ratio across the capillary for all peaks, where the only value that changes for individual peaks is the Peak Height.

Peak Fit Analysis Settings

The peak fit analysis settings page lets you view and change peak fit settings for sample data. To access these settings, select **Edit** in the main menu and click **Analysis**, then click **Peak Fit** in the options list.
NOTE: Settings can be modified in an assay prior to starting a run, or in a run file once the run has finished executing. Analysis changes made to an executing run will not be saved to the final run file.

- Click **Import** to import an analysis settings file. This will be explained in more detail in “Importing Analysis Settings” on page 340.
- Click **Export** to export the current analysis settings file. This will be explained in more detail in “Exporting Analysis Settings” on page 340.
- Click **Apply** and then click **OK** to save changes and exit.
- Click **Cancel** to exit without saving changes.

**Range Settings**

- **Minimum** - The molecular weight value (in kDa) below which peaks will not be identified. This value will also be used as the default lower MW range for the data displayed in the electropherogram and virtual blot.
• **Maximum** - The molecular weight value (in kDa) above which peaks will not be identified. This value will also be used as the default upper MW range for the data displayed in the electropherogram and virtual blot.

• **View** - Changes the molecular weight range used for the x-axis.
  - **Analysis** matches the range of the run data that was selected in the Peak Fit Analysis Settings in both the electropherogram and virtual blot view. This is the default setting.
  - **Full** will display the range of the run data for the entire capillary in both the electropherogram and virtual blot view.

### Baseline Settings

• **Threshold** - The variance, or roughness, in a baseline data segment below which a point will be called part of the baseline.

• **Window** - How long baseline data segments are expected to be in pixels. Shorter segments will allow the baseline to follow plateau sections of the signal.

• **Stiffness** - The amount the baseline is allowed to vary from a straight line. Settings between 0.1 and 1.0 make the baseline fit closer to a straight line. Settings from 1.0 to 10.0 will make the baseline fit follow the data more closely.

### Peak Find Settings

• **Threshold** - The minimum signal to noise ratio required for a peak to be identified. A setting of 1.0 will detect many peaks, a setting of 10.0 will detect fewer peaks.

• **Width** - The approximate peak width (at full width half max) in pixels used to detect peaks. The minimum value for this setting is 3.0. Larger widths help to eliminate the detection of shoulder peaks and noise peaks.

• **Area Calculation** - Two fits are used, either Gaussian Fit or Dropped Lines. These settings can be changed before or after the run is finished.
  - For Immunoassays, peak area is calculated using Gaussian distribution by default:
• For Total Protein Assays, peak area is calculated using Dropped Lines. This type of area calculation is also often called the perpendicular drop method. This method is preferred when peaks overlap or are close to each other as they are in Total Protein Assays. This method draws two vertical lines from the left and right bounds of the peak down to the x-axis and then measures the total area bounded by the signal curve, the x-axis (y=0 line), and the two vertical lines.

Peak Fit Analysis Settings Groups

Peak fit settings are saved as a group, and multiple settings groups can be created. Specific group settings can then be applied to individual capillaries, sample names or attributes in the run data.
NOTES:
We recommend using the Compass for Simple Western default values for peak fit analysis settings. These settings are included in the default Peak Fit group.

Analysis settings are run-file specific. However, settings can be imported or exported for use with other run files. For more information see “Importing and Exporting Analysis Settings” on page 340.

Peak fit groups are displayed in the analysis settings box:

![Analysis Groups](image)

The Peak Fit group shown contains the Compass for Simple Western default analysis settings. You can make changes to this group and create new groups.

To view settings for a group, click on the group name in the analysis settings box.

Creating a New Peak Fit Group

1. Select **Edit** in the main menu and click **Analysis**, then click **Peak Fit** in the options list.
2. Click **Add** under the analysis settings box. A new group will be created:

![Analysis Groups](image)

3. Click on the new group and enter a new name.
4. Modify range, baseline or peak find parameters as needed.

5. To use the new group as the default peak fit settings for the run file data, click the arrow in the drop down list next to Default, then click the new group from the list. Peak fit settings in the new group will then be applied to the run data.

6. Click **Apply** and then click **OK** to save changes.

Changing the Default Peak Fit Group

1. Select **Edit** in the main menu and click **Analysis**, then click **Peak Fit** in the options list.
2. Click the arrow in the drop down list next to Default, then click a new default group from the list.
3. Click **Apply** and then click **OK** to save changes. Peak fit settings in the group selected will be applied to the run data.

**Modifying a Peak Fit Group**

1. Select **Edit** in the main menu and click **Analysis**, then click **Peak Fit** in the options list.
2. Click on the group in the analysis settings box you want to modify.

3. Modify range, baseline or peak find parameters as needed.
4. Click **Apply** and then click **OK** to save changes. The new peak fit settings will be applied to the run data.

**Deleting a Peak Fit Group**

1. Select **Edit** in the main menu and click **Analysis**, then click **Peak Fit** in the options list.
2. Click on the group in the analysis settings box you want to delete and click **Remove**.
3. Click **OK** to save changes.

### Applying Peak Fit Groups to Specific Run Data

1. Select **Edit** in the main menu and click **Analysis**, then click **Peak Fit** in the options list.
2. Click on the group in the analysis settings box you want to apply to specific run data.

3. Application of peak fit groups to specific run data is done in the override box. Click **Add** under the override box. A default override data set will be created from sample information found in the run file.

4. Click the cell in the **Apply To** column, then click the down arrow.
5. Select an option from the drop down list. This will apply the settings group selected to specific run data as follows:

- **Sample names** - All sample names entered in the assay template (Assay screen) will display in the drop down list, otherwise the default name of Sample will be shown. Select a sample name to apply group settings to all capillaries that use this sample name in the run file.

- **Attributes** - All sample attributes entered in the assay template (Assay screen) will display in the drop down list. Select an attribute to apply group settings to all capillaries that use this attribute in the run file.

- **Cycle 1** - When this option is selected, group settings will be applied to all capillaries.

- **Probe (RePlex Assays only)** - Select a probe to apply Peak Fit group settings to all capillaries within that probe.

- **Custom settings** - Lets you choose specific capillaries to apply the group settings to. When this option is selected, the following pop-up box appears to let you enter a specific capillary number or range of capillaries:

6. If you need to change the peak fit group used for a data set, click the cell in the **Settings** column and click the down arrow. Select a group from the drop down list.
7. Repeat the previous steps to apply other groups to specific run data.
8. To remove a data set, click on its cell in the **Apply To** column, then click **Remove**.
9. Click **Apply** and then click **OK** to save changes.

**Peak Names Settings**

The peak names analysis settings page lets you enter custom naming settings for sample proteins. Compass for Simple Western can automatically label sample peaks in the run data associated with specific blocking reagent names, primary antibody names or attributes. To access these settings, select **Edit** in the main menu and click **Analysis**, then click **Peak Names** in the options list.

---

**NOTE:** Settings can be modified in an assay prior to starting a run, or in a run file once the run has finished executing. Analysis changes made to an executing run will not be saved to the final run file.
• Click **Import** to import an analysis settings file. This will be explained in more detail in “Importing Analysis Settings” on page 340.

• Click **Export** to export the current analysis settings file. This will be explained in more detail in “Exporting Analysis Settings” on page 340.

• Click **Apply** and then click **OK** to save changes and exit.

• Click **Cancel** to exit without saving changes.

### Peak Names Analysis Groups

Peak name settings are saved as a group, and multiple settings groups can be created. Specific group settings can then be applied to individual capillaries, blocking reagent names or primary antibody names and attributes in the run data.

---

**NOTE:** Analysis settings are run-file specific. However, settings can be imported or exported for use with other run files. For more information see “Importing and Exporting Analysis Settings” on page 340.
Peak name groups are displayed in the analysis groups box:

![Image](image)

The Peak Names group shown is a Compass for Simple Western template group. You can make changes to this group and create new groups.

To view settings for a group, click on the group name in the analysis settings box.

**Creating a Peak Names Group**

1. Select *Edit* in the main menu and click *Analysis*, then click *Peak Names* in the options list.
2. Click on the *Protein* template group in the analysis group box.

![Image](image)

3. Enter a new name for the group.
4. Click in the first cell in the *Name* column in the analysis groups peak table.
5. Enter a sample protein name associated with the primary antibody used in the run.

![Image](image)

6. Click in the first cell in the *MW* column.
7. Enter the molecular weight (in kDa) for the sample protein.
8. Click in the first cell in the **Color** column, then click the button.

The color selection box will display:

The color selected will be used to identify the sample protein peak in the peaks and capillaries table in the Analysis screen.

9. Click a color or define a custom color and click **OK**. The color selection will update in the table:
10. Click in the first cell in the **Range (%)** column.

11. Enter a range window for the MW entered. Compass for Simple Western will automatically name peaks found within this percent of the molecular weight. For example, if the molecular weight entered is 40 kDa and a 10% range is used, all peaks between 36 and 44 kDa will be identified with this peak name.

**NOTE:** The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay in Compass for Simple Western may vary from apparent molecular weights using other techniques and based on sample and assay conditions.

12. **For assays with more than one detection channel:** click in the **Channel** cell and select a channel from the drop down menu.
Adding Peak Names Groups
1. Select Edit in the main menu and click Analysis, then click Peak Names in the options list.
2. Click Add under the Analysis Groups box. A new group will be created:

![Analysis Groups](image)

3. Click on the new group and enter a new name.

![Analysis Groups](image)

4. Enter information in the Analysis Groups peak table as described in “Creating a Peak Names Group” on page 319.
5. Click Apply and then click OK to save changes.

Modifying a Peak Names Group
1. Select Edit in the main menu and click Analysis, then click Peak Names in the options list.
2. Click on the group in the Analysis Groups box you want to modify.

![Analysis Groups](image)

3. Change the information in the Analysis Groups peak table as described in “Creating a Peak Names Group” on page 319.
4. Click **Apply** and then click **OK** to save changes.

**Deleting a Peak Names Group**

1. Select **Edit** in the main menu and click **Analysis**, then click **Peak Names** in the options list.
2. Click on the group in the Analysis Groups box you want to delete and click **Remove**.
3. Click **Apply** and then click **OK** to save changes.

**Applying Peak Names Groups to Run Data**

1. Select **Edit** in the main menu and click **Analysis**, then click **Peak Names** in the options list.
2. Click on the group in the Analysis Groups box you want to apply to specific run data.

3. Application of peak names groups to specific run data is done in the override box. Click **Add** under the override box. A default override data set will be created.

4. Click the cell in the **Apply To** column, then click the down arrow.
5. Select an option from the drop down list. This will apply the settings group selected to specific run data as follows:

- **All** - When this option is selected, peak names group settings will be applied to all capillaries in the run file.

- **Antibody names** - All primary and secondary antibody names entered in the assay template (Assay screen) will display in the drop down list, otherwise the default name of Primary will be shown. Select a name to apply group settings to all capillaries that use the primary antibody name in the run file.

- **Attributes** - All primary and secondary antibody attributes entered in the assay template (Assay screen) will display in the drop down list. Select an attribute to apply group settings to all capillaries that use this attribute in the run file.

- **Cycle 1** - When this option is selected, group settings will be applied to all capillaries.

- **Probe (RePlex Assays only)** - Select a probe to apply group settings to all capillaries within that probe.

- **Custom settings** - Lets you choose specific capillaries to apply the group settings to. When this option is selected, the following pop-up box appears to let you enter a specific capillary number or range of capillaries:

6. If you need to change the peak names group used for a data set, click the cell in the **Settings** column and click the down arrow. Select a group from the drop down list.
7. Repeat the previous steps to apply other groups to specific run data.

8. To remove a data set, click on its cell in the Apply To column, then click Remove.

9. Click Apply and then click OK to save changes. Named peaks will be identified with a peak name label in the electropherogram and virtual blot, and will be color coded in the peaks and capillaries tables:
Standard Curve Settings

To use a standard curve to quantitate the concentration of a target protein detected either by an Immunoassay or a Total Protein Assay, first create peak names groups as described earlier for your standard curve protein and the target protein. In the example below, ERK2 is the standard curve protein and the target protein.

NOTE: Analysis settings are run file-specific. However, settings can be imported or exported for use with other run files. For more information see “Importing and Exporting Analysis Settings” on page 340.

To set up a standard curve:

1. Click **Standard Curves** from the Peak Name submenu options.
2. From the Peak drop down list, select the peak name for your standard curve protein.
3. Choose either a **Linear** or **4 Parameter (4PL)** curve fit from the **Fit** drop down list.
4. To add another concentration, click **Add** under the Standard Curve table.
5. Repeat the previous steps to enter information for other concentrations. In the following example, four concentrations were entered:
To remove a concentration, select its row and click **Remove**.

6. Enter the concentration units in the box (for example, pg/μL).
7. Click **OK** to save changes.

**Applying Peak Names Groups to Run Standard Curve**

1. Select **Edit** in the main menu and click **Analysis**, then click **Peak Names** in the options list.
2. Click on the group in the analysis settings box you want to apply to specific run data.
3. Application of peak names groups to specific run data is done in the override box. Click **Add** under the override box. A default override data set will be created.

4. Click the cell in the Apply To column, then click the down arrow.

![Image of the override box with options]

5. Select an option from the drop down list. This will apply the settings group selected to specific run data as follows:

   a. **All** - When this option is selected, peak names group settings will be applied to all capillaries in the run file.

   b. **Blocking reagent** - When this option is selected, group settings will be applied to all capillaries that use this reagent name in the run file.

   c. **Primary antibody names** - All primary antibody names entered in the assay template (Assay screen) will display in the drop down list, otherwise the default name of Primary will be shown. Select a name to apply group settings to all capillaries that use the primary antibody name in the run file.

   d. **Attributes** - All primary antibody attributes entered in the assay template (Assay screen) will display in the drop down list. Select an attribute to apply group settings to all capillaries that use this attribute in the run file.

   e. **Cycle 1** - When this option is selected, group settings will be applied to all capillaries.

   f. **Probe (RePlex Assays only)** - Select a probe to apply group settings to all capillaries within that probe.

   g. **Custom settings** - Lets you choose specific capillaries to apply the group settings to. When this option is selected, the following pop-up box appears to let you enter a specific capillary number or range of capillaries:
6. If you need to change the peak names group used for a data set, click the cell in the Settings column and click the down arrow. Select a group from the drop down list.

7. Repeat the previous steps to apply other groups to specific run data.

8. To remove a data set, click on its cell in the Apply To column, then click Remove.

9. Click Apply and then click OK to save changes. The curve fit will be visible on the Std Curve tab and the concentration of the proteins will appear in the Peaks table:
System or Loading Control Settings

It is possible to use a system or loading control protein to normalize data between capillaries, between runs and between instruments. First create peak names groups as described earlier for your control protein and the target protein. In the example below, System Control is the control protein and ERK1 is the target protein.

NOTE: Analysis settings are run file-specific. However, settings can be imported or exported for use with other run files. For more information see “Importing and Exporting Analysis Settings” on page 340.
To identify the control protein:

1. Click **Peak Names** and select **Loading Controls**.

2. Select a Reference Capillary from the pull-down menu. The peak area of this capillary will be used to normalize the peak area of the named peaks. For RePlex assays (Jess/Abby only), the user can specify which probe to use as the reference, Probe 1 or Probe 2. All named peaks in both Probe 1 and Probe 2 will be normalized to the reference.

3. To manually assign the Control Area, click the box and enter the peak area of your control protein.

4. Click **Apply** and then click **OK** to save changes. Compass for Simple Western will automatically normalize the peak area of the target protein against the control protein. The corrected area appears in the **Corr. Area** column in the Peaks table and in the Capillaries table:
Standards Settings

The standards analysis settings page lets you view and change the position for fluorescent standards. To access this setting, select Edit in the main menu and click Analysis, then click Standards in the options list. The default standard settings for the 12-230 kDa size range is shown in the following example:
• Click **Import** to import an analysis settings file. This will be explained in more detail in “Importing Analysis Settings” on page 340.

• Click **Export** to export the current analysis settings file. This will be explained in more detail in “Exporting Analysis Settings” on page 340.

• Click **Apply** and then click **OK** to save changes and exit.

• Click **Cancel** to exit without saving changes.

**Standards Analysis Settings Groups**

Standards settings are saved as a group, and multiple settings groups can be created. Specific group settings can then be applied to individual capillaries, sample names or attributes in the run data.
Ladders Settings

The ladders analysis settings page lets you view and change the molecular weight and position for the ladder and change the capillary, probe (Jess/Abby only) or channel (Jess only) used for it. To access these settings, select Edit in the main menu and click Analysis, then click Ladders in the options list.

For RePlex Assays (Jess/Abby only), select the ladder in Probe 1 or Probe 2, depending on the assay setup.

NOTE: Probe selection is not available with RePlex Assays that include Total Protein.

The default standard settings for the 12-230 kDa size range is shown in the following example for a standard Immunoassay and a RePlex Assay (Jess/Abby only):
NOTES:
Settings can be modified in an assay prior to starting a run, or in a run file once the run has finished executing. Analysis changes made to an executing run will not be saved to the final run file.

We recommend using the Compass for Simple Western default values for standards and ladders analysis settings. These settings are included in the default Standards and ladders group.

Analysis settings are run-file specific. However, settings can be imported or exported for use with other run files. For more information see "Importing and Exporting Analysis Settings" on page 340.

Changing the Capillary Used for the Ladder

Known ladders are used to calculate the molecular weights of unknown sample proteins. As noted in the Simple Western Product Inserts, we strongly recommend that you use capillary 1 for the ladder. However, you can change the ladder capillary as needed, or opt to not use a ladder at all.

NOTES:
When the ladder capillary is set to none, fluorescent standards information is used to calculate sample protein molecular weight instead of the ladder.

The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay in Compass for Simple Western may vary from apparent molecular weights using other techniques and based on sample and assay conditions.

To change the ladder capillary:
1. Select **Edit** in the main menu and click **Analysis**, then click **Ladders** in the options list.
2. Click the arrow in the drop down list next to Capillary, then click a capillary number or none from the list.
Compass for Simple Western will use the data in the selected capillary to recalculate molecular weights for sample proteins in the run data using the information in the ladder table. If none is selected, Compass for Simple Western will instead use the information in the fluorescent peaks table (fluorescent standards) to calculate molecular weight for sample proteins.

NOTES:
When the ladder capillary is set to none, the ladder table becomes inactive and cannot be modified.

The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay in Compass for Simple Western may vary from apparent molecular weights based on other techniques as well as sample and assay conditions.

Creating a New Standard

1. Select Edit in the main menu and click Analysis, then click Standards in the options list.
2. Click Add under the analysis settings box. A new MW will be added.
3. Click in the first cell in the MW column in the Fluorescent Peaks table.
4. Enter the molecular weight (in kDa) for the fluorescent standard.

5. Click in the first cell in the Position column.
6. Enter the position of the fluorescent standard peak.

7. Repeat the steps above for the remaining standards in the table.
8. Select which standards should be used for molecular weight determination of sample proteins by clicking the checkbox in the Fit column.

**Creating a New Ladder**

1. Select Edit in the main menu and click Analysis, then click Ladders in the options list.
2. Click the arrow in the drop down list next to Capillary, then click a capillary number or none from the list. Capillary 1 is typically used for the ladder.
Compass for Simple Western will use the data in the selected capillary to calculate the molecular weights for sample proteins using the information in the ladder table. If none is selected, Compass for Simple Western will instead use the information in the fluorescent peaks table (fluorescent standards) to calculate molecular weight for sample proteins.

**NOTES:**
When the ladder capillary is set to none, the ladder table becomes inactive and cannot be modified.

The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay in Compass for Simple Western may vary from apparent molecular weights using other techniques and based on sample and assay conditions.

3. If a ladder capillary was selected, click in the first cell in the MW column in the ladder table. Enter the molecular weight (in kDa) for the ladder standard.
4. Repeat the steps above for the remaining ladder MW values in the table.
5. Click Apply and then click OK to save changes.

**Importing and Exporting Analysis Settings**

The analysis settings in a run file can be exported as a separate file. This allows the same analysis settings to be imported into other assays or run files at a later time, rather than having to re-enter settings manually.

**Importing Analysis Settings**

*NOTE: Importing an analysis settings file populates the settings in all Analysis pages.*

1. Open the run file or assay you want to import analysis settings to.
2. Select Edit in the main menu and click Default Analysis (Assay screen) or Analysis (Analysis screen).
3. Click Import on any page.
4. Select a settings file (*.settings) and click OK. The imported settings will display in all analysis pages.

**Exporting Analysis Settings**

*NOTE: Exporting an analysis settings file exports the settings in all Analysis pages.*

1. Open the run file or assay you want to export analysis settings from.
2. Select Edit in the main menu and click Default Analysis (Assay screen) or Analysis (Analysis screen).
3. Click **Export** on any page. The following window displays:

![Export Analysis Settings](image)

4. The default directory is Compass/Assays. Change the directory if needed.

5. Enter a file name and click **Save**. The settings will be saved as a *.settings file.
Chapter 8:
Setting Your Preferences

Chapter Overview
• Custom Preference Options
• Setting Data Export Options
• Selecting Custom Plot Colors for Graph Overlay
• Setting Up Jess, Wes, and Abby to Send Tweets
Custom Preference Options

You can set and save custom preferences for Access Control, data export, plot colors in the graph and Twitter communication. To access these settings, select Edit in the main menu and click Preferences.

NOTE: In Compass for Simple Western version 5.0 and higher, you can no longer change or save Custom Preferences outside of the first instance of the software that’s been opened. When running multiple instances of the software on the same computer, the following message displays if you try to change Custom Preferences in any instance except the first instance opened.

To move between preferences pages in this window, click on any option in the list on the left. The following items can be user-customized in Compass for Simple Western:

- **Access Control** - This feature can be used to help satisfy the 21CFR Part 11 data security requirements. See “Enabling Access Control” on page 328 for more information.
Setting Data Export Options

Select **Edit** in the main menu and click **Preferences**, then click **Analysis Export** in the options list.

- **Analysis Export** - Lets you customize data export options.
- **Graph** - Lets you customize graph color displays.
- **Grouping** - Lets you analyze replicates by calculating the mean, standard deviation and CV of named proteins and plot statistics. See “Group Statistics” on page 202 for more information.
- **Twitter** - Lets you configure Jess, Wes, or Abby to Tweet run status.

**Setting Data Export Options**

- **Export Standards** - Selecting this option includes data for the standards in each sample when run data is exported. When this option is deselected, only sample data will be exported. This option is selected by default.
- **Export using a comma as the column delimiter** - Selecting this option exports run data in .csv format. When this option is deselected, the data is exported in .txt format.
- **Empower** - This option exports uncalibrated run data in a format that is compatible for further analysis in Empower and other analysis programs that use standard formats.
• **Chromeleon** - This option exports uncalibrated run data in a format that is compatible for further analysis in Chromeleon and other analysis programs that use standard formats.

• Click **Apply** to apply changes to any open run files in Compass for Simple Western.

• Click **Restore Defaults** to restore Compass for Simple Western default settings.

• Click **OK** to save changes and exit.

• Click **Cancel** to exit without saving changes.

---

**Selecting Custom Plot Colors for Graph Overlay**

Select **Edit** in the main menu and click **Preferences**, then click **Graph** in the options list.

- **Apply colors to stacked plots** - Selecting this option applies the color scheme to individual electropherograms when the Stack the Plots option is selected in the Analysis screen graph pane.

---

*NOTE: If Apply colors to stack plots is not checked, the colors shown in the preferences screen will be applied only to overlaid electropherograms when the Overlay the Plot option is selected in the graph pane.*
Changing Plot Colors

1. Select **Edit** in the main menu and click **Preferences**, then click **Graph** in the preferences list.

2. Click the color button next to a plot number. The color selection box displays:

3. Select a color or define a custom color and click **OK**. The color button will update to the new color selected.

4. Repeat the steps above for any other plot colors.

5. Check **Apply Colors to Stacked Plots** if you want the new color scheme to also be used for the Stack the Plots option in the graph pane.

6. Click **Apply** to apply changes to plots currently displayed in the graph pane.

7. Click **OK** to save changes and exit. When the Overlay the Plots option is selected in the graph pane, the new color scheme will be used.
Setting Up Jess, Wes, and Abby to Send Tweets

Select **Edit** in the main menu and click **Preferences**, then click **Twitter** in the options list.

- Click **Apply** to apply changes.
- Click **Restore Defaults** to restore Compass for Simple Western default settings.
- Click **OK** to save changes and exit.
- Click **Cancel** to exit without saving changes.

To have Jess, Wes, or Abby tweet a Twitter account:

---

**NOTES:**

*To set an instrument up to tweet, the computer you are using must have an internet connection.*

*To tweet, Jess, Wes, or Abby must be connected to the internet through a network connection or via the local lab computer.*
We recommend setting up a separate Twitter account for Jess, Wes, or Abby. This lets multiple people in the lab follow run progress. It also lets you send tweets directly from the instrument to all users, for example to notify others when the instrument is available or when an error has been reset, etc.

1. Click **Set Account**. A set account window will display in Compass for Simple Western and the following browser window will open:

![Set Account window](image1)

2. Enter a user name or email and password, then click **Authorize app**. A new page will display in the browser with a PIN number.

3. Enter the PIN number in the set account window in Compass for Simple Western and click **OK**.
4. The user name will now appear in the Twitter User Name box. Select one or all of the tweet options in the Tweet When box, then click **Apply**.

![Twitter Preferences](image)

5. To confirm the Twitter account is receiving messages, click **Tweet Message**. Enter a test message and click **OK**.

![Sending Tweet Message](image)

6. If the test Tweet was successful, Compass for Simple Western will display the following message:
7. Click **OK** to save changes and exit. Jess, Wes, or Abby will automatically tweet as the selected options occur.

**Changing the Twitter Account**

To change the Twitter account the instrument uses:

1. Select **Edit** in the main menu and click **Preferences**, and click **Twitter** in the preferences list.
2. Click **Clear**.
3. Set up the new account as described in “Setting Up Jess, Wes, and Abby to Send Tweets” on page 348.

**Sending Manual Tweets from Jess, Wes, and Abby**

You can send tweets directly from the instrument. For example, you may want to notify other users that the instrument is available, being serviced or when an error has been cleared. To do this:

1. Select **Edit** in the main menu and click **Preferences** and click **Twitter** in the preferences list.
2. Click **Tweet Message**.
3. Enter a test message and click **OK**. The tweet will be received by any users following the Twitter account Jess, Wes, or Abby uses.